# Table of Contents

**Section 1: Get Up and Running** .......................................................................................... 8

- **Chapter 1: Introduction** .................................................................................................... 9
- **Chapter 2: Installation and Setup** ..................................................................................... 10
  - 2.1 Install FileCenter ........................................................................................................ 10
  - 2.2 Run FileCenter for the First Time .............................................................................. 11
  - 2.3 Network Installation .................................................................................................. 13
- **Chapter 3: The FileCenter Interface** ............................................................................... 14
  - 3.1 The Manage Tab ......................................................................................................... 14
  - 3.2 The Edit Tab ............................................................................................................. 14
  - 3.3 The Search Tab ......................................................................................................... 15
  - 3.4 The Inbox Tab .......................................................................................................... 15
  - 3.5 The Task Buttons ...................................................................................................... 16
  - 3.6 The Ribbon and the File Tab .................................................................................. 16
- **Chapter 4: Prepare Your Filing System** ........................................................................... 18
  - 4.1 Should I Use Electronic File Cabinets? ................................................................. 18
  - 4.2 Import Existing Files and Folders .......................................................................... 21
  - 4.3 Plan New Cabinets ................................................................................................. 21
  - 4.4 Recommended Cabinet Layouts ............................................................................ 22
- **Chapter 5: Using Cabinets, Folders and Files** ................................................................. 26
  - 5.1 The Cabinet Layout ................................................................................................. 26
  - 5.2 Manage Your Cabinets ........................................................................................... 26
  - 5.3 Drawer Basics .......................................................................................................... 28
  - 5.4 Folder Basics ........................................................................................................... 28
  - 5.5 Delete a Drawer or Folder .................................................................................... 29
  - 5.6 File Basics .............................................................................................................. 29
  - 5.7 Add Files to Your Cabinets .................................................................................. 31
Chapter 10: Advanced Settings

10.1 Advanced Settings ........................................................................................................ 75
10.2 Pinning Drawers .......................................................................................................... 77
10.3 Secure a Cabinet............................................................................................................ 78
10.4 Integrate with the Save/Open Functions of Other Programs .................................. 80
10.5 Application Bar ............................................................................................................ 81

Chapter 11: File Conversions

11.1 Convert Individual Files to PDF .................................................................................. 83
11.2 Bulk PDF Conversion ................................................................................................. 85
11.3 Email Files as PDFs ..................................................................................................... 87
11.4 Paste Images as Files .................................................................................................. 88
11.5 Convert between Image Formats ................................................................................ 89
11.6 Convert to Word, Excel, etc. ....................................................................................... 89

Chapter 12: Work with PDF Files

12.1 Combine PDF Files through Drag-and-Drop ............................................................. 90
12.2 The “Actions” Button ............................................................................................... 91

Chapter 13: Use the PDF Editor

13.1 Erase .......................................................................................................................... 97
13.2 Redact Sections ......................................................................................................... 97
13.3 Fill Out Forms ......................................................................................................... 99
13.4 Typewriter ............................................................................................................... 99
13.5 Rearrange or Delete Pages ...................................................................................... 100
13.6 Crop Pages ............................................................................................................. 100
13.7 Rotate Pages .......................................................................................................... 101
13.8 Add Annotations ...................................................................................................... 101
13.9 Stamp Pages ............................................................................................................ 102
13.10 Page Numbering (Headers & Footers) .................................................................... 104
13.11 Bates Numbering .................................................................................................... 104
13.12 Add Searchable Metadata ...................................................................................... 105
13.13 Apply Security ........................................................................................................ 106
Chapter 14: Text Recognition (OCR) ............................................................... 109

14.1 What is a Searchable PDF? ................................................................. 109
14.2 Make a File Searchable when You Scan ........................................... 110
14.3 Make an Existing File Searchable ...................................................... 110
14.4 Send the Text from a Scanned Document to Word ......................... 111
14.5 OCR Options Described .................................................................. 112

Chapter 15: Tap into Document Content ............................................... 115

15.1 The CONTENT Field ..................................................................... 115
15.2 Barcode Fields .............................................................................. 117
15.3 Regular Expression Fields .............................................................. 117
15.4 Zone Fields .................................................................................. 120
15.5 Testing Your Content Field ............................................................ 121
15.6 The Content Field Library ............................................................... 121
15.7 Data Mining with Content Maps .................................................... 121
15.8 Regular Expression Syntax .............................................................. 122
15.9 Regular Expression Examples .......................................................... 123

Chapter 16: Advanced Scanning ............................................................ 128

16.1 More Ways to Scan ..................................................................... 128
16.2 Adjust the Scanned Image ............................................................... 131
16.3 Scanning Options Described ........................................................... 133
16.4 Scanning Profiles .......................................................................... 142

Chapter 17: Speed Up Repetitive Scanning ........................................... 144

17.1 Use an Inbox with a Network Scanner or ScanSnap ...................... 144
17.2 Scan to File with Naming Options ................................................ 145
17.3 Use Profiles with Filenames ........................................................... 146
17.4 Automatically Break Up Scans at Regular Intervals ....................... 147

Chapter 18: Automate Scanning with Separators .................................... 148

18.1 The Separators Dialog ................................................................. 148
Section 1: Get Up and Running
Chapter 1: Introduction

In its simplest terms, FileCenter is paperless office software designed to help any kind of user get and stay organized. It handles any kind of file, helps you scan in paper documents, works wonderfully with PDFs, and gives you some powerful editing, searching, and preview capabilities.

But if you take a closer look, you’ll find that FileCenter is a flexible, adaptable tool designed to meet a whole range of needs. While we often describe it in terms of “scanning” and “file organization,” in practice it has seen a wide variety of uses – from small businesses needing a way to store and search invoices, to corporations needing a flexible, large-scale file management system, to music teachers wanting an easy way to organize and display sheet music on a tablet PC. Graphic designers, clergymen, web developers, housewives, students, genealogists, and of course business managers, doctors, accountants, and lawyers have all called FileCenter the most valuable piece of software on their PCs.

The power of FileCenter lies in its simplicity and its flexibility. Anyone can quickly grasp the underlying principles and get up and running in no time. From there, your mind will race with ways to adapt it to your unique situation.

This guide will teach you the basic concepts of FileCenter, often in terms of small businesses or medical offices which deal with huge volumes of paper. Yet don’t think FileCenter is limited to that range of tasks.

To make the best use of this guide, first go through all of Section 1: Get Up and Running (chapters 1-7), then move on to Section 2: Getting Sophisticated (chapters 8-22). Finally, Section 3: Tasks, will give you simple, step-by-step instructions for performing common tasks and will serve as the place you can turn for quick guidance any time.
Chapter 2: Installation and Setup

This chapter will take you step-by-step through installation. If you don’t understand the concept of a FileCenter cabinet, feel free to pause now and peek ahead at Chapter 4: Prepare Your Filing System, or go ahead with the setup and skip the portion about cabinets. You’ll be able to set them up later.

2.1 Install FileCenter

To begin your installation, locate the setup file and double-click it.

If you’re not sure where to find the file and you downloaded it, look on your Desktop or in your Downloads folder (usually at C:\Users\[username]\Downloads). Look for a file called “FileCenter Setup_.exe”, where the underscore “_” will be a version number.

Once the installation starts, click through the screens, paying special attention to these:

All Users vs. Current User vs. Unique Profiles

Most users, unless they share their computer with someone else, should select All Users.

You would only select Current User if you share your computer with another person and you are the only one who will use FileCenter.

If you share a computer and you want each user to have their own settings, or if you are a network admin installing FileCenter on a Terminal Server, select All Users with Unique Profiles (which uses Windows roaming profiles).

Important: This only affects program preferences; it has nothing to do with sharing files. Also, it only applies to the machine you’re installing on. If your machine is on a network, this setting does not affect other users on the network.

Tip: In technical terms, the All Users option puts FileCenter’s settings in C:\ProgramData\FileCenter, while the Current User and All Users with Unique Profiles options put the settings in C:\Users\[username]\FileCenter.
**Product Key**

If you already bought FileCenter, your place of purchase will have given you a *Product Key*. Enter it now.

If you’re doing a free trial of FileCenter, click *Install as a 15-Day Trial*.

**Optional Components**

You can optionally install the following additional features (omitting them won’t affect FileCenter). Note that you might not see some of these options, depending on your computer’s configuration.

**Install PDF Printer.** You use a PDF printer to “print” documents, web pages, email messages, etc. to PDF files. It’s an easy way to archive documents or save things that don’t normally lend themselves to being saved – like web pages.

*Pro Only:* These options are only available in FileCenter Professional and Pro Plus.

### 2.2 Run FileCenter for the First Time

Launch FileCenter from the FileCenter icon on your Desktop or from the *Start* menu > *All Apps/Programs > FileCenter*.

The first time you run FileCenter, a setup wizard will guide you through the initial setup. Follow the prompts using the following sections for additional guidance.

*Tip:* You can repeat the setup wizard any time. Go to the drop-arrow under the *Help* button > *Setup Wizard*.

**Cabinet Setup**

We’ll cover cabinets in more detail in Chapter 4: Prepare Your Filing System. For now, we recommend you create at least two cabinets to start with, just for the sake of learning how cabinets work:

**My Documents.** Select the option to assign the Windows *My Documents* folder to a cabinet.
**Empty Cabinet.** Select the option to create an empty cabinet and call it “Sandbox”. You can use this cabinet to practice making drawers and folders, then delete it later.

**PaperPort Folders.** If you have any PaperPort folders on your machine, they should show up here. We recommend that you assign your PaperPort folders to cabinets so you can see the differences between FileCenter and PaperPort.

If you understand cabinets already and have an existing folder you want to assign to a cabinet, go ahead and do that now. If you have more cabinets to set up, you can create them later.

**Choose a Scanner**

FileCenter works with TWAIN scanners. That includes most scanners that plug directly into your computer, and some wireless scanners. Most network scanners are not TWAIN scanners, but you can still use them through FileCenter’s Inbox feature (see p. 144, Use an Inbox with a Network Scanner).

If you have a scanner connected to your computer, you can select it now. If it appears more than once on the list, select the entry that does not have “WIA” in the name.

If you use a Fujitsu ScanSnap scanner, it won’t show up in the list but you can still use it with FileCenter. See p.38, Scan with a ScanSnap for details.

We’ll cover scanners, scanner selection, and scanner troubleshooting in Chapter 6: Scanning Basics.

**Cloud Setup**

FileCenter can work with a number of different cloud services, like Google Drive, OneDrive (SkyDrive), DropBox, SugarSync, etc.

If you use one of these services, you know that it places a special folder on your computer. Everything in that folder gets synchronized with the cloud drive.

If you would like to use this folder, or one of its subfolders, as a cabinet in FileCenter, select the folder and assign it a cabinet name.
**Capture Save/Open Dialogs**

FileCenter has the ability to substitute the *Save* and *Open* dialogs of most Windows programs with custom *Save/Open* dialogs that show your FileCenter cabinets. This makes it a breeze to save files straight into FileCenter and open files from FileCenter.

At the same time, we recognize that not all of your files will be in FileCenter, so we make it easy to switch back to the regular Windows *Save/Open* dialogs on a case-by-case basis, or to turn the feature off completely for specific programs.

This feature is optional. For more information, see p. 80, Integrate with the Save/Open Functions of Other Programs.

**2.3 Network Installation**

FileCenter runs very well on a network. The setup is simple: put FileCenter on each workstation, put your cabinets on the server (or a shared network folder), then point everyone to the same cabinets. If one person makes a change, everyone will see it.

We provide special *Share* buttons throughout the program to make it easy to share cabinets and other features on the network.

For large networks, FileCenter comes with a tool to help administrators roll out uniform configurations, lock out features, and administer shared cabinets.

For more information, see Chapter 21: Use FileCenter on a Network.
Chapter 3: The FileCenter Interface

FileCenter combines what might be considered a few different programs into a single, smooth-flowing interface. You’ll easily move from task to task and feature to feature, accomplishing much of your daily file-related work without ever leaving the interface.

In this chapter we’ll take a look at the main sections of FileCenter and show you where to go to access the features you’re looking for.

If you look at the top of FileCenter’s interface, you will see a row of four tabs: File, Manage, Edit, and Search. Let’s take a closer look at each of those, beginning with Manage.

3.1 The Manage Tab

The Manage tab is where you’ll organize your files. Think of it as Windows Explorer, only better. Anything you can do in Windows Explorer, you can do here: open files, delete files, rename files, copy files, move files, etc.; but mostly, you will browse, organize, and manage your files — any kind of file.

There are two ways to do this: with a regular Explorer interface, or with electronic file cabinets which mimic real file cabinets, with drawers, folders, and files.

Cabinets show up as tabs under the main toolbar. The area below shows your files, broken out into three panels: drawers on the left, folders in the middle, and files on the right. It won’t take you long to appreciate how fast and efficient this layout is. You’ll navigate to almost any location in as few as two or three mouse clicks. No more hunting and clicking through deep folder trees trying to find a file. We’ll help you set up your file cabinets in the next chapter, Prepare Your Filing System.

To open a file, just double-click it. It will open in whatever Windows program normally handles that kind of file. If it happens to be a PDF file, you’ll have the choice of opening it in its regular program or in FileCenter. Which brings us to the Edit tab.

3.2 The Edit Tab

If the Manage tab is like Windows Explorer, the Edit tab is like Adobe Acrobat, or better yet, like Microsoft Word. It’s a place to open a file and make changes to it.
The *Edit* tab is a “PDF editor” – a tool for viewing and editing PDF files. Here you will print a file, add or remove pages, fill out forms, add comments and annotations, etc.

Everyone understands that if you open a file in Microsoft Word and change some text, you have to save your changes, otherwise you will lose them when you close. FileCenter’s *Edit* tab works the same way.

Once you understand the concept of the *Edit* tab, it isn’t hard to see how it interacts with the *Manage* tab and complements it. You use the *Manage* tab to organize your files. If you have a PDF file you need to edit, you open it in the *Edit* tab, make your changes, save them, then close the file and go back to the *Manage* tab.

You will learn more about the ins and outs of the *Edit* tab in Chapter 7: PDF Basics, and Chapter 13: Use the PDF Editor.

### 3.3 The Search Tab

The *Search* tab also complements the *Manage* tab. The *Manage* tab provides a very nice structure for organizing your files, and usually that organization helps you get to your files quickly. Occasionally, however, you will misplace a file or forget where you put it. That’s where the *Search* tab comes in.

Use the *Search* tab to search through your files. You can search by filename or you can search the body of the files. For example, if you know that the missing file mentions the name “Henderson” in it, you can search for any files that contain the text “Henderson”. In that sense, search is just like a web search, only you are searching the body of your documents instead of web pages.

FileCenter will give you a full list of documents that meet your search criteria. Once you spot your file, you have a few options: you can jump to it in the *Manage* tab, you can open it, you can edit it in the *Edit* tab (if it’s a PDF), etc.

The *Search* tab is your tool for finding needles in the haystack. We’ll cover search in detail in Chapter 19: Search for Files.

### 3.4 The Inbox Tab

Not all users will need the Inbox tab, but those who do will find it handy.
Use the *Inbox* to move inbound files into FileCenter. What do we mean by “inbound files”? Here are a few examples: files coming off of a network scanner, files on a digital camera, files on a portable scanner, files from a fax service. These are files coming into your office from some device or service.

Your *Inbox* will show you these files and help you move them into FileCenter. We’ll discuss the *Inbox* tab, how to set it up, and how to use it on p. 60, The Inbox.

### 3.5 The Task Buttons

FileCenter’s aim is to stay clean and streamlined for basic users while providing plenty of productivity tools for power users. To accomplish that, we tuck many of the power features one mouse click away from the main interface – close enough for easy access but one step removed so they won’t visually overwhelm users who don’t need them.

Throughout the interface, you’ll see buttons with a drop-arrow. We call these *task buttons*, and they’re where you’ll find most of the power in FileCenter. Here are a few of the main ones:

- **Cabinets.** The *Cabinets* button to the left of the cabinet tabs is where you’ll control all aspects of cabinets.

- **Drawers/Folders/Files.** At the top of the drawer, folder, and file panes you’ll see a corresponding task button. These three task buttons hide a wealth of file management features.

- **Preview.** FileCenter actually comes with a number of file preview features and options, all available from the *Preview* button when the preview window is open.

### 3.6 The Ribbon and the File Tab

In addition to the task buttons, FileCenter houses many of its power features in the *ribbon*. The ribbon is simply the main toolbar that runs along the top of the interface. In fact, we’ll refer to it as the *Main Toolbar*. Here are a few highlights:

- **Email.** With the *Email* button, you can send files via email in just a mouse click. You’ll also find that there are over half a dozen power tools associated with emailing, like zipping files and emailing them, changing the way the filenames appear in the email, and sending files as PDFs ... even if they weren’t PDFs to start with.
**Scan/OCR.** Many of the scanning/OCR features can be accessed as one-click shortcuts in the menus under the *Scan* and *OCR* buttons.

**Actions.** The *Actions* button on the main ribbon contains a whole toolbox of PDF manipulation features that work regardless of which view you’re in.

**Tools.** In the *Tools* button you will find a host of power features that didn’t fit in the other task buttons.

*Pro Only:* Some of these buttons and options are only available in FileCenter Professional and Pro Plus.
Chapter 4: Prepare Your Filing System

The biggest mental hurdle most users face is setting up their filing system ... but it shouldn’t be. FileCenter works very nicely with your files just the way they are; and if you want to improve the way you organize your files, FileCenter will help you get there.

Once you understand a couple of simple, underlying principles, you will see how easy it is to adapt FileCenter to almost any organizational need.

4.1 Should I Use Electronic File Cabinets?

While FileCenter can show your drives and files just like Windows Explorer does, its real power comes through its Electronic File Cabinets. This section will help you understand cabinets and how to set them up.

Cabinets vs. Windows Explorer

Think of cabinets as an improvement on Windows Explorer. They show regular Windows directories, just like Explorer does, but they improve the presentation and enforce a more uniform structure.

*Important:* It’s critical that you understand this point: cabinets are Windows folders, NOT databases. You can display any folder as a cabinet without changing it. In fact, a cabinet is *just another way of showing* a folder’s contents. This means you always have full access to your files, even outside of FileCenter and even if you stop using FileCenter.

So why use cabinets over Windows Explorer? Cabinets have distinct advantages. They give you faster access to your files. They promote a more thoughtful structure and lend themselves to good, consistent file organization. They keep you from losing your bearings in deep folder trees. And not least of all, they mimic real file cabinets, a system anyone can feel comfortable with quickly.

Understand a Cabinet’s Structure

To help you understand how a cabinet works, let’s play with the *My Documents* cabinet you created during setup (if you need to create it, see Task 1: Make a My Documents Cabinet).
Click the *My Documents* tab in FileCenter. You will see the *Drawers* column fill up with the directories in *My Documents*. These are your drawers. Click a drawer which you know has files in it. Now you’ll see the *Folders* column populate with the directory’s subfolders, and possibly files on the right. With an easy, left-to-right motion, you can quickly drill down to any file you want.

Now let’s understand what’s happening behind the scenes.

Open up Windows Explorer to your *My Documents* folder. (To open Windows Explorer, you can go to your *Start* button > *My Documents* or *My Computer*, or you can press the “Windows” button + “E” – that’s the button with the Windows symbol on it, usually to the left of the left *Alt* key.)

Put Windows Explorer and FileCenter side by side.

First look at Windows Explorer. Notice the list of folders in *My Documents*. Now switch over to FileCenter. You’ll see that those same folders show up as *drawers* in FileCenter.

While you’re still in FileCenter, click the *Drawers* button (at the top of the list of drawers) and select *Add Drawer*. Call it “Test Drawer” and click *OK*. Click on the “Test Drawer” to open it. Now click the *Folders* button in FileCenter (to the right of the drawers), select *Add Folder*, call it “Test Folder” and click *OK*.

Now go back to Windows Explorer. You should see a new folder in *My Documents* called “Test Drawer”, and if you open it you’ll see the “Test Folder” you made in FileCenter.

What conclusion can we draw from this? A FileCenter cabinet is tied to a regular Windows directory. What you do in FileCenter is reflected in Windows and *vice versa*. FileCenter is simply showing the same folders and files, but with a better presentation.

There are two more conclusions we can draw. First, you can easily display your existing files in FileCenter without any kind of import or conversion routine. We’ll discuss that in more detail on p. 21, *Import Existing Files and Folders*. And finally, if you stop using FileCenter, you won’t lose access to your data.

**Display Styles for Cabinets**

It’s worth taking a moment to point out a few different display styles for cabinets. Some users love the “drawer” approach, but some prefer more of an Explorer look. FileCenter can accommodate both.
**Drawers, Folders, Files.** By default, a cabinet shows drawers, folders, and files in three separate windows, from left to right. Most users prefer this approach. It enforces good structure and gets you to your files very quickly.

**Drawers in a Drop List.** This option does just what it says: moves the *Drawers* window into a drop-list. Let’s take a look at it. Right-click on the *My Documents* tab in FileCenter and select *Edit Cabinet*. Under the *Layout* tab, select *Display Drawers in Drop List* then click *OK*. Now you only see two windows: *Folders* and *Files*, with the drawers moved to a list above the folders. To select a drawer, just click a different item on the list. The folders and files change to that drawer’s contents. Some users prefer this layout for its reduced clutter and its ability to focus on just one location.

**Do Not Use Drawers.** You can abandon the “drawer” approach altogether in favor of Explorer-style folder trees. To see what we’re talking about, again right-click on the *My Documents* tab > *Edit Cabinet* > *Layout* tab and select *Do Not Use Drawers* and *OK*. You’ll see just two windows: an Explorer-style folder tree and files.

In fact, this is just like Windows Explorer with one benefit: you only see the “slice” of Windows Explorer you care about. Your “cabinet” gives you fast access to one piece of your folder tree and eliminates all of the clutter.

**Do Not Use Folders.** You can also use drawers, but eliminate the *Folders* window, which is useful for users who don’t need the extra organizational level of folders. You’ll find this setting together with the others you’ve just seen.

---

**Use Explorer Instead of Cabinets**

If you prefer an Explorer interface to FileCenter’s “drawer” approach, you have two options. We recommend you still use cabinets, but with the *Do Not Use Drawers* display style. Why? Quicker access to the directories you work with and reduced clutter.

Alternatively, you can switch to a full Explorer interface. On the right-hand side of FileCenter, above the list of files, you’ll find an *Explorer* button. Use this to switch over to an Explorer view. While you can use this hand-in-hand with cabinets, you can also make it the default interface. See Task 2: Use an Explorer Interface Instead of Drawers.
4.2 Import Existing Files and Folders

You don’t need to “import” or convert your files to work with them in FileCenter. FileCenter can show any directory as a cabinet, as we discussed above on p. 18, Cabinets vs. Windows Explorer. Just add a cabinet and set its Location to the folder you want to “import”. For specific steps, see Task 3: Make a Cabinet from Existing Files.

With that said, some folder layouts lend themselves better to a cabinet than others. We’ll discuss this on p. 22, Recommended Cabinet Layouts.

**Important:** FileCenter expects there to be folders in the directory you choose. These will show up as drawers (see p. 18, Understand a Cabinet’s Structure). If there are files in the base folder, a special drawer called Cabinet Root will hold these files. See Task 6: Show the Files in a Cabinet’s Base Folder.

Cabinets on Cloud Drives

Most cloud services put a special folder on your machine for the cloud files. Anything you put in this folder gets synchronized to the cloud.

FileCenter is completely compatible with these services. To synchronize a cabinet to the cloud, just make sure it’s in the cloud folder. For specific steps, see Task 4: Make a Cabinet on a Cloud Drive.

4.3 Plan New Cabinets

We’ll walk you through adding cabinets in the next chapter, Using Cabinets, Folders and Files. But for now, let’s walk through a few basic decisions you should make before you start setting up your cabinets.

If you’re starting from scratch, there are two considerations you need to address: where you should put your cabinets, and how you should lay them out. We’ll take up the layout question on p. 22, Recommended Cabinet Layouts.

As far as location is concerned, you have two basic options: private cabinets on your personal computer, or shared cabinets that you put or make available on the network.
**Private Cabinets**

Normally, any cabinet that you put on your personal computer will be private. By default, FileCenter will put your new cabinets in *My Documents* under a folder called *My Cabinets*. So, for example, if you add a cabinet called *Personal Files*, you’ll find the data at:

```
My Documents\My Cabinets\Personal Files
```

If you want the cabinet to be somewhere else, like a large partition on your drive, an external drive, or a specific folder, just make sure you set the *Cabinet Location* manually when you add the cabinet.

**Important:** “Private” can mean multiple things. Here we mean that no-one else will have the cabinet unless you take steps to share it. “Private” does *not* mean your files are protected from prying eyes. Anyone who uses or shares your computer will probably be able to see your files unless you take security measures to protect them. We’ll talk about that more on p. 78, Secure a Cabinet.

**Shared Cabinets**

If you want other users to have access to the cabinet, you need to put it in a “shared folder”. By that, we simply mean a folder that is openly available to everyone on your network. We’ll discuss this in detail in Chapter 21: Use FileCenter on a Network.

For now, realize that if you plan to share a cabinet, you need to have a working network. This can either be a full-fledged office network with a server, or it can just be two computers that are connected together (“peer to peer” network). If you need to have someone set up a network for you, this is a good time to do it.

**Important:** When you add a new cabinet, FileCenter will put it on your personal computer by default. If this is a cabinet you plan on sharing with other users, you *must* choose a location that every computer can see, like a shared network drive or a shared folder on your computer.

### 4.4 Recommended Cabinet Layouts

The best way to use a cabinet depends entirely on how you organize your work. Use your cabinets in whatever way makes the most sense to you. A good guideline is to make your file cabinets parallel the way you organize physical files, your media libraries, your work, etc.
If you parallel your cabinets with physical filing cabinets, we recommend one change. Don’t make a FileCenter drawer for each cabinet drawer. Instead, make a drawer for each hanging file. Physical filing drawers do nothing more than hold your hanging files, which are the real organizational structure. So do the following:

1. Create a drawer for each hanging file
2. Put folders in the drawers to match the folders in your hanging files
3. Put documents in the appropriate folders

With that said, here are a few tried-and-true layouts that are popular with many FileCenter users.

**One Drawer Per Patient, Client Or Matter**

If you work with distinct clients, patients, cases, matters, or accounts, we **strongly recommend** that you create a separate drawer for each one. Doing this, you can enjoy these benefits:

- Speedy lookups with the drawer search feature (see p. 28, Search Drawer Names)
- Automatically include the client/patient/case/etc. name in your filenames (see Task 14: Insert Names in Filenames)
- Easily archive inactive drawers (see p. 73, Archive Drawers to Prevent Cabinet Bloat)
- “Pin” your drawers to a *Daily Appointments* or *Active Work* cabinet (see Task 17: Use a *Daily Appointments* or *Active Work* Cabinet)

For example, a law firm, accounting firm, medical or dental practice might have a cabinet with drawers that look like this:

```
Banks, George – 0031
Bates, LaToya – 0127
Brown, Saundra – 0035
Crawford, Diedre – 0237
Delgado, John – 0239
Fletcher, Sheila – 0743
Foster, Vincent – 0071
Grimes, Doris – 0178
Hatfield, Katrina – 0438
Morant, Claudette – 0567
Palmer, Daniel – 0123
Thompson, Lenore – 0070
```

In this example, the drawer name has both the person’s name and their four-digit file number. This lets the staff use either one to look up a person’s drawer through the drawer search feature.
Years or Months

Some files are better organized by year. Digital photos are the classic example. In this case, create one drawer for each year, then a subfolder for each month.

Note that FileCenter includes Folder Templates to automatically create the month folders for you. Do this:

1. Create your drawer for the year
2. Click the Drawers button
3. Select Apply Folder Template
4. Select Months
5. Click Apply

Transactional businesses may want one cabinet per year, with drawers for the months and folders for the days. You can automatically create drawers for the months using the same folder template. Just follow these steps:

1. Create a cabinet for the year
2. Right-click on the cabinet’s tab
3. Select Apply Folder Template to Cabinet
4. Select the Months template
5. Click Apply

Business Users

If the business handles a couple of different kinds of work, it makes sense to have a separate cabinet for each kind of work.

Joe Attorney uses two file cabinets — one for his estate planning clients and one for his tax clients. Both use the one-drawer-per-client approach. He also has a third cabinet called Library where he organizes his research and his forms into drawers by topic.

Paula Pediatrician has three cabinets — one for her medical practice, one for her web-based business, and one to organize her personal files. She organizes her practice by patient. Her web-based business uses drawers to organize each aspect of the business: legal documents, advertising material, correspondence, etc.
Home & Personal Users

Personal users can make great use of FileCenter. For example, Jim uses a few different cabinets to organize his multimedia files — a cabinet of digital photos, a cabinet of mp3s, and a cabinet of video clips.

Susan maintains web sites for her family & friends. She has a “Web Sites” cabinet with one drawer for each web site. She finds that the FileCenter structure reflects the structure of her web sites perfectly.

William does family history research. He uses one cabinet for each main family branch, and then stores his research and photos in drawers by family.

Glenn has just one cabinet with drawers for different personal needs: financial documents, legal agreements, correspondence, journal, digital photos, music, e-mail, and miscellany.

Practical Examples

FileCenter includes two sample cabinets to help you get started organizing your files: Business and Personal. If you didn’t install them when you set up FileCenter, you can do it now:

1. Click the drop-arrow under the Help button
2. Select Setup Wizard
3. Go to Cabinet Setup on the left
4. Select I Want a Sample Personal Cabinet and I Want a Sample Business Cabinet
5. Click Finish

Feel free to modify these cabinets to suit your individual needs.
Chapter 5: Using Cabinets, Folders and Files

Now that we’ve got the basic concepts down and you’ve started giving some thought to how you should lay out your cabinets, let’s go ahead and dive into the mechanics of setting up and managing cabinets, drawers, folders, and files.

5.1 The Cabinet Layout

As we touched on earlier, a cabinet has four components:

- Cabinet “tabs” along the top
- Drawers on the left
- Folders in the middle
- Files on the right

When you click a drawer, you’ll see its folders in the middle. When you click a folder, you’ll see its files. In other words, cabinets contain drawers, drawers contain folders, and folders contain files. (The one exception is that you can skip folders and put files right in a drawer.)

Note: This is the classic layout. If you’re using an alternative style, yours will look slightly different (see p. 19, Display Styles for Cabinets).

5.2 Manage Your Cabinets

To add, edit or delete a cabinet, click the large Cabinets button on the main toolbar.

Add a Cabinet

To add a cabinet, click the large Cabinets button, then the Add button. You’ll see a lot of cabinet options. Usually, you’ll only use two of them:

- **Name.** Any unique name (this is the name that will display on the cabinet’s tab)
- **Location.** If there’s a specific directory you want to use for this cabinet, click Browse and select it (see note below); otherwise, click Use Default Location
- (accept the defaults for the rest of the options)
When you click OK, a new tab will appear on the main interface with your cabinet’s name on it. Click the tab to select the cabinet. If the Location you chose had files in it, you will see them now. Otherwise, the cabinet will be empty. We’ll show you how to add drawers and folders shortly.

**Important**: When you set a cabinet Location, that folder will be the cabinet. The first level of directories in that location will be the drawers, then folders and files. In other words, FileCenter won’t create a cabinet in that location, it will use that location as the cabinet.

**Remove a Cabinet**

To remove a cabinet tab, click the large Cabinets button, select the cabinet on the list, and click Remove.

**Important**: This does NOT delete the cabinet’s data. It just removes the cabinet’s tab from FileCenter. If you want to delete the data too, browse out to the cabinet’s directory in Windows Explorer and delete it.

**Modify a Cabinet**

You can change a cabinet’s options any time. Just click the large Cabinets button, select your cabinet on the list, and click Edit.

**Change the Tab Order**

By default, your cabinet tabs will be arranged in the order you add them. To move a tab, just click and drag it to another position.

You can also arrange your cabinet tabs alphabetically. Click the Cabinets button, and on the cabinets dialog, click Sort and OK.

**Show Files in the Base of the Cabinet**

FileCenter expects all of your files to be in drawers. If the cabinet’s main directory happens to contain files of its own, they will show up in a special drawer called Cabinet Root. See Task 6: Show the Files in a Cabinet’s Base Folder.
5.3 Drawer Basics

Above the list of drawers you’ll notice a Drawers button. You’ll use this button to add, delete, and modify your drawers.

Add or Change a Drawer

To add a new drawer to your cabinet, click the Drawers button > New Drawer, then give the drawer a unique name.

Important: A drawer name cannot be longer than 255 characters and it cannot contain any of the following characters: \\/:*?“<>! =. You should also avoid using non-keyboard characters, like characters with accents.

To rename a drawer, select the drawer, then click the Drawers button > Rename Drawer.

Tip: You can also rename a drawer by hitting the F2 key.

Search Drawer Names

If you have a long list of drawers, you can quickly jump to the drawer you want. You’ll see a small search box next to the Drawers button. Start typing in characters from the drawer’s name, and FileCenter will immediately move to that drawer. The search feature doesn’t care about letter case, and it will first try to match the start of the drawer name, and failing that, will match your search string anywhere in a drawer name.

5.4 Folder Basics

Just like with drawers, there is a Folders button above the list of folders. You’ll use this button to add, delete, and manage your folders.

Add or Change a Folder

To add a new folder to a drawer, click the Folders button. You’ll see two options:

- New Folder – Creates a new folder under whatever folder is selected. You’ll use this option to create subfolders. If no folder is selected, it will create a top-level folder.
- *New Top Level Folder* – Creates a folder at the top level (first tier of folders in the drawer), regardless of whether you have another folder selected.

**Important:** A folder name cannot be longer than 255 characters and it cannot contain any of the following characters: \\ / : * ? “ < > | =. You should also avoid using non-keyboard characters, like characters with accents.

To rename a folder, select it, then click the *Folders* button > *Rename Folder*.

**Tip:** You can also rename a folder by hitting the F2 key.

---

**Work with Folders**

Folders can go many levels deep (limited only by Windows’ internal restrictions). We've already seen that to add a subfolder, just select the folder you want to put it in, then click the *Folders* button > *New Folder*.

You can also drag/drop folders into other folders or even into other drawers. You can also convert a folder into a drawer. Just select the folder, click the *Folders* button > *Convert to Drawer*.

**Tips:** To learn how to expand/collapse whole folder trees at a time and to show whether folders have contents or not, see p. 70, Advanced Folder Features.

---

**5.5 Delete a Drawer or Folder**

To delete a drawer or folder, just select it and hit the Del key on your keyboard. You can also delete it from the *Drawers* or *Folders* button.

**Important:** When you delete a drawer or folder, you will delete every folder and file in it. If the cabinet is on a removable drive or network drive, the deletion is permanent and irreversible! If the cabinet is on your personal computer, the deleted items go to the Windows Recycle Bin.

---

**5.6 File Basics**

FileCenter will store any kind of file. You can do anything with your files that you’d be able to do in Windows Explorer. For example, if you right-click on a file, you’ll see the same pop-up menu you see in Windows Explorer, plus some options unique to FileCenter.
Like the Drawers and Folders buttons, you’ll find a Files button above the list of files. This button is full of options for using and manipulating your files. Note that there are even more options if you select a PDF file.

**Open a File**

When you double-click a file, it will open in its native application. In other words, it will open in the program Windows has assigned to that type of file. Word documents will open in Microsoft Word, Excel spreadsheets will open in Microsoft Excel, digital pictures will open in your picture viewer, MP3 files will open in your media player, etc.

You can also select a file and click Open on the main toolbar.

The one exception is PDF and TIFF files. FileCenter has a built-in PDF/TIFF editor, so you can open these files right into FileCenter for editing. When you attempt to open a PDF or TIFF file, FileCenter will ask if you want to open it in the regular program or in FileCenter. If you choose FileCenter, your file will open in the Edit tab. We’ll cover this more in Chapter 7: PDF Basics.

**Delete, Move, or Rename a File**

To move a file, just drag-and-drop it anywhere you want – a different folder, a different drawer, or anywhere outside of FileCenter. You can also use Ctrl +X to cut it, Ctrl + C to copy it, and Ctrl + V to paste it in a new place.

To multi-select files, hold down the Ctrl key while you click to select them singly, or to select a range, select the first file, hold down the Shift key, and click the last file.

You can rename files from the Files button > Rename File, or use the F2 key. By default, FileCenter will pop up a dialog to help you rename the file. We do this so you will have access to your naming rules, if you use them (we’ll cover this in depth in Chapter 8: Automate File & Folder Naming). If you prefer to rename your files inline, like you do in Windows Explorer, you can enable that. See Task 8: Enable Inline Renaming.

**Important:** Deleting files works just like deleting drawers and folders (see p. 29, Delete a Drawer or Folder), and the same warning applies. Namely, if the cabinet is on a removable or network drive, the deletion is permanent and irreversible! If the cabinet is on your personal computer, the deleted file(s) will go to the Windows Recycle Bin.
Change the Way Files are Displayed

You can choose how you want your files to display. For example, you can show them in a simple list, as large icons, as thumbnails, or in a table with detailed file information.

There are two ways to change the display style:

- Click the Display button above the list of files and change the Files View setting and, if appropriate, the thumbnail size
- Click the Files button > Views and select a display style

**Important:** Thumbnails are dependent on your Windows system. Some file types will display as thumbnails and others won’t, depending on what thumbnails Windows supports. FileCenter doesn’t have a way to force thumbnails if Windows doesn’t support them.

5.7 Add Files to Your Cabinets

Adding files is as easy as saving them into the directory where your cabinet is, or dragging-dropping or copy-pasting them into the cabinet. Here are more specifics.

Use FileCenter’s Save/Open Dialogs

FileCenter offers a feature to help you save files directly into FileCenter from your other programs. It replaces the Save dialog you usually see when you save files with a special FileCenter version that shows your cabinets. For example, when you save a document from Microsoft Word, you can see a special FileCenter Save dialog instead of the usual one.

This feature is completely optional. If you enable it, you can still switch back to a regular Save dialog on a case-by-case basis, or disable it completely for specific programs. We’ll cover it on p. 80, Integrate with the Save/Open Functions of Other Programs.

Save Files through Explorer

As we’ve already discussed, a FileCenter cabinet is just a normal Windows directory. If you’re not sure where that directory is, click the Cabinets button, find your cabinet on the list, and look at its Location.
Once you know where a cabinet is on your drive, it’s easy to add files. When you save a file from another program, just browse out to the directory where your cabinet is. You’ll spot the folders that represent drawers and find your way into the structure without any problem. Save your file where you want it in your cabinet. When you come back to FileCenter, it will be there.

Save Files as PDFs

PDF is a good choice for sharing files or archiving files if you know they don’t need to change in the future. It’s also a good choice for web pages and emails. A PDF is like a “snapshot” of a file. It isn’t intended for editing.

To save a file as a PDF, you actually “print” it to a special PDF printer. This creates the snapshot.

FileCenter includes a PDF printer called, appropriately, FileCenter PDF Printer. If you print an item to this printer, FileCenter will ask you where you want to put it, then save it as a PDF file.

Pro Only: This feature is only available in FileCenter Professional and Pro Plus.

Save Web Pages

While you can save web pages as HTML files, you’ll usually either lose the formatting or end up with a folder full of supporting files.

You are better off saving web pages as PDF files, as we discussed in the last section.

Save Email Attachments

Email attachments are just like any other file. You can save them right into your cabinets. For example, in Outlook you’d do this:

1. Open the email message in Outlook
2. Right-click on an attachment
3. Select Save As or Save All Attachments
4. Browse to the location where you want to save the file(s)
5. Click Save

Assuming you saved them into a cabinet, they will immediately show up in FileCenter.
Save Email Messages

While you can save email messages as PDF files, FileCenter also offers mechanisms to save them as actual files that will still open in Outlook (or your email program). We’ll discuss this later, in Chapter 20: Use FileCenter with Email.

Drag/Drop or Cut/Paste Files into FileCenter

Think about how you normally move files around – you either cut/paste them from one place to another, or you drag them from one spot and drop them in another. The same technique works for bringing files into FileCenter.

Just open up Windows Explorer, find the files you want to import, and either drag/drop them into FileCenter or cut/paste them into FileCenter.

To multi-select files, you can select them one-at-a-time by holding down the \textit{Ctrl} key while you click on each one, or to select a range, select the first file, hold down the \textit{Shift} key, and click the last file.

To copy files, press \textit{Ctrl} + \textit{C}. To cut files (move them), press \textit{Ctrl} + \textit{X}. To paste files in FileCenter, press \textit{Ctrl} + \textit{V}. 
Chapter 6: Scanning Basics

FileCenter aims to make scanning as fast and easy as possible. We have worked hard to streamline every aspect of scanning, reducing mouse clicks and eliminating extra steps and complexity wherever possible.

While there are a lot of time-saving power features, which we’ll cover in Chapter 16: Advanced Scanning and Chapter 17: Speed Up Repetitive Scanning, right now we’ll go over the basic steps that will serve the needs of most users.

6.1 Scanner Requirements

To use FileCenter’s scanning features, you need a scanner that comes with a TWAIN driver. Most desktop scanners do have TWAIN drivers, but if you’re in doubt, go out to your scanner maker’s website and look for a “Downloads” or “Drivers” link. Locate your scanner, and see if there’s a TWAIN driver you can download for your scanner and your version of Windows.

It’s not a bad idea to go ahead and download the driver, then install it. It will install just like a program. This will ensure that you have the latest bug fixes and features for your scanner.

Portable Scanners

Portable scanners – small, thin scanners that run off a battery and work without being connected to a computer – function a lot like digital cameras. Scans get saved right on the scanner (often to a memory card). Then you connect the scanner to your computer and transfer the scans over.

While you can’t use FileCenter’s scanning features with portable scanners, FileCenter’s Inbox is the perfect tool for pulling your scans into FileCenter. The inbox knows how to connect to your scanner without any effort on your part. Then you can use the easy Move button to pull scans off your scanner and file them away in one simple step.

To learn how to use it, see p. 60, The Inbox.
**ScanSnap Scanners**

Fujitsu ScanSnap scanners have grown in popularity due to their ease-of-use and excellent reliability. Unfortunately, they do not come with TWAIN drivers.

Fortunately, we have worked out an integration for the ScanSnap that will let you set FileCenter as a ScanSnap option. You will be able to scan directly into a FileCenter cabinet or FileCenter’s *Edit* tab. The integration requires you to change a couple of simple settings in your ScanSnap software. For instructions, see Task 9: Integrate with a ScanSnap Scanner.

*Note:* You won’t be able to use FileCenter’s regular scanning features with your ScanSnap, so the only section in this chapter that applies to you is p. 38, Scan with a ScanSnap. Chapter 16: Advanced Scanning won’t apply to you either, but Chapter 17: Speed Up Repetitive Scanning, does describe some features that will work with a ScanSnap.

**Network Scanners**

A “network scanner” is a scanner that isn’t connected to any computer. Instead, it sits on the network and simply saves new scans to a folder.

FileCenter can’t communicate with a network scanner (unless it happens to come with a TWAIN driver, which is rare but not unheard of), so you won’t be able to use any of FileCenter’s scanning features.

FileCenter does offer a feature designed specifically with network scanners in mind: the *Inbox*.

The Inbox is just what it sounds like: a place to receive incoming files and move them into your cabinets. Because a network scanner saves new scans as files, you can set FileCenter to show you those files in its *Inbox* tab. Then a couple of simple tools will help you store the files.

To learn how to use it, see p. 60, The Inbox.

### 6.2 Connect to Your Scanner

To connect to your scanner, make sure it’s plugged into your computer and turned on. Then:

1. Click *Scan* in FileCenter
2. Notice the *Scanner* field in the *Options* section, about mid-way down
3. Click the *Select* button
4. A scanner selection window will pop up; click *Select Driver*
5. A list of scanners will pop up; select your scanner

If your scanner shows up on the list more than once, see TWAIN vs. WIA below.

**TWAIN vs. WIA**

It’s not uncommon for a scanner to show up more than once on the list. When this happens, one of the entries usually starts with WIA. In most cases, you should avoid this option.

On rare occasions, the WIA option will work when other options don’t. So don’t be afraid to try it, but only as a last resort.

### 6.3 Scan in Edit View

The most familiar way to scan is in the *Edit* view. If you’ll recall, the *Edit* view is a PDF editor. You can open and edit PDFs here, and you can also scan here. Let’s try a scan:

1. Make sure you’ve selected the *Edit* tab at the very top of FileCenter
2. Click the *Scan* button on the main toolbar
3. For now, accept all of the defaults and just click *Start Scan*

Your scanner should perform the scan and it should show up in FileCenter. If you experience problems, see p. 38, Troubleshoot Scanner Problems.

If you’re happy with the scan, the next step is to save it. Just click the *Save* button on the main toolbar, pick where to save the scan, and give it a name.

Once you’ve saved it, you can close the scan. Click the small red “X” right above the view of the scan, on the right side.

### 6.4 Scan Straight to File

The fastest, most efficient way to scan is directly into a cabinet. With this method, you’re scanning straight to file, skipping the intermediate step of bringing the scan into a viewer.

To see how it works, try this:

1. Make sure you’ve selected the *Manage* tab at the very top of FileCenter
2. Select a location
3. Click the Scan button on the main toolbar
4. Notice that now there’s a section on the Scan dialog called Save As with a Filename option
5. Type in a filename; FileCenter will save the file under this name
6. Accept all of the defaults and click Start Scan

Your scanner will perform the scan and it will show up as a new file in FileCenter. Notice that you’ve skipped the intermediate steps of previewing the scan, saving it manually, and closing it.

6.5 Scan to a Word Processor

Sometimes all you care about is the text in a scan. You can use FileCenter to pull the text out of a scan and send it to your word processor.

To see how it works, do this:

1. In either the Manage or Edit view, click the Scan button
2. Under Action at the top, select Scan to Word
3. Perform the scan

Your scanner will perform the scan, then FileCenter will quickly extract the text and pop it open in your word processor.

Note that FileCenter will strip all of the formatting out of the scan. You won’t get any of the original fonts or formatting.

**Tip #1:** If you want to preserve all of the original fonts and formatting in Word or if you want to send a table to Excel, see p. 89, Convert to Word, Excel, etc.

**Tip #2:** FileCenter will normally send the text to Microsoft Word, if it’s installed. If you want to use a different word processor, see Task 10: Use a Different Word Processor with Scanning/OCR.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

6.6 Scan with a Portable Scanner

While you can’t scan straight into FileCenter with a portable scanner, getting your scans is still a simple process. Just follow these steps:
1. Do your scanning
2. Plug the scanner into your computer or put the scanner’s memory card into your computer’s card reader
3. Start FileCenter
4. FileCenter will automatically detect the scans on your scanner and list them
5. Use the Move button on the main toolbar to move the scans into FileCenter

For more details, see p. 60, The Inbox.

6.7 Scan with a ScanSnap

With a Fujitsu ScanSnap scanner, you will normally want to scan in the Manage view. Here’s the workflow:

1. Make sure you’ve selected the Manage tab at the very top of FileCenter
2. Select the drawer/folder where you want the scan to go
3. Run your scan through the ScanSnap
4. If prompted, send the scan to FileCenter
5. The file will show up in your current location in FileCenter
6. FileCenter will prompt you for the filename you want to use

The other option is to scan into FileCenter’s Edit tab. This is a good option if you like to visually inspect each scan. The workflow is similar:

1. Make sure you’ve selected the Edit tab at the very top of FileCenter
2. Run your scan through the ScanSnap
3. If prompted, send the scan to FileCenter
4. The file will open in the Edit view
5. When you’re satisfied with the scan, click Save and choose where to save it

Note: For the integration to work, you have to change a few ScanSnap settings. See Task 9: Integrate with a ScanSnap Scanner.

6.8 Troubleshoot Scanner Problems

If you’re having trouble getting your scanner to work, see Task 11: Troubleshoot Scanner Problems. If your scans are going through but there are problems with the images, see Task 13: Troubleshoot Scanned Image Problems.
Chapter 7: PDF Basics

The PDF file format has grown in importance to the point that PDF is now the de facto standard for sharing and archiving documents. As a result, we've made PDF an integral part of FileCenter. FileCenter has a whole array of easy-to-use features to help you make and manipulate PDF files. In this chapter, we'll touch on the high points. Later, we'll cover the whole lineup of features in Chapter 12: Work with PDF Files, and Chapter 13: Use the PDF Editor.

7.1 The Edit Tab is for PDF Files

As we discussed earlier, FileCenter’s Edit view is a place to open, view, and change PDF files. It is a full PDF editor, integrated right into its own tab in FileCenter. For a full explanation of the difference between the Manage and Edit views, see Chapter 3: The FileCenter Interface.

Open PDF Files in FileCenter

To open a PDF in the Edit tab, do any of the following:

- Double-click a PDF in the Manage view; when asked, select Open in FileCenter
- Select a PDF in the Manage view, then go to the Files button > Open in FileCenter
- In the Edit view, click the Open button and browse out to a PDF file

Overview of the PDF Editor

Once you’ve opened a PDF in the Edit view, you will see page thumbnails on the left and a large page view on the right. You can customize all of those windows. For example, drag the separator between the thumbnails and the page view to see more thumbnails at a time, or use the “zoom” buttons to resize the thumbnails. To see bookmarks instead of thumbnails, go to the editor’s View menu > Bookmarks.

In fact, you’ll have noticed that the editor has its own menu bar and toolbar. This is where you’ll find most of the editor’s features. At the same time, all of the buttons on FileCenter’s main toolbar will still work. For example, the Scan button will start a new scan, and the Email button will email a copy of whatever PDF is open in the editor.
The *Actions* button is especially important. It has a long list of powerful features you can use on your PDF documents, like splitting or combining documents, moving pages between files, etc. We’ll discuss those features in detail in Chapter 12: Work with PDF Files.

We’ll go over common PDF tasks, like filling out forms, adding comments, deleting stray marks, redacting text, etc., in Chapter 13: Use the PDF Editor.

**Save Changes**

It’s important to understand that when you make changes to a PDF in the *Edit* tab, you have to save your changes. As we said earlier, working in the *Edit* tab is no different than opening a file in Microsoft Word and making changes. If you close without saving, you’ll lose the changes.

To save your changes, use the *Save* button on the main toolbar. You’ll also find a *Save As* option in the drop-arrow under the *Save* button.

**Close PDFs**

When you are done with a file in the *Edit* view, you need to close it. Use the red “X” button right above the page view of the file, on the right. Alternatively, use the small “x” on the PDF file’s tab in the editor.

### 7.2 PDF in the Manage View

We have also made a lot of PDF functionality available in the *Manage* view. Since this is where you organize your files, it only made sense to let you combine and split PDF files here too. For example, if you drop PDF files on each other, FileCenter will combine them. Some people refer to this as “stacking”. By the same token, you can split a PDF file into multiple files.

One feature that’s only available in the *Manage* view is PDF conversion. Here you can select a non-PDF file (like a Word document), click the *Convert* button, and make a PDF copy of it. This works for most common files.

You’ll find the whole list of features in the *Actions* button on the main toolbar. Our purpose right now is to make you aware of them. We’ll go over them one-by-one on p. 91, The “Actions” Button.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.
7.3 The PDF Printer

As we touched on earlier, FileCenter includes a PDF “printer”. You use it just like any other printer, except instead of printing the document, this printer saves it as a PDF file. For example, to save a web page as a PDF:

1. Go to the web page in your favorite web browser
2. “Print” the page (Ctrl + P works in most browsers)
3. When the Print dialog comes up, select FileCenter PDF Printer as the printer
4. Click Print
5. When asked, give the new PDF a name and a location

This will give you a PDF snapshot of the web page, a perfect way to archive the information. You can use the PDF printer anywhere that you can print.

**Important:** FileCenter installs a second PDF printer called XChange Internal Driver. You should *never* use this printer. It’s for FileCenter’s internal PDF conversions. If you use it as a printer, you’ll get watermarks and unpredictable results!

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.
Section 2: Getting Sophisticated
Chapter 8: Automate File & Folder Naming

If you want to get to your files quickly, you need a good, consistent cabinet layout and consistent way of naming and organizing files. This becomes even more important if you’re sharing files on the network. Every network user needs to name and organize files the same way. If you don’t enforce consistency, everyone will lose time hunting for documents.

FileCenter has three features that will not only make it effortless to be consistent, but that will actually speed up the time it takes to save files: Naming Options, Custom Lists, and Folder Templates. But before we show you how to use them, let’s take a few minutes and help you establish some guidelines for naming files.

8.1 File Naming Conventions

If you want your files to be easy to find, you need to be consistent in how you name them, and you need sufficient identifying information in your filenames. If you consistently follow the same pattern every time you name your files, you’ll easily predict what a file’s name will be and you’ll find it without hunting.

Wise users set up a file naming convention and stick to it religiously. In other words, they decide how they’re going to name their files – what elements a filename will contain and how to format them – and they follow those self-imposed guidelines religiously.

Elements of a Naming Convention

As we’ve worked with various companies over the years, we’ve noticed the ones that use clear, predictable filenames. While the filename styles vary widely, we see certain elements show up again and again:

Begin with a date in the format YYYY-MM-DD. If being able to sort your documents chronologically matters to your business, consider this a requirement. The YYYY-MM-DD format makes it so files will always sort by date. Other date formats that we’ve seen:

- YYYYMMDD
- YYYY.MM.DD
- YYYY.MMDD
- YYYY-MMDD
We recommend always using a four-digit year; it makes the date format unambiguous and faster to read, and leaves no doubt about the century. If you don’t need the day, or even the month, you can obviously leave those off.

What date should you use when naming a file? For correspondence, the correspondence date. For official documents, like filings and court pleadings, use the filing or service date. For lab reports, the report date. For transactions, the transaction date. For any dated document, the date in the document. Otherwise, use the date you create the document.

**Name of the case, account, client, patient, etc.** Consider including the person or matter that this document pertains to. This will often correspond to the drawer name in FileCenter, if you use one drawer per case, client, patient, or account. A few examples:

1998-12-15, Estate of Esther Jones ...
2012.01.28 John Browning ...
19640129 – Frame, Roddy ...
2001-05-14, Joseph v. Samuels ...
2005.11.06 ~ Johnson Electric ...

**Transaction number, account number.** Alternatively, if you run a transactional business rather than a business based on clients, customers, or patients, you might include a transaction identifier or account number as one of the first elements in the filename.

**Document type.** Identify what kind of document this is: patient intake form, lab report, purchase order, court brief, opinion letter, official response, invoice, etc. While we don’t encourage abbreviations, this is one place where clear, standardized abbreviations can help. See our discussion on abbreviations below.

**Correspondence.** For correspondence, consider including the party’s name along with a “T” or “F” to indicate “to” or “from”. Some use the abbreviations *LT/LF* for “letter to/from”, *FT/FF* for “fax to/from”, and *ET/EF* for “email to/from”. Some formats we’ve seen:

... Robert Johnson (LT) ...
... LT Johnson, Sara ...
... ET Jose da Silva – email subject line ...
... FF Sara Bingham, fax description ...

**Subject matter.** If you feel you need to describe the document further, add a short description or a couple of keywords. In the case of email, you might include the original email subject line.

**Increment.** If you could potentially end up with multiple files sharing identical names, like a lengthy email exchange, put an increment or “counter” at the end. Decide how many characters you’ll need and use a zero-padded number. For example, if you could end up with
Field separation. Finally, decide how you’re going to separate the different elements of your filename. Some users who prefer conciseness will just string everything together with spaces, while others will use special characters to separate the chunks of information. It doesn’t really matter what you choose as long as each piece of information “pops” out easily and as long as you’re consistent.

You can’t choose any of these: `< > : " / | ? *`. Common separators are a dash (with or without spaces), commas, tildes, parentheses, and periods. Examples:

- 1998-12-15, Estate of Esther Jones, LT Sara Johnson.pdf
- 2012.01.28 John Browning PO 01.pdf
- 19640129 – Frame, Roddy – Lab Results.pdf
- 2001-05-14, Joseph v. Samuels, Motion to Dismiss.docx
- 2005.11.06 ~ Johnson Electric ~ LF Human Resources.pdf

As a rule of thumb, don’t choose a character that’s used in any of the fields. For example, if you separate your dates with a dash, don’t use dashes to separate the fields:

- 1996-06-15 – Alice Frame – Living Will.pdf

… isn’t as clear as:

- 1996.06.15 – Alice Frame – Living Will.pdf

Or if you display your party names as “Last, First” you won’t want to use commas to separate fields:

- 1996-06-15, Frame, Alice, Living Will.pdf

… isn’t as clear as:

- 1996.0615 ~ Frame, Alice (Living Will)

**Important:** Some long-time PC users still avoid using spaces and truncate their filenames, like this: *SomeFileName.doc*. In the days of DOS, when we were limited to 8 character filenames, that was almost required. But those days have long passed. Use spaces! If you don’t, your filenames will be less readable, and worse, indexers will treat the whole filename as a single word, making filenames harder to search.
**Other Considerations**

**Should you include a date?** Some files don’t need a date context. In those cases, you can obviously omit the date. Research libraries, contact information, and form templates are obvious examples.

When a date does matter, some users prefer to just rely on the file’s *Created* date in Windows. FileCenter does let you sort by the file’s date – just click the *Display* button above the list of files and select a sorting option.

But be aware that there are potentially two problems with relying on the Windows date. First, it assumes that the date you create the file is the right date to use for the file. But what if you’re scanning an old document? The document’s date won’t match Windows’ file date. Second, you’re assuming that the Windows date won’t change. As a general rule, programs should never change a file’s *Created* date, but be aware that some programs will anyway. File synchronization software in particular has been known to fiddle with dates.

**Should you use abbreviations?** Abbreviations can help shorten the name, and sometimes even make it more readable ... to a point. But if you decide to use abbreviations, limit them to your most common terms and establish a standardized list. Don’t let your staff use their own idiosyncratic abbreviations; limit them to the standardized ones, otherwise your filenames will get cryptic and hard to search. Also, don’t go overboard with abbreviations. Readability and clarity matter more than brevity.

Good abbreviations will expand easily in your mind. If you’re having to pause and decipher every abbreviation, it’s going to slow you down. So while “PO” is an obvious abbreviation for “Purchase Order”, “MT” could mean either “Motion”, “Meeting”, or “Minutes”. “MOT”, “MTG”, and “MIN” would be better. Sometimes just taking out the vowels produces a good abbreviation, or taking the first three, four, or five characters of the word, or the first letter of each word.

For a good rule of thumb when setting up your abbreviations, think about a new staff member coming into the office. How quickly and easily will they understand your filing system?

**Do I need to include the client, patient, case, etc. if it’s in the drawer/folder name?** Some would argue that if you’re putting the file in well-named folders, you don’t need to duplicate that information in the filename. For example, if you’re filing something in the “ABC Industries” drawer and “Widget Contract Renegotiation” folder, do you need to include those elements in the filename too?
Arguments for: If you remove a file from the cabinet, it loses some of its identifying information unless that information is also in the filename. For example, if you put a file on a thumb drive, you won’t know what client/matter it belongs to unless that information is in the filename. The same argument applies to misfiled items. If the filename holds the file’s complete information, it’s easy to find missing files and return them to the right location.

Arguments against: In Windows, the safe working filename length is 260 characters. If it gets longer than that, some programs won’t be able to work with the file. Note that when we say filename, we’re actually referring to the full filename, folders and all. So if you tend to use really long, descriptive folder names and really long filenames, you could easily surpass 260 characters.

There’s also a practical limit on how many characters Windows will display. For example, if you show your files as thumbnails, you might see as few as 35 characters of the filename. If you use the Details view style, you can expand the filename column to show more of the name, but don’t expect to see more than about 75 characters.

You can mitigate these limitations with the careful use of abbreviations.

8.2 Pre-Defined Filenames

You can set up a list of your most commonly-used filenames, then when it’s time to save/rename a file, you just pick a name from the list. This means you can name a file in just two or three mouse clicks, never touching the keyboard.

For even more power, your names can have dynamic elements in them, like dates, client/customer names, counters, etc.

We call these pre-defined filenames Naming Options.

Pro Only: Naming Options are only available in FileCenter Professional and Pro Plus.

Create Naming Options

You’ll set up your naming options from the Naming button on the main toolbar (in Manage view). Click Add to add a new filename to the list.

Build your naming option in the Expression field. You can type in text by hand:
You can also add dynamic fields to the expression. Here are some examples of how fields can be translated into filenames:

«FOLDER Drawer» Engagement Letter
Robert Johnson Engagement Letter

«DATE mmmm» Monthly Newsletter
August Monthly Newsletter

To insert a field, do the following:

1. In the expression, position the cursor where you want to insert the field
2. In the lists above, select the Field Type and, if applicable, the Field Option
3. Click Insert Field into Expression

This will insert your field into the filename expression. You can add text before or after the field, or cut and paste the field into a different part of the expression. With dates, you can even modify the date format in the field.

To remove a field from the expression, simply delete it using your keyboard. You can also clear the entire expression using the Clear Entire Expression link or just the increment portion of the expression using the Clear Increment link.

**Dynamic Fields**

Here are the dynamic fields available to you:

**Original Filename.** When you are renaming a file or saving a file under a new name, you can use the original filename as part of a naming option. Select the General option > ORIGINAL Name.

For example, if a file is named `c:\files\resume.doc`, the original filename is `resume`.

If you pair the original filename with an Increment, you can make it easy to save new versions of a file:

    resume 01
    resume 02
    resume 03
    ... etc.
**Username or Computer Name.** Sometimes a good way to identify a file is by the user who created it or the machine where it was created. Under the General section, you’ll see two options: *USER Name* and *COMPUTER Name*. These fields will insert either your Windows username or the name of your computer on the network. If you’d like to see what these values are, go to the drop-arrow under the *Help* button > *About* and you’ll see them listed.

**Folder Name.** You’ll usually be saving files into cabinets, which means the file will go into a drawer and possibly folders. You can use the drawer and folder names as part of a naming option. For example:

```
c:\cabinet\Johnson\Trusts
```

This path has a drawer name (*Johnson*) and a folder name (*Trusts*). You can use those names as part of the filename. Why would you want to? Many businesses use client or patient names for drawer names, or maybe a case name or case number. If that’s true for you, you’ll be able to pull the client name, case number, etc. into your filenames.

For example, if you use one drawer for each client, the drawer name will have the client’s name. If, on the other hand, the first folder in a drawer contains the client name, you may be more interested in using that folder as a field.

The *Drawer Name* field option will always refer to the drawer, if there is one. Folder names are supported up to three levels deep. You can reference them either down from the drawer, or up from the file:

```
Drawer\Level 1\Level 2\Level 3\File.doc
```

```
Drawer\Parent 3\Parent 2\Parent 1\File.doc
```

If you save to a location outside of a cabinet, or you don’t use drawers, you’ll only be able to use the *Parent* locations:

```
c:\...\Parent 3\Parent 2\Parent 1\File.doc
```

**Dates.** The date fields will insert a formatted date. You have three dates to choose from. *Date/Time* will insert the current date. If you are renaming an existing file, you can use *Date Created* to get the date the file was originally created, or *Date Modified* to get the date when it was most recently changed.

You have a list of date formats to pick from, but you’re not limited to those choices. If you want to come up with your own format, insert any date format from the list, then modify it with these formatting identifiers:

- **d** – Day of month without a leading 0
• **dd** – Day of month with a leading 0
• **ddd** – Abbreviated day of the week (*Sun*, *Mon*, etc.)
• **dddd** – Full day of the week (*Sunday*, *Monday*, etc.)
• **m** – Month as a number without a leading 0
• **mm** – Month as a number with a leading 0
• **mmm** – Abbreviated month name
• **mmmm** – Full month name
• **yy** – Two-digit year
• **yyyy** – Four-digit year
• **h** – Hour without a leading 0
• **hh** – Hour with a leading 0
• **n** – Minutes without a leading 0
• **nn** – Minutes with a leading 0
• **s** – Seconds without a leading 0
• **ss** – Seconds with a leading 0

You can use spaces, commas, and dashes between the date elements and arrange the date elements however you want. You can also omit any of the date elements. For instance, you may want to use only the current month or the current year.

**Important:** You cannot use a forward slash “/” in your date format, since Windows won’t allow it in filenames.

**Tip:** You can add your favorite date formats to the list. Go to Settings > Date Formats.

**Auto-Increment.** Think of an *increment* as a counter. You’ll want to use increments when you’ll end up with a lot of files with the same name in the same folder.

The auto increment will automatically add a number to the end of the filename. For example, if a folder will contain many files called *Report.doc*, the auto-increment will name them *Report 01.doc*, *Report 02.doc*, *Report 03.doc*, etc.

You have a few increment formats to choose from, each one padding the number with more 0s. When you insert the increment field, it must always go at the end of the expression. An increment cannot be customized or edited.

**Content.** The *content* field pulls text out of the document to use in your filename. You can pull values from barcodes, text from specific regions on a page, or text that matches certain patterns or criteria. For example, it can grab names, dates, invoice numbers, etc. to create truly
dynamic filenames. The content field is sophisticated enough to deserve its own chapter. To learn more, see Chapter 15: Tap into Document Content.

**Pro Plus Only:** This feature is only available in FileCenter Pro Plus.

**Variable.** A variable field gets its value from you at the time you scan or run OCR. On the *Scan* and *OCR* dialogs, you’ll see a Variable tab. Here you enter the value that you want inserted in the variable field. See p. 141, Variables Tab for more information.

When you create a variable field, you need to give it a name. The name is *not* case sensitive. It can contain any characters you want except a space or an “=” sign.

**Pro Plus Only:** This feature is only available in FileCenter Pro Plus.

**Character Formatting within Fields**

For advanced users, it’s possible to apply some character formatting to an individual field, like altering the capitalization or limiting the field to a certain number of characters. The following formatting flags are available:

- `-DT format` – Converts the value into the date format specified
- `-L{n}` – Returns a specific number of characters from the left side of the string
- `-LC` – Puts all of the text in lower case
- `-LN` – Converts certain letters to numbers, like "S" to "5" and "O" to "0"
- `-NS` – Removes all spaces from the string (“no spaces”)
- `-R{n}` – Returns a specific number of characters from the right side of the string
- `-RC{characters}` – Removes individual characters from the string (case sensitive)
- `-RT{text}` – Removes a string of text from the string (case sensitive)
- `-SR{find,replace}` – Perform a search and replace within the string (case insensitive)
- `-TC` – Capitalizes the first letter of each word (“Title Case”)
- `-UC` – Puts all of the text in UPPER CASE
- `-X expression` – Pulls out a portion of the field’s text based on a regular expression

**Note:** These formatting codes only apply to the specific field that they’re placed in. They don’t affect the rest of the naming option.

**Using the Formatting Options:** To use any of these formatting options, put the flag in square brackets “[ ]” at the end of the field, before the closing chevron. A few examples:

```plaintext
«FOLDER Drawer [-LC]»
```
Date/Time: The \texttt{-DT} flag converts a date into a different format. Note that with \textit{date} fields, this isn’t necessary. But \textit{content} fields may give you dates that need to be reformatted. The formatting codes are explained in Dynamic Fields, above.

Left/Right: The \texttt{-Ln} and \texttt{-Rn} flags are used to trim down the text to a fixed number of characters. When would you need this? Suppose that your drawer names also contain a client ID number at the end, like this: \textit{Johnson, Robert – 65298}. If you want to use this ID number in your filename, you’d include the flag \texttt{“-R5”} which would give you the last five characters of the drawer name, or \textit{65298}:

\begin{verbatim}
«FOLDER Drawer [-R5]»
\end{verbatim}

Remove Characters/Text: You can strip out individual characters or strings of text from the string. For individual characters, list out all of the characters you want removed. For example, to strip out all punctuation:

\begin{verbatim}
«FOLDER Drawer [-RC{,.:;?}]»
\end{verbatim}

Text removal works the same way. The only difference is that you’re providing an exact string of text to remove. For example, to remove the text \textit{“Invoice”}:

\begin{verbatim}
«CONTENT Zone 1 [-RT{Invoice}]»
\end{verbatim}

Search and Replace: The \texttt{-SR} flag allows you to do a search and replace within the string. For example, to replace all underscores \texttt{“_”} with spaces:

\begin{verbatim}
«COMPUTER Name [-SR{_, }]»
\end{verbatim}

To do multiple search-replace operations, chain them together like this:

\begin{verbatim}
-SR{search\_a,replace\_a,search\_b,replace\_b}
\end{verbatim}

For example:

\begin{verbatim}
«CONTENT Zone 1 [-SR{v.,versus,et al.}]»
\end{verbatim}

This replaces \texttt{“v.”} with \texttt{“versus”} and removes the phrase \texttt{“et al.”} (replaces it with nothing). There’s no limit to the number of search-replace operations you can perform. For example, to convert numbers to letters (to compensate for OCR mistakes), you might do this:

\begin{verbatim}
«CONTENT Zone 1 [-SR{0,O,1,I,2,Z,5,S,6,G,7,T,8,B}]»
\end{verbatim}
Comments: You can include your own comments in the square brackets. This is a nice way to identify otherwise-obscure fields:

«FOLDER Drawer [-LC The client name in lower case]»
«CONTENT Zone 1 [INTAKE FORM DATE]»
«CONTENT Zone 1 [-L25 ~ INTAKE FORM DATE]»
«COMPUTER Name [-TC -L5 (first five chars)]»

Tip: You can set off the comment from the formatting codes any way you want. Just make sure you don’t use any characters that are invalid in a filename and that you don’t use any characters with special significance in naming options (like apostrophes, single quotes, double quotes, chevrons, commas, dashes, and square brackets).

Regular Expressions: Special rules apply to the regular expression option:

The regular expression must be the last formatting item in the list, and you can’t include any comments. For example:

«COMPUTER Name [-TC –X ^\w+]»

If you want to capture text from a set of parentheses in the expression, indicate the set number after the –X. For example, to capture the text between two commas in the drawer name, use the following:

«FOLDER Drawer [-X1 , ([a-zA-Z.\- \]+),]»

We’ll cover regular expressions in depth on page 122, Regular Expression Syntax.

Important: Some programs require regular expressions to begin and end with forward slashes /like_this/. Don’t use the forward slashes in FileCenter.

Control Where a Naming Option Appears

When setting up a naming option, you will see a list called Filter on Folders. This feature is a way to categorize your naming options by folder name.

The easiest way to describe this feature is with an example: Suppose a law firm does two kinds of work for its clients, tax planning and estate planning. All tax planning work goes into a client folder called Tax Planning, and all estate planning work into a folder called Estate Planning. The firm has set up dozens of naming options. The problem is that the naming options are specific
to either tax planning or estate planning. When they save a tax planning document, they don’t like the list getting cluttered with estate planning options, and vice versa.

The Filter on Folders feature allows the firm to dictate when a naming option will show up. The controlling factor is the name of the folder where the firm is saving a file. If the firm is saving into a folder named Estate Planning, only the estate planning options will show up.

To use this feature, type in all of the folder names where the naming option should be allowed to appear. Enter one folder name per line. Case doesn’t matter, but it must otherwise be an exact match. There are a few special rules, which the following examples will illustrate:

- **tax** – You must be directly in a folder called “tax”
- **tax*** – Any folder in the path can be called “tax”
- **tax\returns** – You must be directly in a folder called “returns” under a folder called “tax”
- **tax\returns*** – The folder sequence “tax\returns” must be somewhere in the path

In other words, adding an asterisk (*) at the end of a folder name makes it so the folder can be anywhere in the path – your current folder, a parent folder, the drawer name, etc. In fact, you can even restrict a naming option to a specific cabinet by using the name of the cabinet’s folder.

You can require a specific sequence of folders by using backslashes (\) between them. There’s no limit to the number of folders you can string together, but they must follow that sequence exactly. If you include a trailing asterisk (*), the sequence can appear anywhere in your path (but the specific sequence must still match exactly).

**Use Naming Options**

Here’s how you’d typically use a naming option:

1. Rename a file, or save a file through FileCenter’s Save dialog
2. Notice that the Filename field has a drop-arrow on the end
3. Click this button to show your naming options
4. Pick a name from the list
5. Save

Naming options are available anywhere you enter a file or folder name in FileCenter.
Create Naming Options on the Fly

You can also add a naming option on-the-fly, which makes sense because the time when you’ll usually need a new naming option is when you’re in the middle of saving or renaming a file. When you bring up the list of naming options, you’ll notice New and Edit links in the upper right-hand corner. Use these to add or modify a naming option.

8.3 Custom Lists

Naming options work well if you have a fairly narrow set of rigid filenames. But some users need more flexibility in naming their files while still drawing off of predefined lists for consistency. That’s where the Custom Lists feature comes into play.

Custom lists are just that – your own, personal lists of items that find their way into filenames. When it’s time to name a file, you can pop up your lists, click on items to build a filename, then click Save.

Create Custom Lists

You’ll find custom lists in the same place as naming options. Click the Naming button on the main toolbar (in Manage view), then click the Custom Lists tab.

To create a new list, click Add, then follow these steps:

1. Give the list a unique name – something that describes the list
2. Type your list items in the space below, one per line
3. If you want to sort your items alphabetically, click the Sort button
4. Click OK

Now you’ll see your list on the left with a preview of the list items on the right. You can create as many different lists as you want. Normally you’d want your lists to each be a different category. For example, you might have a list called Attorneys with the names of all attorneys in the firm, or Utility Companies with the name of each utility you pay bills to. But these are just suggestions. You can use custom lists any way that makes sense to you.

Using Custom Lists

Here’s how you’d typically use a custom list:
1. Rename a file, or save a file through FileCenter’s Save dialog
2. Notice that the Filename field has a “…” button on the end; click the button
3. If you have naming options you’ll see them first; just click the Custom Lists tab
4. Select a list on the left
5. Double-click a list item to insert it into your filename
6. Do the same for other list items
7. Type in any other text you need to add
8. Click Save

Like naming options, custom lists are available anywhere you enter a file or folder name in FileCenter.

Create or Add To Lists on the Fly

You can add new lists or add new items to your lists on-the-fly. Any time you have the custom list window open, you can use the New and Edit links in the upper right-hand corner to add or modify a list.

Pair Custom Lists with Naming Options

The real power of custom lists comes when you pair them with naming options.

For example, suppose a law practice commonly drafts about 20 different documents. When they name their files, they like to include the date, the client name, the document type, and the attorney’s name. Unfortunately, they have ten attorneys. If they created one naming option for each document type under each attorney, they would end up with 200 naming options.

Instead, they decided to pair naming options with custom lists. First, they set up a naming option for each document type, using the drawer name to insert the client’s name:

«DATE yyyy-mm-dd», «FOLDER Drawer», Living Will
«DATE yyyy-mm-dd», «FOLDER Drawer», Quitclaim Deed
«DATE yyyy-mm-dd», «FOLDER Drawer», Will
etc.

Next they set up a custom list of attorney names. Now when they save a file, they first select the naming option to fill in most of the information, then they insert the attorney’s name. They can still name a file with just a few mouse clicks, and they don’t have to scroll through hundreds of naming options.
Here is how to use naming options and custom lists together:

1. Rename a file, or save a file through FileCenter’s Save dialog
2. Notice that the Filename field has a “… ” button on the end; click the button
3. Go to the Custom Lists tab
4. Notice that the first list is Naming Options; select it
5. Locate the naming option you want and double-click it to insert it into the filename
6. Select another list on the left
7. Double-click a list item to insert it into your filename
8. Do the same for other list items
9. Type in any other text you need to add
10. Click Save

8.4 Folder Templates

Many users – business users in particular – tend to use the same folder layouts over and over. If you’re this type of user, you will appreciate the Folder Templates feature. Folder templates are simply pre-defined folder layouts. They can be simple lists of folders, or they can be massive folder trees with layer after layer of subfolders.

For example, suppose a dentist keeps all of her patient records in FileCenter, one drawer per patient. Every patient drawer needs to have exactly the same folder layout for organizing the patient records. The dentist sets up her layout as a folder template. Now, whenever she adds a drawer, FileCenter sets up all of the folders for her.

Create Folder Templates by Hand

You will create and manage your folder templates from the Templates button on the main toolbar (in Manage view).

Click Add to create a new template, then follow these steps:

1. Give the template a unique name; this is just to help you identify the template
2. Click Add to add a folder to the list
3. Click Add Child to add a subfolder
4. Add will always add a folder at the same level as the folder you have selected; Add Child will always add a subfolder
5. Use Promote to bring a folder (and all of its subfolders) up one level
6. *Rename* and *Delete* should be obvious
7. Click OK when you’re finished

**Important:** If you update a folder template, it will not affect locations where you’ve already used the template.

### Create a Template from an Existing Layout

You can also create a folder template out of an existing folder layout. For example, suppose you have a drawer with a folder layout you want to use in other drawers. Do this:

1. Select the drawer
2. Click the *Drawers* button > *Create Folder Template from Drawer*
3. FileCenter will grab the folder layout and insert it in a new template
4. Give the template a unique name
5. Click OK

You can create a new template from any of these locations:

- Right-click on a cabinet’s tab > *Create Folder Template from Cabinet* (creates a template using all drawers and subfolders)
- *Drawers* button > *Create Folder Template from Drawer* (creates a template using the drawer’s folders)
- *Folders* button > *Create Folder Template from Folder* (creates a template from the selected folder)

### Apply a Folder Template

You can apply a folder template to a cabinet, drawer or folder.

**New Drawer/Folder.** When you add a drawer or folder, you’ll notice an option to *Apply Folder Template*. If you select this option, you’ll get a list of your folder templates. Select the template you want to use in the new drawer/folder. FileCenter will automatically add the folders for you when it creates the drawer (or folder).

**Existing Drawer/Folder.** To add folders to an existing drawer/folder, just go to the *Drawers* or *Folders* button > *Apply Folder Template*. If you’re applying it to a folder, the folders will get added under the *selected* folder.
Entire Cabinet. To add folders to a whole cabinet, right-click on the cabinet’s tab. You’ll see two options. First, you can **Apply Template to All Drawers**. This will add the folders to *each* drawer in the cabinet. In other words, if you have five drawers, the template will get applied five times, once to each drawer. Second, you can **Apply Template to Cabinet**. This will affectively populate an entire cabinet, creating drawers and possibly folders and subfolders. You would use this option if you have an entire cabinet layout that you reproduce regularly.
Chapter 9: Move Files

FileCenter features a few tools to help you bring files into FileCenter, move files around, and reorganize your cabinets.

9.1 The Inbox

Some users need to bring in files from an outside source. Two common examples: pulling files off of digital cameras, and retrieving scans from network scanner folders. To simplify this, FileCenter provides the *Inbox* tab.

Think of the *Inbox* tab as the place you go to see files that are ready for importing. You’ll choose what folder the *Inbox* shows. Normally this is going to be somewhere like the folder where your network scanner saves new scans, or the folder on your digital camera. You can then grab those files and bring them into FileCenter. Here’s how to get started:

1. Go to the *Inbox* tab
2. Click the *Inbox* button
3. Browse to the folder that has files you need to import
4. Click OK

You’ll now see the files displayed. To import them, do the following:

1. Select the file(s) you want to import (for multiple files, see below)
2. Click the *Move* button on the main toolbar
3. Browse to the place you want to save the files
4. Click OK

**Tip #1:** To select multiple files one by one, hold down the *Ctrl* key while you click each one. To select a range, select the first file, then hold down *Shift* while you click the last file. To select all files, press *Ctrl + A*.

**Tip #2:** If you need to see what a file is, click the *Preview* button on the main toolbar.

**Practical Example: Portable Scanner or Digital Camera**

If you have a portable scanner or digital camera, the inbox is an easy way to import your images. Just follow these steps:
1. Plug in your scanner/camera, or put its memory card in your card reader
2. Start FileCenter
3. In the **Inbox** tab, you should see the images that are ready for importing (if it doesn’t, see the tip below)
4. Use the **Move** button on the main toolbar to transfer images into FileCenter

**Tip:** When FileCenter starts, it automatically looks for digital cameras and portable scanners, then tries to locate the images. If FileCenter doesn’t find your images, just make sure you’re on the **Inbox** tab, then click the **Inbox** button and browse out to your camera/scanner. It will be on a drive called **Removable Drive**. You’ll find the images in a folder called **DCIM** then **100Media** or something similar.

**Multiple Inboxes**

You can have more than one inbox folder. To add another folder, just click the **Inbox** button and browse to the new folder.

To return to a previous inbox, click the drop-arrow under the **Inbox** button. You’ll see all of your prior inbox folders listed there. Just click one to open it.

**9.2 The Move Button**

For moving files within your cabinets, try the **Move** button on the main toolbar. It works just like it does in the **Inbox**. Namely, it prompts you for a new location, then moves the item there. This button works for files, folders, and drawers. Simply do this:

1. Select an item (it also works with multiple files)
2. Click **Move**
3. Browse to the new location
4. Click **OK**

**Tip:** When you move drawers and folders, they can get promoted/demoted, depending on where you put them. See How Folders and Drawers Might Change below.
9.3 The Split View

For more speed and power, use FileCenter’s Split View. This gives you a split screen to show two locations at the same time – one on top, one on bottom. With two locations open, you can easily drag and drop items from one place to another. Better still, FileCenter can rename items for you as you move them, saving you extra steps. But before we cover that, let’s understand the basics of the split view.

Basic Moving/Copying

With the split view open, you can select one location on the top and another one below. This makes it easy to move or copy items down from the top view into the bottom.

Take note of the bar between the two views. It holds some tools that will help you move files around. For example, on the right side of the bar you’ll find Move and Copy buttons. Here’s how they work:

1. Select items in the top window – a drawer, a folder, or files
2. In the bottom window, select the place you want them to go
3. Click Move or Copy
4. You’ll get a confirmation dialog
5. On the dialog, you have the option to rename the file as you move/copy it
6. Click OK

FileCenter will put the file where you selected.

Tip #1: If you choose to Copy the file, you can create a link instead of a copy. For more information, see Task 15: Create Links to Files.

Tip #2: If you’re moving a drawer between cabinets, try using the Drawers button > Move to Cabinet instead.

Drag-and-Drop; Drop Renaming

You can also drag/drop items from the top view into the bottom. The advantage of using drag-and-drop is both speed and the ability to rename multiple files as you move them. If you get comfortable with this feature, you will quickly appreciate how much effort it saves.
Notice the *Move* and *Copy* options on the *left* side of the middle bar under *Drop Action*. These control the action. In other words, if you have *Move* selected, all dragging/dropping will move the items. Likewise for *Copy*.

Next to those options, you’ll see a field. You can optionally use this field to rename items as you drag them. Either type in a new name or use *Naming Options* (see p. 47, Pre-Defined Filenames). Here’s how it works:

1. Choose a *Drop Action* in the center bar
2. Enter or select a new name
3. Select the item(s) you want to move/copy
4. Drag them from the top view to the bottom

FileCenter will rename the items as it moves (or copies) them.

**Important:** If you’re working with drawers or folders, where you drop them matters. They can change from folders to drawers and vice versa. We’ll discuss this in the next section.

**Tip #1:** You can use the drop renaming feature to rename files in bulk. See Task 16: Rename Files En Masse.

**Tip #2:** You can also drag/drop files from bottom to top, but the drop renaming feature won’t work.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

### How Folders and Drawers Might Change

If you understand the cabinet structure, you’ll realize that where you drop a folder or drawer can change the way it’s displayed. For example, if you drop a drawer into another drawer, it will turn into a folder. If you need to brush up on this, see p. 26, The Cabinet.

Here are some guidelines for how to move drawers and folders:

- To move a *drawer* and keep it a drawer, drop it on the *cabinet tab*
- To move a *folder* and keep it a folder, drop it on a *drawer or another folder* (it will become a subfolder)
- To turn a *drawer into a folder*, drop it on a *drawer*
- To turn a *folder into a drawer*, drop it on the *cabinet tab*
Combine the Split View with the Inbox

To add even more power to the Inbox, use it together with the Split View:

1. Go to the Inbox tab
2. Click Split View on the main toolbar
3. A cabinet window will open below
4. Browse to the location where you want to file your item(s)
5. Either use the Copy/Move buttons or drag-and-drop with Drop Renaming to bring the items into FileCenter

The Inbox paired with Drop Renaming is probably the fastest way you can file new items in FileCenter.
Chapter 10: Add More Power to Cabinets

Once you’ve mastered the basic concepts of cabinets, FileCenter has a whole lineup of power features waiting for you.

10.1 Favorites

Think of Favorites as bookmarks to cabinet locations you access frequently. You’ll spot the Favorites button right above the list of files. Here’s how to add a favorite:

1. Browse to the location (cabinet, drawer, folder) you want to bookmark
2. Click the Favorites button > Add Favorite
3. Give it a unique name
4. Click OK

Now to jump to the location any time, just go to the Favorites button and select it on the list. Use Favorites > Manage Favorites to re-order your favorites, sort them, or delete them.

Tip: You can include a Split View in your favorite. Open the split view, select locations in the top and bottom windows, then add your favorite. When you select the favorite in the future, it will automatically open the split view and select both locations, perfect for users who regularly move files between two specific folders.

10.2 Advanced File Options

Use these features for viewing and working with files. Note that we’ll cover even more file-related tools in upcoming chapters: file conversion, text recognition, PDF manipulation, and file search.

File Preview

One of the simplest but most useful features in FileCenter is the Preview Window. The preview window shows you what’s in a file without you having to open it. Perfect for when you’re hunting for a file, just needing a little bit of info out of a file, or needing to see what a file is before you rename it, the preview window will become one of your favorite go-to features. Many users leave it on all the time.
To open the preview window, just click the *File Preview* button on the main toolbar. It will show you whatever file is selected.

**Tip:** The preview window works in the *Inbox* tab too.

**Change the Preview Window’s Position.** You can put the preview window on the right side, the bottom, or in its own floating window. To change positions:

1. Open the preview window
2. Select a file to activate the previewer
3. Click the *Preview* button on the toolbar above the preview and select *Settings*
4. Change the *Location of Preview*
5. Click OK

**Change the Preview Engine.** For PDF and text-based files (like Microsoft Office files), you have a few preview engines to choose from. Each has its own way of displaying files. You’re generally best-off just using the defaults, but feel free to experiment with the others. To change the engine:

1. Open the preview window
2. Select a PDF or Office file
3. Click the *Preview* button in the preview window
4. Select a different engine from the list

If you find there’s an engine you like better than the default, you can make it the default in the *Preview* button > *Settings*.

**FileCenter Standard vs. FileCenter Pro & Pro Plus.** You can preview PDF and image files with all editions. With FileCenter Pro and Pro Plus, you get very good representations of over 500 different file types, including Microsoft Word, Excel, and PowerPoint, WordPerfect, CAD, etc. With FileCenter Standard, you get a text-only preview of the most common file formats.

**File Sorting**

By default, FileCenter will sort your files alphabetically, A-Z. Sometimes you may want to reverse the order or even sort on a different value, like the file’s *Create* date. To change the sort criteria:

1. Click the *Display* button right above the list of files
2. Select the *View and Sort* tab
3. Change the *Files Sort Direction* and/or *Files Sort Column*
4. Click OK

**File Filtering**

There are times when a user may want to look at only a specific kind of file, like just PDFs or just Word documents, or perhaps they only want to see files that fall within a certain date range, like just files modified in the last week. You can filter the list of files to only show the files you want to see. Here’s how to use it:

1. Click the Display button right above the list of files
2. Select the Filters tab
3. Select the criteria for the files you want to see
4. Click OK

When you get back to your cabinet, you’ll only see the files that meet the criteria you selected. You’ll also see the filter criteria displayed above the list of files, a visual reminder that your view is filtered. To temporarily pause filtering:

1. Click the label showing the filtering criteria above the list of files OR …
2. Click the Display button > Filtering tab
3. Select Pause Filtering
4. Click OK

The filtering label will change to show Filtering Paused, an indicator that a filter still exists but isn’t being applied. To turn the filter back on, repeat the steps above and de-select Pause Filtering.

To turn off filtering, repeat the steps above, but select Clear Filter, or click the drop-arrow next to the Display button > Clear Filter.

**Important:** Make sure you turn off filtering when you’re done, otherwise you might come back into FileCenter later and think most of your files got deleted.

**Tip:** There are shortcuts for turning on and off filtering under the drop-arrow next to the Display button.

---

**Enhanced Thumbnails**

FileCenter Professional offers an additional thumbnail mode: Enhanced Thumbnails. Enhanced thumbnails have a few benefits over regular thumbnails:
• You get thumbnails for every significant document type, over 500 in total. Standard thumbnails only support images, some PDFs, and Office files, depending on your version of Windows.
• Once the thumbnail gets generated, it will pop up instantly when you come back to the folder. Standard thumbnails regenerate every time.
• You can flip through the pages of multipage documents with the page selector above the files list.

To turn on enhanced thumbnails, simply click the drop-arrow next to the Display button and select Enhanced Thumbnails. To adjust the thumbnail size:

1. Click the Display button
2. Adjust the Thumbnail Size slider
3. Click OK

Enhanced thumbnails get cached (or saved) so FileCenter can display them faster when you come back to the folder. If it seems like a lot of space is getting eaten up on your C: drive from thumbnails, you can clear the cache. Go to the Files button > Clear Thumbnail Storage.

If you find that a thumbnail needs to be updated, select it, then either hit the F5 key on your keyboard, or go to Files > Reload Selected Thumbnails.

Pro Only: This feature is only available in FileCenter Professional and Pro Plus.

Choose Where PDFs and TIFFs Open

Because FileCenter has a built-in PDF editor, you can open PDFs (and TIFF images) right in FileCenter.

Opening PDFs/TIFFs when You're in FileCenter. By default, when you’re in FileCenter and you double-click a PDF or TIFF, FileCenter will ask where you want to open it: in FileCenter or in its regular program. You can change this behavior:

1. Click Settings on the main toolbar
2. Make sure General is selected on the left
3. Locate the option called When Opening PDFs from This Program
4. Select the option you prefer: Always Prompt, Open in FileCenter, or Open in the Default Program
5. Click OK
Note that this does NOT affect what happens when you double-click a PDF outside of FileCenter. It will still open in its regular program.

**Opening PDFs/TIFFs when You’re Not in FileCenter.** You can make FileCenter your *default* application for opening PDFs and/or TIFFs. This means that Windows will *always* open PDFs and TIFFs in FileCenter. The icons for your PDFs and TIFFs will change to a FileCenter icon. And any time you double-click a PDF or TIFF, whether FileCenter is open or not, it will open in FileCenter. You should consider this a *permanent* change.

Here’s how to do it:

1. Click *Settings* on the main toolbar
2. Make sure *General* is selected on the left
3. Select *Make this program your default PDF application* and/or *Make this program your default TIFF application*
4. Click *OK*

**Email a File**

One of FileCenter’s nice convenience features is the ability to email files. Just select a file (or files) and click the *Email* button on the main toolbar. FileCenter will open your email program and start a new message with the file(s) attached. You’ll also notice a number of helpful options if you click the drop-arrow under the *Email* button:

**Email as Link:** You can send a *link* to a file instead of the file itself, which is very useful on an office network where your recipient has access to the file. But be warned, most email and anti-virus programs will disallow the link because it’s a security risk. If you want to use this feature, you’ll have to get your IT person to configure your email server and your email client to allow LNK files.

**Email as PDF:** Use this option to send files as PDFs, even if they aren’t PDFs to start with. FileCenter quickly creates a PDF copy of the file in the background, then attaches the PDF to the email.

**Email as Secure PDF:** This works just like the PDF option, but you provide a password for the PDF. The attached file will be encrypted and password protected. (You should either tell the recipient the password in a separate communication, like over the phone).

**Email as Zip:** You can *zip* multiple files into a single, compressed file. This will shrink the file size, which often matters for attachments. Your recipient will need to know how to unzip a file.
Email and Rename: Sometimes you want to give a file a better name before you send it. With Email and Rename, FileCenter prompts you for the name you want to use. The attachment will have the new name, and the original file will remain untouched.

**Important:** FileCenter will not work with any email service that you have to access through a web browser, like Gmail, Yahoo, MSN, etc. To learn how to use FileCenter’s email feature with these services, see p. 183, Web Mail (Gmail, Yahoo, etc.).

**Tip:** If you see a mail setup screen when you try to email a file, it means you don’t have an email program set up. You’ll have to get a working email program on your computer before you can use the email feature.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

### 10.3 Advanced Folder Features

A handful of features – some obvious and some less obvious – can make folders even easier to work with. We have already discussed the most powerful of them back on p.57, Folder Templates. In this section, we’ll cover the others.

**Auto-Expand Folder Trees**

It’s possible to expand a folder and all of its sub-folders at once. You’ll find commands to expand/collapse folders in the Folders button. But FileCenter provides two other methods that are even more convenient.

The first way is through a keyboard shortcut. With a folder selected, hold down the Ctrl key and press the Down Arrow button. The whole folder structure under that folder will open. Ctrl + Up Arrow will collapse the folders.

You can accomplish the same thing by double-clicking on a folder, except you may need to turn on a setting first. Go into FileCenter’s Settings button, select Manage Files on the left, and select the option called Double-clicking Drawer/Folder expands all sub folders. With this setting in place, you can double-click a folder to expand it and all of its sub-folders. Double-clicking again will collapse them.

**Tip:** If you double-click a drawer, all of the folders in the drawer will expand.
Colorize Folders

It’s possible to add custom color to any folder. Some users like to use custom colors as a way to indicate status or to help them categorize items visually.

First, make sure that you’ve turned this feature on under Settings > Manage > Enable Folder & Drawer Painting. Then do the following:

1. Select the drawer/folder you want to colorize
2. Click the Folders button
3. Select Paint Folder
4. Choose the color you want to apply
5. Click OK

**Important:** This feature only works if your cabinet is on a Windows drive – specifically, an NTFS drive. It will not work on non-Windows drives, like NAS drives.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

Show Whether Folders Have Contents

FileCenter can tag folders with status icons that indicate whether the folders have contents or not. For example, small green icons will show up on folders that have files in them, or conversely, small red icons can indicate that folders are empty.

To turn on this feature:

1. Go to Settings
2. Select Manage on the left
3. Set the option called Show Folder Status Indicators
4. Click OK

**Note:** This only indicates the status of the immediate folder. For example, if a folder contains a subfolder but no files, the folder will display as empty, even if the subfolder has files in it.

Change the Sort Order

By default, folders are sorted by folder name in ascending order. You can change it to descending order:
1. Click the *Folders* button > *Sort Options* OR ...
2. Click the *Display* button above the list of files
3. Select the *View and Sort* tab if it isn’t already selected
4. Change the *Folders Sort Direction*
5. Click OK

### 10.4 Advanced Drawer Features

You’ll find all of the drawer features in the *Drawers* button. Most of them are self-explanatory, but a few deserve special attention.

#### The “Cabinet Root” Drawer

You might see a special drawer called *Cabinet Root* show up automatically. FileCenter will display this drawer if it detects files in the cabinet’s main folder – in other words, files that are outside of drawers. If you go to the *Cabinet Root* drawer, you will see these files.

You can’t rename or move this drawer, but you can control when it will show or force it to stop showing:

1. Click the *Cabinets* button on the main toolbar
2. Select the cabinet on the list
3. Click *Edit*
4. Change the option called *Show Cabinet’s Main Folder as a Drawer* to either *Always*, *Never*, or *Only if Contains Files* (the default)
5. Click *OK*

You’ll need to do this for each cabinet separately.

#### Shortcut Drawers

Normally drawers are the first level of directories in the cabinet folder (see p. 26, *The Cabinet*). It is possible, however, to show an outside location as a drawer. We call this a *Linked Drawer*. A linked drawer is simply a shortcut to an outside folder. It will show up below the other drawers, and while it appears to be integrated into the cabinet, it continues to reside in its original location.

To add a linked drawer:
1. Click the *Drawers* button
2. Select *Create Linked Drawer*
3. Give the drawer a unique name
4. Browse to the drive/folder you want to show as a drawer
5. Click *OK*

**Deleting a Linked Drawer.** When you delete a linked drawer, it just removes the link from your cabinet. The original folder remains intact.

**Other Considerations.** In most regards, a linked drawer behaves just like a regular drawer. The one exception is that you can’t demote it to a folder. Also be aware that if you move or rename the original folder, the link will break. In this case, you’ll have to remove the linked drawer and re-create it, pointing the new drawer to the right location.

**Colorize Drawers**

You can add a custom color to any drawer, just like with folders. Access this feature from the *Drawers* button > *Paint Drawer*. See p. 71, Colorize Folders for more information.

**Archive Drawers to Prevent Cabinet Bloat**

For businesses, we often recommend that each customer, client, or patient have their own drawer. If your business deals with a constantly revolving customer base, you might need to trim down your cabinets periodically to keep them from getting too bloated.

One way you can do this is to create a second cabinet called *Archive* (or whatever makes sense for your business). Then, every so often, move inactive drawers into the archive. Here’s how:

1. Select the drawer you want to archive
2. Click the *Drawers* button
3. Select *Move to Cabinet*
4. Select the *Archive* cabinet
5. Click *OK*

FileCenter will move the drawer out of your cabinet. Repeat for any other drawers you need to archive.
Add Multiple Drawers

If you need to create a lot of drawers, one easy way to do it is from the Drawers button > Add Multiple Drawers. Just type the drawer names into the list, one per line, then click OK.

You can add folders and subfolders at the same time. Use the Tab key to show where folders and subfolders go in relationship to the drawer. For example, the following items would create one drawer and two folders:

- Smith, Brooke
- Estate Plan
- Living Documents

Here is the same example, except that the first folder has two subfolders of its own:

- Smith, Brooke
- Estate Plan
  - Wills
  - Trusts
- Living Documents

If you have a list of customers, clients, or patients (or anything else you want to make drawers from), FileCenter can use it to automatically generate drawers for each one.

FileCenter will accept the list in two different formats:

**Plain Text:** FileCenter can import names from any plain text file. The file should have one drawer name per line, and it should be saved as Plain Text or ANSI Windows Text with a .txt extension. You will know that a file is plain text if you double-click it at it opens in Windows Notepad.

To import the text file, click the Import from File button on the Add Multiple Items dialog. Browse to the file and click Open. FileCenter will pull in the list. Click OK to create the drawers.

**CSV File:** A CSV file (comma-separated values) is similar to a plain text file. The difference is that it has one “record” per line with multiple “fields” per record. Fields are normally surrounded with quotation marks and are always separated by a comma. Hence the name. Comma-separated files must have a .csv extension.

Click the Import from File button on the Add Multiple Items dialog. Browse to the.csv file and open it. FileCenter will open the file in a new window where you can choose what fields will be used in the drawer name. For guidance using this dialog, click its Help button.

**Tip:** This feature is also available for folders. You can access it under the Folders button > Add Multiple Folders.
Filter the List of Drawers

Back on p. 28, Search Drawer Names, we learned that you can quickly jump to a drawer by typing part of the drawer name in the little search field that sits above the list of drawers. This search field has an additional ability. It can also filter your drawer list.

For example, suppose that you have many hundreds of drawers representing your clients. You only want to see the clients that are limited liability companies (usually abbreviated LLC). In the search field, you would type “llc” (without quotes), then click the filter button to the right (it looks like a funnel). FileCenter will hide (but not remove) every drawer that doesn’t have “llc” in the name.

To remove the filter, click the filter button again.

Note: The filter characters can appear anywhere in the drawer name.

Change the Sort Order

By default, drawers are sorted by drawer name in ascending order. You can change it to descending order:

6. Click the Drawers button > Sort Options OR ...
7. Click the Display button above the list of files
8. Select the View and Sort tab if it isn’t already selected
9. Change the Drawers Sort Direction
10. Click OK

10.5 Advanced Cabinets

Up until now, we’re only talked about Standard Cabinets – in other words, cabinets that derive their structure from a directory of folders (see p. 26, The Cabinet). FileCenter supports a second type of cabinet, known as an Advanced Cabinet.

An advanced cabinet is for users who have important folders spread all over their computer. Advanced cabinets have the ability to “gather” random folders into a unified list of drawers. Specifically, each drawer in an advanced cabinet has its own location assignment, which can be anywhere on your computer or the network. This is different than a standard cabinet, where each drawer must exist under the cabinet’s directory in Windows.
For the most part, the drawers in an advanced cabinet behave just like regular drawers, except that you can’t move them between cabinets or demote them to folders.

Create and Manage an Advanced Cabinet

To create an advanced cabinet, do this:

1. Click the Cabinets button on the main toolbar
2. Click Add
3. Give the cabinet a unique name
4. For the Cabinet Type, select Advanced Cabinet
5. Select a location for the cabinet, or choose Use Default Location
6. Set any other options you want
7. Click OK

If you open the cabinet, you’ll just see an empty interface. Next we add drawers.

Add, Edit, and Delete Drawers

The real power of an advanced cabinet comes from the fact that you can bring together folders from all over your computer into a single, unified cabinet. Here’s how to do that:

1. Click the Drawers button
2. Select Manage Drawers
3. You’ll see a list of drawers which, for now, is empty
4. Click Add
5. Give the drawer a unique name
6. Browse out to the folder you’re wanting to display as a drawer
7. Click OK
8. Repeat for all of the drawers you want to add
9. When you’re done, click OK

Now your cabinet will show the drawers you added. Click on a drawer and notice the status bar in the bottom left-hand corner of FileCenter. It’s showing the path of that drawer. Click another drawer and notice how the path changes.

To rename a drawer or change its location, select it, then go to the Drawers button > Edit Drawer. To remove a drawer, select it, then go to the Drawers button > Remove Drawer.
Note: If you remove a drawer from the cabinet, it does NOT delete the drawer’s original folder. It just removes the drawer from the list.

Important: If a drawer’s original folder gets moved or renamed, you’ll have to update the drawer and browse out to the new location.

10.6 “Pinning” Drawers

Another way to get drawers into an advanced cabinet is to “pin” them from other cabinets. This just adds the drawer to the advanced cabinet without moving it out of the original cabinet, where the drawer’s contents actually reside.

When would you use this? The classic case is daily appointments for a professional office, like a doctor, lawyer, or accountant:

1. The office sets up an advanced cabinet called Daily Appointments
2. Each morning, the office staff “pin” the day’s patient/client drawers to the Daily Appointments cabinet
3. The practitioner has quick, easy access to the patient or client’s records without having to look anything up
4. At the end of the day, when the office staff is finished with billing, they clear the cabinet

Pin a Single Drawer to an Advanced Cabinet

To pin a drawer to an advanced cabinet, do the following:

1. Go to the drawer you want to pin
2. Click the Drawers button
3. Select Pin To and select the cabinet on the list
4. Confirm

Now if you go to the advanced cabinet, you’ll see the drawer there. Remember, this is just a link to the actual drawer, which continues to reside in the original cabinet.

Pin Multiple Drawers

To pin many drawers at once, do this:

1. Go to the cabinet that has the drawers
2. Click the Drawers button
3. Select Advanced Pinning
4. Select Existing and choose the advanced cabinet you’re pinning to
5. Put a check next to the drawers you want to pin
6. Click OK

**Tip:** When you use the Advanced Pinning feature, you can actually create a new cabinet on-the-fly and pin to it. Just select the New option and give the cabinet a name. This is a great way to throw together temporary, *ad hoc* cabinets to help with a quick task.

**Move Pinned Drawers Between Cabinets**

You can shuffle drawers around between advanced cabinets. Just select the drawer you want to move, then go to the Drawers button > Move To and select the cabinet.

**Clear the Cabinet**

When you’re ready to clear all of the pinned drawers from a cabinet, go to the Drawers button > Manage Drawers and click Remove All then OK.

**Note:** Once again, when you remove pinned drawers from a cabinet, it does NOT delete the original drawers. It just “unpins” them from the advanced cabinet.

**10.7 Secure a Cabinet**

Some users – especially business users – are concerned about securing their cabinets against unauthorized users.

First, it’s very important to understand that FileCenter simply “overlays” regular Windows directories (see p. 26, The Cabinet). As a result, FileCenter can’t lock or secure your files, folders, and drawers. Even if FileCenter restricted access, a person could still bypass FileCenter and go straight to the files in Windows Explorer.

But you do have ways of securing your files.
Prevent Deletions & Moving

You can disable the ability to delete or move files on a cabinet-by-cabinet basis. This keeps you from accidentally deleting/moving items. It also disables drag-and-drop and all of the moving features in split view. But note, this restriction only applies inside of FileCenter. To turn on this setting:

1. Click the Cabinets button on the main toolbar
2. Select the cabinet
3. Click Edit
4. Select the option that says Prevent Cabinet Files and Folders from Being Deleted or Moved
5. Click OK

**Important:** This setting disables: deletions, drag-and-drop, cut-and-paste, and the Move options in split view.

Windows Security Settings

Because a cabinet’s contents are regular Windows files and directories, you can secure them with regular Windows security settings. FileCenter will seamlessly inherit all folder, file, and share permissions from Windows.

Encryption & Shredding

FileCenter integrates with the Open Source Axcrypt encryption tool. Axcrypt provides very strong file-level encryption (meaning, you encrypt individual files instead of whole folders). When you encrypt a file, you provide a password. Without the password, the file can’t be de-encrypted, opened, or viewed.

Axcrypt also provides secure shredding. If you need a deleted file to truly disappear, you “shred” it. Shredding overwrites the space on the disk where the file was stored with multiple passes of random data, destroying the original file. For sensitive files, this extra protection is important. When Windows “deletes” a file, it only removes the name. The file’s actual contents stay on your disk until Windows re-uses the space for another file.

To install Axcrypt, download it from:

http://www.axantum.com/axcrypt/downloads.html
Once you’ve installed it, FileCenter will automatically detect Axcrypt on your system and add two new menu items to the Files button: Shred and Encrypt. Use these options to shred and encrypt/decrypt files.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

**Tip #1:** You can open encrypted files by just double-clicking them. Axcrypt will ask for the password, then decrypt the file and open it.

**Tip #2:** You can encrypt/decrypt/shred multiple files at once.

### 10.8 Integrate with the Save/Open Functions of Other Programs

When you save and open files in other programs, FileCenter can pop up your cabinets instead of the program’s regular Save and Open dialogs. This makes it possible for you to use your cabinets any time you save or open a file, regardless of what program you’re in.

FileCenter’s custom Save/Open dialogs work just like regular Save and Open dialogs, except that they show your cabinets.

You can disable the integration on a program-by-program basis, switch back to a regular Save/Open dialog on-the-fly, and easily activate the integration for programs that aren’t supported out-of-the-box.

**Tip:** If you’re using WordPerfect, you’ll have to change a setting in WordPerfect or the integration won’t work. See Task 20: Use FileCenter’s Save/Open Dialogs with WordPerfect.

### Turn on the Integration

To turn on the integration:

1. Click Settings on the main toolbar
2. Select Save/Open Dialogs on the left
3. Select Enable Custom Save & Open Dialogs
4. Click OK

**Important:** The integration will only work if you use cabinets and you have at least one cabinet.
Switch back to Regular Dialogs

FileCenter’s custom *Save/Open* dialogs give you the flexibility to switch back to the regular Windows *Save/Open* dialogs any time you need to. Just use the *Esc* key on your keyboard or click *Switch to Windows*. Use this to switch over to regular dialogs on a case-by-case basis.

You can permanently disable the integration for specific programs. For example, you might want to use FileCenter’s *Save/Open* dialogs when you’re working in Microsoft Word, but use regular *Save/Open* dialogs with your web browser. To learn how to do this, see Task 19: Disable the Save/Open Dialogs for an Application.

Add a Program

FileCenter supports many of the most common programs out-of-the-box. If you have another program you want to use with FileCenter, the setup is simple. For instructions, see Task 18: Turn On the Save/Open Dialogs for an Application.

*Note:* FileCenter’s *Save/Open* integration does not install any add-ins or make any modifications to other programs.

10.9 Application Bar

FileCenter’s *Application Bar* is a convenient panel of program links. Use it for quick access to your most-used programs or to drag-and-drop files onto programs.

The application bar appears at the bottom of the main FileCenter interface. To show it, click the *Tools* button on the main toolbar > *Show Application Bar*.

Add/Remove Icons

The application bar comes pre-loaded with a few common applications that FileCenter found on your PC. You can rearrange the icons, remove icons, and add icons of your own:

1. Right-click in the application bar
2. Select *Edit Application Bar*
3. The list on the right shows what’s on your application bar; re-order items with the up/down arrows, or remove individual items with the “<” arrow, or clear the list with the “<<” arrow
4. To add an item, select it on the left and click “>”
5. To add an item that isn’t on the list, click *Browse for Application* and browse out to a shortcut for the program or to the program itself (usually an “EXE” file)
6. Click *OK* when you’re done

**Tip:** You can show either large or small icons. To change, right-click on the application bar and select *Small Icons* or *Large Icons*.

**Drag/Drop Files onto Applications**

The application bar supports drag-and-drop. Just drop a file onto the program’s icon. FileCenter will send that file to the program.
Chapter 11: File Conversions

Files don’t always come to you in the best format for the way you work. For example, suppose that you regularly receive court opinions as TIFF files, but in your system you prefer to work with PDF files. That’s where file conversions come in: switching a file from one format to another. FileCenter can make these kinds of changes easily.

You’ll do most of your conversions via the **Convert** button on the main toolbar. But you’ll find there are other hidden gems as well.

**Pro Only:** Conversion features are only available in FileCenter Professional and Pro Plus.

### 11.1 Convert Individual Files to PDF

If you need to make a PDF copy of a document, one way you can do it is to open the document then print it to the **FileCenter PDF** printer, as we described on p. 41, The PDF Printer. But there’s an easier way.

For many kinds of files, just select the file in FileCenter, then click the **Convert** button on the main toolbar. FileCenter will create a PDF copy of the file.

**Preserve Formatting**

By default FileCenter will do a “quick” conversion which sometimes loses some formatting. For a perfect reproduction, select the option called **Use PDF Print Driver**. This will print the document to PDF, preserving all of the document formatting.

**Note:** This option won’t work with all files. Here’s the rule of thumb: if you right-click on a file and see a **Print** or **Print To** option on the menu, this option will probably work.

**Conversion Options**

You may see some of these conversion options, depending on what kind of file you’re converting:
PDF/A-1b. (FileCenter Professional only). Select this option to create a PDF/A-compatible file. PDF/A is an archival-quality PDF intended for long-term storage. Some government agencies require the PDF/A format.

*Note:* PDF/A does not support the full range of PDF features. You should not modify a PDF/A file or you might introduce elements that aren’t compatible with PDF/A. PDF/A will also produce larger file sizes.

**Use Image Size as PDF Page Size.** When you’re converting from an image file to PDF, FileCenter needs to know what size to make the PDF pages. You have two options: select a specific page size, or base the page size on the size of the original image.

If you select *Use Image Size as PDF Page Size*, FileCenter will make the PDF the same size as the original image based on its dimensions and resolution.

The *Force Image DPI* option then lets you optionally specify the image’s resolution, which will in turn affect its scale. Resolution is given in *dots per inch*. For example, assume an image is 400 pixels wide by 300 pixels tall. If you put the DPI as 100, your resulting PDF will be 4” x 3”.

*Important:* Most images already contain a setting with their ideal DPI. To use the image’s default DPI, set *Force Image DPI* to 0. Only use the *Force Image DPI* setting if you want to make the PDF page size larger or smaller.

**Specify a Default Page Size.** Instead of basing the PDF size on the size of the original image, you can force the PDF to specific page size. Note that FileCenter will *scale* the image to fit within the page size.

**Force PDFs as Black and White.** When you’re converting from an image file to PDF, you can force color images to come over as black-and-white images. Some users prefer black-and-white PDFs because they’re smaller.

**PDF Compression.** The compression settings control how your scanned images will be compressed if you scan to PDF. Most users will get the best compression if they use *JBIG* when scanning in black and white, and *JPEG* or *JPEG + ZIP* when scanning in grayscale or color. JPEG compression also lets you set your JPEG quality, which has a dramatic effect on file size. The default quality of 75 strikes a good balance between file size and image quality. For a sharper image, at the cost of file size, increase the quality. For a smaller file size, at the cost of graininess in the image, decrease the quality.
11.2 Bulk PDF Conversion

If you have multiple files to convert to PDF, you might want to use FileCenter’s Advanced PDF Conversion feature which not only converts multiple files at once, it also gives you more options. There are two ways to get to this feature:

- Select multiple files, then click Convert
- Go to the Actions button > Advanced PDF Conversion

Both methods will open a special window at the bottom of FileCenter. This window shows the files you’re going to convert and provides you with a number of conversion options, which we’ll go over shortly.

To add files to the conversion list, just drag-and-drop them into the list from anywhere (even locations outside of your cabinets), or select them in their cabinet and click Add.

**Tip:** You’ll want to limit your batches to around a dozen files at a time. For high volume conversions and even more conversion power, like watching folders for new files to convert, searching for files to convert, and running OCR to make the PDFs searchable, look at FileCenter’s sister product, FileConvert.

**Set Options and Keywords**

First, notice that when you select conversion options, you can apply them to every file in the list or to only the selected file(s).

If you want to use different options for each file, click Selected File, select a file on the list, then choose its options. Do this for each file. To simplify entering common options, set them for one file, click Copy to All, then go through each file and customize their individual options.

Here are the available options:

**Filename.** By default, the converted file will have the same name as the original, but with a PDF extension. So My Document.doc will become My Document.pdf. If there’s already a My Document.pdf, the new document will be called My Document_2.pdf.

To use choose a different filename for the converted file, just type it in the Filename field or select a naming option.
Tip: If the original file is already a PDF, FileCenter assumes you just want to modify the file’s PDF options. If you provide a different filename, FileCenter will make a copy of the file with the new options. If you leave it set to <Original Name>, it will modify the existing file instead.

**Password Protection.** You can give the converted file a password. This does two things. First, it requires the user to enter the password to be able to open the PDF. Second, it encrypts the PDF file so that the contents can’t be extracted.

To give the converted file a password, select the **Password** tab, select **Require a Password to Open the Document**, and enter the password in the **Open Password** field.

**Remove a Password.** If the original file is already a password-protected PDF, you can remove the password. Just enter the current password, then select **Remove Password and Permissions**.

**Delete Original File.** By default, FileCenter creates a PDF copy of the file and leaves the original untouched. If you want the original file deleted, select **Delete Original File**.

Note that if the original file is a PDF and you’re not changing the name, FileCenter won’t delete the original, even if you set this option. Instead, FileCenter just modifies the original.

**Important:** Be wary about automatically deleting the original! If you need to make changes to the file in the future, you’re out of luck. PDF files can’t be edited and can’t be converted back to the original format. Converting a file to PDF is a one-way street!

**Keywords.** You can add searchable keywords to the PDF file. These keywords will not be visible in the document, but they will make it easier to find the document using full-text search. You have four different fields to use: **Keywords, Title, Author, and Subject**.

If the original file is already a PDF, you can either replace its existing keywords or add to them. Use the **Append To** and **Replace** options to choose whether or not to keep the existing keywords.

**Advanced Options.** The **Advanced** tab has some advanced conversion options. Note that not all of these options will apply to all file types. For example, the **page size** options only come into play if you’re converting an image, like a JPEG or TIFF file, to PDF. Other kinds of documents, like Word documents, already have a defined page size that you can’t overwrite. Compression and black/white options fall into the same category – they only apply to image files.

For a full description of the advanced options, see p. 83, Conversion Options.
Perform the Conversion

When you’ve set all of the conversion options you want, click Convert in the advanced conversion window. FileCenter will convert every document in the list, one-by-one, using the options you chose.

Note that some documents will pop open briefly in their native application while FileCenter converts them. So don’t use other programs while the conversion proceeds.

When conversion is done, the list will show the converted files. You can double-click the files in the list to open them and make sure they converted properly. The actual converted files are in the same folders with the originals.

To start a new conversion run, click Reset All.

11.3 Email Files as PDFs

One of the most common reasons to convert a file to PDF is to email it to someone. Emailing PDFs is a good practice, especially if the original shouldn’t be changed. For example, suppose you email someone a contract to sign. If you send a Word document, they could alter the terms of the contract without you knowing it, and then sign. On the other hand, if you send the contract as a PDF, you have much greater assurances that it won’t get changed (for the very best assurances, see p. 106, Password Protection).

Because emailing PDFs is such a common task, FileCenter gives you a shortcut conversion method that condenses it into just one step:

1. Select the non-PDF file you want to send (like a Word document)
2. Click the drop-arrow under the Email button
3. Select Send as PDF

FileCenter will make a PDF copy of the file and attach the copy to a new email message. The original remains unaffected.

For even more security, select Email as Secure PDF. This will encrypt the file and password-protect it (you’ll be prompted to assign it a password). No-one will be able to open the file without the password.

For more information on emailing files, see p. 69, Email a File.
11.4 Paste Images as Files

One hidden feature is the ability to paste an image into FileCenter as a PDF file (or other image format). Note that we said *image* and not *image file*. It’s an important distinction. In other words, if you copied an *image* to the Windows Clipboard, you can paste it into FileCenter and FileCenter will turn the image into an *actual file*.

For example, suppose that you regularly pull information off of the Internet. You’ve been printing whole web pages to PDF, but you don’t need most of the information on those pages. Ideally, you only need a specific section of the page – a stock table, perhaps.

Here’s how to save that section of the page to PDF:

1. Pull up the page in your favorite web browser
2. Position the page so the section you need is visible
3. Use the *Snipping Tool* that comes with Windows to draw a rectangle around the section and copy it to the Clipboard
4. Open FileCenter
5. Navigate to the drawer/folder where you want to save the image
6. Press Ctrl+V to paste the image

You’ll now see a prompt asking for a filename and a file format. FileCenter will save the image in whatever file format you choose – even PDF.

*Use Snipping/Screenshot Tools*

Most people will use this feature in conjunction with a screen snipping or screenshot tool. These tools can capture a region of the screen and copy it to the Clipboard. Newer versions of Windows include one called, simply, *Snipping Tool*.

To use this feature with a snipping/screenshot tool, it’s important that you configure the tool to save new screenshots straight to the Clipboard instead of saving them to file. For example, in the Windows *Snipping Tool*:

1. Open the *Snipping Tool*
2. Click the *Options* button
3. Select *Always Copy Snips to the Clipboard*
4. Click *OK*
11.5 Convert between Image Formats

It’s quite easy to convert images between different formats. For example, suppose you receive a PNG file but you prefer to save image files in JPEG format. Simply select the file you want to convert, click the Convert button on the main toolbar, then choose the new format.

11.6 Convert to Word, Excel, etc.

One common need is to convert a scanned document from PDF back into Word, Excel, or other Office format. This kind of conversion is possible through the Convert button.

For example, suppose that a client shows up with a scan of an old contract. They’d like to use the same contract with another company. Using FileCenter, you can convert that scan back into Word format, preserving all of the fonts and layout, ready for you to make the minor changes necessary. To do this:

1. Select the file in FileCenter
2. Click Convert on the main toolbar
3. Under Convert To, select DOCX

You can convert into a few Office formats, including Word, Excel, WordPerfect, and PowerPoint.

**Important:** If the original file is a scan, the quality of the output will depend heavily on the quality of the scan.

**Pro Plus Only:** This feature is only available in the FileCenter Pro Plus edition.
Chapter 12: Work with PDF Files

You will find a lot of PDF power in FileCenter. The PDF editor in the Edit tab holds some of that power – which we’ll see in Chapter 13: Use the PDF Editor. But you’ll be surprised how much you can do with PDFs without ever leaving the Manage tab – things like splitting or combining PDF files, pulling pages from a PDF into a new file, etc. These are the PDF features that tend to operate at the file level; in other words, that create or manipulate whole files.

In this chapter, we’ll cover the PDF features available in the Manage tab.

Tip: Don’t think that these features are limited to the Manage tab. Most of them will work just as well in the Edit tab, and sometimes with slightly different options. We’ll point those out along the way.

Pro Only: These PDF features are only available in FileCenter Professional and Pro Plus.

12.1 Combine PDF Files through Drag-and-Drop

Some businesses deal with ever-growing PDF files. For example, a law firm might add signed addenda to a contract. A warehouse might add shipping or delivery information to a purchase order. A doctor’s office might add x-rays to the doctor’s notes.

One way to add pages to a PDF is to just scan them in, which we’ll cover on p. 129, Insert New Pages into an Existing Document. But if you receive the new pages as PDF or image files, just go into the Manage tab and drag/drop the files onto each other:

1. Select as many files as you want (PDF, TIFF, or JPEG)
2. Drop them onto the file you want to add them to
3. Choose whether to Append or Prepend
4. Confirm the document order
5. Click OK

FileCenter will combine them on the spot.

People often refer to this as “stacking” or “merging” PDFs. Regardless of what you call it, it’s a fast, easy way to join two PDFs.
12.2 The “Actions” Button

You will find a wealth of PDF features in the Actions button. Most of these work in both the Manage and Edit view. If you’re using the Edit view, these actions apply to the files you have open in the PDF editor. If you’re using the Manage view, they apply to the files you have selected.

In the descriptions below, we’ll mostly just refer to the Manage view, since this is usually where you’ll use these features.

Combine Documents

The Combine Documents option has the same effect as dragging and dropping PDFs onto each other, which we just covered, but with a few more options. To use this feature:

1. Select one or more PDFs (or open them in the Edit tab)
2. Click Actions > Combine Documents

This will open the tool with the list of files you want to combine. If you’re working in the Manage tab and you want to add more files to the list (e.g. they’re in a different directory than the others), use the Add Files button.

Choose the Order. Once you have your list of files to combine, the next step is to put them in the order you want. Select files in the list and use the Up/Down buttons to move them around.

Choose a Destination. Now you need to choose a Destination. This is the resulting file – the one that will have the whole stack of files in it. You have two options: create a new file, or overwrite a file in the list. If you’re in the Manage tab and you choose to overwrite, you’ll then see a drop-list where you can pick which file to overwrite. If you’re in the Edit tab, it will overwrite the first file in the list.

Optionally Create Bookmarks. FileCenter can automatically bookmark the location of each document in the resulting file. It will use the document’s original filename, minus the “PDF” extension.

Optionally Delete/Close Files. Finally, you can choose to delete (or close) the files after combining them. If you’re overwriting one of the files in the list, it obviously won’t get deleted.

Combine the Documents. When you click OK, FileCenter will create one unified file from every file in the list, in the order you selected.
To insert one file in the middle of another one, see Insert, below.

**Unstack Document**

If “stacking” means combining PDFs, then “unstacking” means pulling them apart. And that’s exactly what the Unstack option does: break up a file at regular intervals. In a nutshell, Unstack separates one file into many files. All you need to do is specify how many pages you want in each file. Here are the steps:

1. Select a file (or open it in the Edit tab)
2. Click Actions > Unstack
3. If you’re in the Manage tab, specify the filename that FileCenter should give the new documents; they’ll all use the same name with a counter (e.g. Document [1].pdf, Document [2].pdf, etc.)
4. Indicate how many pages each document should receive
5. Optionally delete/close the original document after unstacking

To simply split a file, see Split, below. To pull out specific pages into a separate file, see Extract Pages, below.

**Insert Document**

We already saw that Combine will join two files, one on top of the other. To insert a file in the middle of another file, use Insert. To use this feature:

1. Select (or open) the target file; in other words, the file that will receive the pages
2. Click Actions > Insert
3. Browse to the file you want to insert or, if you’re in Edit view, optionally choose from other files that are already open
4. Choose where the pages should go
5. If you’re in Manage view, optionally delete the file you’re inserting

**Split Document**

The Split tool works exactly like it sounds: it splits one document into two. You simply choose the page where the split should happen and provide a name for the new file (if you’re in Manage view).
The first half of the document will keep the original name. The part that gets split off will receive the new name or, if you’re in Edit view, it will be opened in a new document tab.

**Transfer Pages**

When you need to move pages between files (but keep the files separate), you’ll use the *Transfer Pages* tool. While you can use this tool in either the *Manage* or *Edit* view, we recommend doing it in the *Edit* view. This lets you see the pages you’re dealing with.

**Choose/Open the File.** The *Transfer Pages* tool “pushes” pages from one document to another. So in *Edit* view, open the document that has the pages you want to move (or select it in *Manage* view).

**Choose the Pages.** Next you need to choose the pages you want to transfer. You have three ways you can do this. (Note that if you’re in *Manage* view, you’ll have to use the third.)

If you just want to transfer the page you’re currently looking at, go to the *Actions* button > *Transfer Pages* and select *Current Page*. In the thumbnail view, this is the page with a gold border around it.

For multiple pages, it’s easiest to select the thumbnails. Hold down the Ctrl button while you click the thumbnail of each page you want to transfer. Note that they will receive a blue background, showing that they are selected. Now go to the *Actions* button > *Transfer Pages* and choose the *Selected Pages* option.

Alternatively, go straight to *Actions* > *Transfer Pages*, then choose *Custom Range*. Here you’ll enter page numbers for the pages you want to transfer. You can specify individual pages, page ranges, or both. A few examples:

```
5, 7, 9
1-3
1-3, 5, 7, 9, 13-21
```

**Choose the Target Document.** Next you need to choose the file where you want to put the pages. Either choose *Existing File* (or *File in the Current Directory*) and browse to the file, or if you have it open, select *Already Opened Document* and select it in the list.

**Choose the Page Position.** Next you need to indicate a page position for the files.

**Optionally Delete Pages.** Finally, you can choose to delete the pages from the original file. In essence, you’re deciding whether to copy the pages between files or move them.
Transfer the Pages. When you click OK, FileCenter will either copy or move the pages from the selected file into the file you chose and insert them at the specified position.

This is probably the most complicated of the PDF tools, but it’s a powerful feature that can save you extra work.

Extract Pages

The Extract tool is similar to the Transfer tool, except instead of inserting pages into an existing file, you’re making them into their own file. You might also think of it as a Split tool for grabbing pages out of the middle of a file. Again, we recommend using this tool from the Edit view.

Here’s how it works:

1. Open the file in Edit view (or select it in Manage view)
2. Select PDF Tools > Extract Pages
3. Select the pages you want to extract, as described in Transfer Pages, above
4. Provide a filename for the new file, or if you’re in Edit view, optionally choose to just open it in a new tab
5. Optionally choose to delete the original pages

FileCenter will pull the pages into a new file. If you saved the pages to file, you’ll find the file in the same directory as the original.

Extract and Save. If you’re in Edit view, you have another option in PDF Tools called Extract & Save. This works just like Extract, except that it doesn’t show you any options. Instead, it immediately prompts you to save the new file. It’s a fast way to extract straight to file, especially when you need to save it somewhere other than the original directory.

Delete Pages

The Delete Pages tool simply deletes pages from your PDF.

If you have a PDF open in the Edit view, select the page(s) you want to delete, then go to PDF Tools > Delete Pages. To select multiple pages, hold down Ctrl while you click on the thumbnails.

If you’re in the Manage view, you need to have Enhanced Thumbnails on. Use the page selector above the list of files to browse to the page you want to delete. Then go to Actions > Delete Pages. To learn about enhanced thumbnails, see p. 67, Enhanced Thumbnails.
Print Documents

If you’re in the Manage view, you’ll find an option called Print Documents. Use this tool to print a PDF or multiple PDFs without having to open them:

1. Select the PDF or PDFs you want to print
2. Go to PDF Tools > Print Documents
3. If you chose multiple documents, select the print order
4. Click OK

You’ll have a chance to choose a printer and any print options.

Send Document Text to Word

Sometimes you need just the text from a PDF file. FileCenter can pull the text out of a PDF and send it to Word, where you can edit it, incorporate it into another document, etc. To use this feature:

1. Select the PDF in the Manage view
2. Go to Actions > Send Document Text to Word
3. The text will open in your word processor

**Important:** If the PDF is a scan, it will only have text if you performed OCR on the file. If this feature isn’t finding any text in the PDF, see p. 111, Send the Text from a Scanned Document to Word.

**Note:** FileCenter won’t preserve the formatting. We’ve found from experience that users spend more time fixing formatting problems than they would applying fresh formatting.

**Tip:** FileCenter will send the text to whatever program opens RTF files on your system. To change it, see Task 10: Use a Different Word Processor with Scanning/OCR.

Password Protect the File

We’ll discuss PDF security on p. 106, Password Protection. For now, we’ll just note that if you’re in Manage view, you can quickly give a PDF a password using Actions > Password Protect PDF. A user will have to enter this password in order to open or view the PDF.

If the PDF already has a password and you want to remove it, enter the existing password, then select Remove Password and Permissions.
**Convert a PDF File to TIFF**

Most users are concerned with converting files into the PDF format. A few, however, prefer the time-honored TIFF format, which is an image-only format. In other words, it’s simply a “picture” of a document.

If you want to convert a PDF file to TIFF, use **Actions > Convert PDF to TIFF**.

**Tip:** If you have a lot of files you need to convert to TIFF, look at FileCenter’s sister product, FileConvert.
Chapter 13: Use the PDF Editor

In this chapter, we revisit the Edit view and go over common tasks and how to pull them off.

13.1 Erase

One of the most common questions we get is how to erase parts of a PDF. This could be stray marks on a scan, text, or other elements.

If the PDF is a scanned image, you should do your erasing with the image editing tools. See p. 132, Edit the Image after You Scan.

For other PDFs, the tool of choice here is the pencil tool, which doubles as an eraser (just like a pencil).

On the lower toolbar, make sure you have these values set:

- **Color** to white
- **Thickness** to 12 pt (unless you want a finer eraser)
- **Opacity** to 100%

Now just click and drag the eraser over whatever you want to delete. While you’re dragging, you’ll still see the deleted item dimly behind the eraser, but when you release the mouse, it will disappear completely.

*Commit the Change*

For safety’s sake, you can still undo the eraser at this point (Edit menu > Undo, or Ctrl + Z). To commit the change, click the Flatten button.

13.2 Redact Sections

*Tip:* If the PDF is a scanned image, use the image editing tools for redacting. See p. 132, Edit the Image after You Scan.
**FileCenter Pro Plus**

FileCenter Pro Plus features an easy-to-use redaction feature:

1. Open the PDF
2. Go to the *Document* menu on the PDF editor’s toolbar
3. Select *Redaction > Mark for Redaction*
4. Draw a rectangle around the area to be redacted, OR...
5. Drag the cursor across text to be redacted

Note that you can still resize the rectangle after you’ve drawn it. The rectangle will appear transparent at this stage. To preview what it will look like once you’ve finalized the redaction, hover your mouse over the rectangle.

Redact any other portions of the document you’d like. Once you’ve marked all of the sections you want redacted, finalize the redaction:

1. Go to back to the *Document* menu on the PDF editor’s toolbar
2. Select *Redaction > Apply All Redactions*

This will mask the affected areas and remove any underlying OCR text from those areas.

**Other Editions**

Other editions of FileCenter lack a dedicated redaction tool, but you can accomplish a similar effect with other tools.

*Important:* The techniques below will visually mask areas of the document, but they will *not* remove any underlying OCR text!

The pencil/eraser works well for small areas, but to redact large sections of text, you will find it easier to use the *rectangle* tool.

Select it, and make sure you have these values set on the lower toolbar:

- Both *Fill* and *Stroke* color to white
- *Thickness* at 0 pt
- *Opacity* at 100%

Now just click and drag the rectangle over a section of the page you want to redact. While you’re dragging, you’ll still see the underlying text dimly, but when you release the mouse, it will disappear completely.
The rectangle will remain selected, allowing you to adjust it if you need to. To de-select it, just hit the Esc button on your keyboard.

For safety’s sake, you can still undo the redaction for now (Edit menu > Undo, or Ctrl + Z). To commit the change, click the Flatten Comments button.

13.3 Fill Out Forms

Another popular use for the PDF editor is filling out PDF forms.

Some PDF forms are “fillable”, meaning that the form has been set up for filling. You will know if a form is fillable because the mouse cursor will change to an “insert” cursor when you mouse over a field. To fill in the field, just click in it and type.

If the form won’t let you click in the fields and start typing, it means the form isn’t “fillable”. That doesn’t mean you can’t fill it out, it just means the person who made the form didn’t set up any fields. The Typewriter section, below, will show you how to fill out these forms.

Saving the Form

If you save the form, it will save your answers too. So if you don’t want to overwrite the original, blank form, be sure to click the drop-arrow under the Save button and choose Save As to save the filled-out form as a copy.

13.4 Typewriter

FileCenter offers a Typewriter feature so you can add text anywhere on a PDF. You’ll find this very useful with forms that aren’t fillable.

Click the typewriter button, then click where you want to start typing. Before you begin, notice that you can set the font.

You can also change fonts midway through your typing. If you want to always default to the selected font, click Make Default.

When you’re done typing, hit the Esc key on your keyboard to close the tool.
Commit the Change

At this point, you can still undo the typing. To make the text permanent, click the Flatten button.

13.5 Rearrange or Delete Pages

To rearrange pages in your PDF, just drag the thumbnails around. If you’ve got a long file, you will have an easier time if you enlarge the thumbnail window. Grab the divider between the thumbnails and the page view, and drag it as far to the right as you’d like.

With more thumbnails on the screen, you will be able to move pages from one end of the document to the other without any problem.

To delete a page, select its thumbnail, then click the Delete Page button or hit Del on your keyboard.

To delete multiple pages, hold down the Ctrl button while you click on each thumbnail to select them one-at-a-time, or to select a range, click the first thumbnail, hold down the Shift key, then click the last thumbnail in the range. Then delete the whole selection.

13.6 Crop Pages

You can trim the pages in your PDF files. Click the Crop button and do the following:

1. First, set the page range. Do you only want to crop the current page? All pages?
2. In the page preview on the right, click the corners and drag them to the new size
3. Click OK

Tip: If you want to trim down to the actual body of the page, just click the Remove White Space button.

Undo Cropping

To reverse cropping, do the following:

1. Click the Crop button
2. Select the page range
3. Click Set to Zero
4. Click OK

13.7 Rotate Pages

You can also rotate pages, which you’ll find especially useful if you do scanning. Just select the Rotate button, then choose your page range and your rotation amount and click OK.

13.8 Add Annotations

PDF files offer a very nice feature: the ability to mark up the file with comments and notes that don’t have to print with the file. We’ll collectively refer to these as annotations. FileCenter’s PDF editor has a rich assortment of annotation tools. Here are the main ones.

Comments & Text Boxes

FileCenter offers a few different ways to add comments and notes. First, the Sticky Note Tool.

This gives you a pop-up balloon where you can add some notes. When you close the comment, it collapses down to an unobtrusive icon.

To add a sticky note, click where you want the icon to appear. You can reposition the balloon, and FileCenter will remember the location.

The Callout Tool lets you point your comment at a specific item on the page.

Unlike the Sticky Note Tool, it doesn’t collapse. To add a callout, first click on the spot where the arrow should point, then drag the mouse to where you want the note placed. Add your text, then press Esc on your keyboard to end the note.

Finally, the Text Box Tool simply puts a text box on the page.

Just click where you want the box to go, enter your text, then reposition the sides to the size you want. Press Esc on your keyboard when you’re done.

Tip: You can change the fonts, border size, and border color for all of these tools. You’ll find those options on the lower toolbar once you start the note.
**Highlighting**

If your document has actual text (not just a scanned image), you can use the *Highlight Tool* to highlight text.

The tool will automatically adjust to the text height. To change the color of the highlighter, use the lower toolbar.

If your document does not have actual text or you can’t get the highlighter to work, you can use the *Pencil* tool as a highlighter. Do this:

1. Select the *Pencil* tool
2. On the lower toolbar, pick a color for the highlighter
3. Set the width to 12 pt (or whatever width works best for you)
4. Set the *Blend Mode* to *Multiply*
5. Drag across the area you want to highlight

**Shapes**

Shapes do a nice job of bringing attention to elements on the page. FileCenter offers a rich lineup of shapes.

To use the basic shapes – lines, arrows, ovals, and rectangles – just click and drag. To make multi-sided shapes, click at each point where you want to put a turn or angle, then double-click to finish the shape.

With all of the shapes, you can change the line color and width. Those with a “center” also have a fill color and fill opacity.

**13.9 Stamp Pages**

A common way to show a document’s status is with *Stamps*. Just like ink stamps, the *Stamps* feature puts a status image on the page.

FileCenter comes with a pre-defined palette of stamps.

Just pick the stamp you want to use, then click on the page where you want it. Drag the stamp to reposition it, and drag the corners to resize it.
Import Custom Stamps

You can import custom stamps from your own image files or from third-party stamp collections. You can find many third-party stamp collections on the web, and some of these even allow for dynamic information, like user initials and date/time. Third-party stamp collections usually come as PDF files.

Import Non-Dynamic Stamps:

1. Click the drop-arrow next to the Stamps button
2. Select Show Stamps Palette
3. On the stamps palette, click New to add a new collection
4. On the right, select either From Image or From PDF
5. Browse out to the image or PDF collection and open it

Your stamp(s) will now appear in the palette.

Import Dynamic Stamps:

Dynamic stamps contain changing information, like a date or a username. Dynamic stamps always come in a PDF file. To import dynamic stamps, you need to put this PDF in FileCenter’s Custom Stamps folder.

1. Go to FileCenter’s Settings
2. Select Miscellaneous on the left
3. Click Open Custom Stamps Folder
4. An Explorer window will open to FileCenter’s custom stamps folder
5. Copy or move the PDF dynamic stamp library into the custom stamps folder
6. Close and re-open FileCenter

Your dynamic stamps will now show up in the stamps palette. They will be in their own section.

Tip: You can turn your signature into a stamp, then easily put it on documents. See Task 21: Use Your Signature as a PDF Stamp.

Use Stamps as Watermarks

Stamps can also double as watermarks. Place and size the stamp how you want it, then with it still selected, lower its opacity to 40% or even 20%.
13.10 Page Numbering (Headers & Footers)

You can add automatic headers/footers to your PDFs with information like dates and page numbers:

1. Go to the Document menu in the PDF editor
2. Select Header and Footer > Add

You’ll see a dialog where you can add header and footer information. You’ll see squares for each quadrant where text can go: Left Header, Central Header, Right Header, and corresponding Footer fields.

But before entering information, set up your font style and formatting options:

1. Click the Font button
2. Choose the font face, size, and color you want to use
3. Click OK
4. Click the Page Number and Date Format button
5. Choose the formats you want to use for page numbers and dates
6. Click OK

Now you can add items to the headers and footers:

1. Select the quadrant where you want to insert information
2. Click Insert Date, Insert Page Number, or type any text that you want to include
3. Repeat for any other quadrants where you want information
4. To save these settings for future use, click the Settings drop-list in the bottom left-hand corner > Save Current Settings
5. Click OK to apply the headers/footers to your document

Note that you can remove the headers/footers. Go back to the Document menu > Header and Footer > Remove All.

Pro Plus Only: This feature is only available in FileCenter Pro Plus.

13.11 Bates Numbering

In addition to dates and page numbering, you can include Bates numbering in your headers and footers (see above). Bates numbering works exactly the same way, except you access it through a different menu item:
1. Go to the **Document** menu in the PDF editor
2. Select **Bates Numbering > Add**

You’ll notice that this dialog is exactly the same as the **Header and Footer** dialog, except it has an extra option for Bates numbering. To add a Bates number to a quadrant:

1. Select the quadrant where you want to add the Bates number
2. Click **Add Bates Numbering**
3. Select the number format you want to use
4. Select the starting number
5. Click **OK**

You can also add any other header/footer information you’d like, as described in Page Numbering (Headers & Footers), above. When you’re ready, click **OK** to insert the header/footer and Bates number.

Note that you can remove the Bates number. Go back to the **Document** menu > **Bates Numbering > Remove All**.

**Note**: Bates numbering is distinct from Headers/Footers, even though they both put information in the header/footer. In other words, you can apply a header/footer and a Bates number separately. They can overlap each other.

**Pro Plus Only**: This feature is only available in FileCenter Pro Plus.

### 13.12 Add Searchable Metadata

Usually the text in the document is enough to make it searchable, but if you want to add some specific keywords to help you find this document in the future, you can do it in the PDF editor:

1. Open the document in the **Edit** view
2. Click the **Properties** button on the editor’s toolbar
3. Select **Description** on the left
4. Add keywords to the **Title, Subject, or Keywords** fields
5. Click **OK**
6. Save your changes
13.13 Apply Security

If you need to restrict access to a sensitive PDF file or ensure that it won’t get changed, the PDF editor’s security features will give you all of the control you need.

Password Protection

If you enable password protection, anyone who tries to open and/or change the PDF will have to enter a password. There are two basic types of password protection available, and you can use them together or separately:

- Require a user to enter a password to open or view the PDF
- Restrict what a user can do with the PDF (view, print, copy text, etc.)

To set a password:

- Open the PDF in the Edit view
- Click the Properties button on the editor’s toolbar
- Select Security on the left
- Under Security Method, select Password Security

Then set your preferences. Here are the options:

Components: When you set a password, your PDF file will get encrypted so no-one can see what’s in it. If you set keywords for the document and you want them to still be visible so you can search for this document, select All Document Contents Except Metadata. See p. 105, Add Searchable Metadata for more information about keywords.

Require a Password to Open the Document: This is just what it sounds like. If you set a password, no-one can open or view the PDF without entering the password first. We’ll refer to this as the Open password.

Require a Password to Change Permissions for the Document: If you want to restrict what users can do with the document, you will have to set a password for it. We’ll refer to this as the Permissions password. Without this password a user can’t change or bypass your restrictions. If you set this password but not the Open password, users can open the file freely, but they will only be able to do what you allow.

The following items only apply if you set a Permissions password.
**Printing Allowed:** You can choose whether to allow users to print this file, and if they can, force it to print in low resolution.

**Changing Allowed:** You can choose the level of changes you want to allow users to have. Note that the levels build on each other. For example, the second level—*Filling in Form Fields*—also includes the first level, *Inserting Deleting and Rotating Pages*.

---

**Digital Signatures**

To understand *digital signatures*, let’s talk about ink signatures on paper documents. When you sign a document in ink, your signature communicates that you agree with what’s in the document and you agree to be bound by it. At the same time, the paper document and the ink its typed in communicate something too. They communicate that the document hasn’t changed since it was signed. In other words, when we look at a signed document, we can safely assume that what we’re holding is exactly the same as what the signer agreed to, because it probably hasn’t changed since the signature was put on it.

Now imagine if documents were written in pencil. Would you put the same trust in them? That’s the dilemma that came with PDF documents. People loved the idea of exchanging important documents electronically, but any high school kid can alter an electronic document. We needed a way to ensure that once a document was “signed”, it could not be changed.

Enter *digital signatures*.

Digital signatures have two roles. First, they can serve as a legally-binding signature, just like a handwritten signature. But they go a step further than that. They also *lock* the document so it can’t be changed. If someone tries to alter a document that has been digitally signed, a warning will pop up notifying that the document’s been compromised.

To digitally sign a document:

1. Click the *Sign Document* button
2. Click where you want the signature to go
3. Choose a certificate to use (if you don’t have one, click *Create Certificate* and follow the prompts)
4. Optionally fill in the *Reason for Signing, Location, and Contact Info*
5. Choose the style of signature you want to use (*Sign Template*); click *Manage* to change the style or create your own
6. Click *OK* to insert the signature
7. Save the signed file when prompted
The signed document will be saved as a new file.

**Tip:** If you want to customize the digital signature or even include your actual, handwritten signature as part of the digital signature, see Task 22: Use Your Signature in a Digital Signature.

### 13.14 Setting Other Preferences

You have a number of other preferences available to you. These control the look, feel, and behavior of the PDF editor. For example, you can set the default zoom level, change the page layout, choose whether to show bookmarks instead of thumbnails, etc.

To access the preferences, go to the *Edit* menu in the PDF editor (right above the PDF editor’s toolbar; below FileCenter’s main toolbar), and select *Preferences.*
Chapter 14: Text Recognition (OCR)

To understand OCR, you first need to appreciate the nature of a scan. To your computer, a scanned document is nothing more than a series of pictures — no different than a digital photo. Even though you can see words in the scan, your computer can’t. Your computer just sees an image.

This has important repercussions. First, it means you can’t select text in the scan, copy it, and paste it somewhere else, like your word processor. Second, it means you can’t search the body of the scan for keywords, because it doesn’t have any words.

To overcome this, someone invented a technology called *Optical Character Recognition*, or *OCR*. The idea was that if a computer could be taught to recognize characters and words in an image, it could turn a scanned document back into a real text document. The idea worked. Today, a computer can recognize the words on a clean scanned page with close to 100% accuracy.

FileCenter embraces OCR just as heartily as it embraces scanning, and in fact, does everything possible to hide the complexities of OCR from you. From your point of view, OCR happens invisibly behind the scenes, making sure that your scanned documents have real text in them.

**Important:** OCR does not change the way your scans look. Instead, it embeds the text invisibly behind the scanned image.

**Pro Only:** The OCR features are only available in FileCenter Professional and Pro Plus.

### 14.1 What is a Searchable PDF?

“Searchable PDF” has emerged as a common buzz-word. What it means, simply put, is that a scanned PDF has “real” text in it. In other words, OCR was performed on the scan, exposing the document text.

With a searchable PDF file, you can copy text from the PDF and paste it somewhere else, like a word processor, and more importantly, you can search the body of the scan. We discuss searching in Chapter 19: Search for Files.
14.2 Make a File Searchable when You Scan

When you scan to PDF, FileCenter can automatically make the file searchable, without any extra steps or effort on your part. Here’s how:

1. Click Scan on the main toolbar (in either Manage or Edit view)
2. On the scan dialog, down under the Scan tab, make sure the scan Type is PDF
3. Click the OCR tab
4. Select Make Searchable PDF
5. If you want to default to these settings, click the Save button right above the list of options
6. Proceed with your scan

After the scan, FileCenter will run OCR in the background. You will see a small status bar on FileCenter’s bottom frame showing the progress. When it finishes, your PDF will be fully searchable.

We’ll cover all of the scanning options in Chapter 16: Advanced Scanning.

Tip: If you’re scanning with a ScanSnap, you can still make your files searchable. Go to Settings > Scan & OCR and in the ScanSnap section, select Run This OCR Profile on ScanSnap Scans.

14.3 Make an Existing File Searchable

You can also run OCR on your existing scans. This works in both Manage and Edit view.

Manage View. Select the PDF you want to OCR, then click the OCR button on the main toolbar. You’ll see a number of options, which we’ll cover in OCR Options Described, below. For now, just select Recognize Text as the Action, provide a name for the searchable file (you can keep the same name), and click Start OCR. FileCenter will quietly go through the PDF and expose all of the text in the images. If you want to see its progress, watch the small progress bars at the bottom of FileCenter. You can continue to work while OCR runs.

Edit View. OCR works the same way in Edit view, with one important difference. FileCenter will open a special text window to show you the text it’s finding. You can go through the document page-by-page and see the text. To toggle this window on and off, go to the Tools button on the main toolbar > Show Text Window.
Tip: To check the text in a PDF that’s already searchable, open it in Edit view, go to Tools > Show Text Window to turn on the text window (if necessary), and in the text window, click Extract to show the OCR text.

What about TIFF or JPEG Scans?

You can OCR your existing TIFF and JPEG files too, but you can only do it in the Manage view. You’ll follow the same steps outlined above. FileCenter will save the result as a searchable PDF file. In other words, FileCenter will make a PDF copy of your file and make that PDF searchable.

What about Batch OCR?

FileCenter only supports OCR on a file-by-file basis. If you have many old scans to OCR or you need even more power, like watching a folder for new files to OCR or searching out files to OCR, look at FileCenter’s sister product, FileConvert.

14.4 Send the Text from a Scanned Document to Word

If you have an existing scan, whether PDF, TIFF, or JPEG, you can perform OCR and send the text straight to your word processor. You’ll find this feature helpful when you want to reuse the text from an old scan.

1. Select the file in the Manage view
2. Click the OCR button on the main toolbar
3. For the Action, select Send OCR Text to Word
4. Click Start OCR

FileCenter will perform OCR, then send the text to whatever program handles RTF files on your system (usually Microsoft Word). If you want to specify a different word processor, see Task 10: Use a Different Word Processor with Scanning/OCR.

Note that this will only send the bare text to your word processor. It does not preserve the formatting or fonts.

Tip #1: If you want to preserve all of the original fonts and formatting in Word or if you want to send a table to Excel, see p. 89, Convert to Word, Excel, etc.

Tip #2: To scan a document straight to Word, see p. 37, Scan to a Word Processor.
14.5 OCR Options Described

The following options are available on the OCR dialog when you perform OCR. Note that some of these options might get hidden if they don't apply to the context.

**OCR Tab**

**Make Searchable PDF.** If you select Make Searchable PDF, FileCenter will save the OCR text with the PDF file. FileCenter will embed the text invisibly behind the scanned image, each word aligned where it appears in the scan. This lets you select text right in the scan, copy it, and paste it in another program.

If you don’t select Make Searchable PDF, FileCenter will discard the OCR text.

**Auto-Rotate Pages.** Sometimes scans have both portrait and landscape pages. FileCenter can automatically detect what direction a page’s text is running then rotate the page upright. If you want FileCenter to correct page rotation, select Auto-Rotate Pages.

**Send Text to Word.** The OCR text will be opened in Word (or whichever program is set to handle RTF files).

**OCR Engine.** You might have different OCR engines to pick from, depending on your edition of FileCenter and your system. Each engine has its own strengths and weaknesses:

*Standard.* The biggest advantage of this engine is speed – the engine is very fast. Its accuracy is typically 80-90% on clean documents – high enough to make your documents searchable. It handles poor images gracefully, but its accuracy degrades quickly as the image quality goes down. This engine does not support columns. It only recognizes English characters.

*Tesseract.* The open-source Tesseract engine was originally developed by Hewlett Packard in the 1980s. It is now maintained by Google. Tesseract is capable of very good accuracy – well over 90% -- and also supports columns. Its weakness is speed. It’s the slowest of the engines in FileCenter.

*Advanced.* This engine comes with FileCenter’s sister product, FileConvert. If you have FileConvert on your machine, you can use its OCR engine in FileCenter too. The advanced engine is faster than the Tesseract engine and has better accuracy. It handles difficult documents very, very well. It does not recognize columns. This engine supports and automatically detects Danish, Dutch, English, French, German, Italian, Norwegian, Portuguese, Spanish, and Swedish.
ReadIris. ReadIris is arguably the best OCR engine available today. Its accuracy, even on problematic documents, is unrivaled by any other engine in FileCenter. It is at least as fast as the Advanced engine. It handles columns and Western European languages with no difficulty.

**Important:** You will only see these engines as options if they are available on your system.

**Pro Plus Only:** The ReadIris engine only comes with FileCenter Pro Plus.

**Line Breaks.** When you’re sending the OCR text to a word processor, FileCenter needs to know where to put line breaks. You have three options:

**By Paragraph.** FileCenter will try to figure out where paragraphs end based on punctuation. For example, if a period falls at the end of a line, it’s probably the last sentence in the paragraph. FileCenter will insert two returns wherever it thinks a paragraph ends. If you choose this option, you should proofread the text to make sure all of the line breaks were handled correctly.

**By Line.** FileCenter will preserve the original lines from the document. This means that one horizontal line of text in the document will be one line of text. In other words, wherever a line wraps in the document, FileCenter will insert a line break. FileCenter will not try to figure out paragraph endings.

**None.** FileCenter will not insert any line breaks. The text will come out as one continuous line of text.

**Page Text.** When FileCenter creates a searchable PDF, it puts the text character-aligned behind the words in the scan. Some users prefer to have the text lumped in a single hidden paragraph at the top of the page, which reduces the file size slightly and reduces the number of text objects in the document. To do this, change the *Embedded Text* option to *Top of Page*.

Most users should leave this set to *Word-Aligned*.

**Page Timeout.** Sometimes an OCR engine can get stuck on a really tough page – poor resolution, poor contrast, a lot of images, etc. The *OCR Timeout* option sets the “give up” point. If the OCR engine hasn’t been successful after ___ seconds, FileCenter will give up and move on to the next page. For reference, most pages, even tough ones, can be recognized in under 30 seconds.

**Page Threads.** To speed up OCR, you can have FileCenter OCR more than one page at a time. Most modern hardware can handle this without bogging down. Use this setting to specify the number of pages you want OCRed simultaneously (current limit: 2).
**Limit OCR To __ Pages.** If your main reason for running OCR is to make the PDF searchable, you might find that most of the important information is in the first few pages of the document. If that’s true, you can save a lot of time by limiting OCR to the first few pages, especially if you scan documents that are dozens or hundreds of pages long.

Use the *Limit OCR* option to choose how many pages of the document you want to OCR. OCR will quit once those pages are done.

**Advanced Tab**

**Remove Blank Pages:** FileCenter can try to identify blank pages in the scan and drop them. This happens as the scan comes in. To identify a blank page, FileCenter looks at how much of the page is white. If it’s almost completely white, FileCenter will consider it blank and drop it from the scan. To adjust the sensitivity, use the *Blank Page Sensitivity* setting, where a low number tolerates no stray marks on the page and a high number will tolerate some speckles and black marks.

**Flatten Comments:** If you’re running OCR on a PDF file, there’s a chance that it contains annotations: text boxes, callout text, sticky notes, etc. You can permanently burn these annotations into the PDF by selecting *Flatten Comments*. Note that if you select this option, you *cannot* remove the comments down the road.

**Other Options:** See p. 83, Conversion Options.

**Other Tabs**

For all other tabs, see p.133, Scanning Options Described.
Chapter 15: Tap into Document Content

One of the most powerful features available to you is the ability to tap into a PDF’s content and use its text to automate portions of your workflow. For example, you can pull names, dates, invoice numbers, and other information from a PDF and use them to create dynamic filenames. You also have the ability to route new PDF documents based on what kind of information they contain.

The mechanics of these operations are explained on p. 47, Pre-Defined Filenames and later on p. 153, Page Content Separators, so we won’t get into them here. Instead, this chapter devotes itself to the feature that lies at the core of this intelligence: the CONTENT field.

Pro Plus Only: This feature is only available in FileCenter Pro Plus.

15.1 The CONTENT Field

In addition to the file naming fields described on p. 48, Dynamic Fields, FileCenter also offers the CONTENT field which deserves its own discussion. The content field also plays a key role in Content Rules which we’ll cover in Chapter 18: Automate Scanning.

Content fields come in a few flavors, each of which uses a different method to grab information from a PDF:

Barcode Text. If you scan with barcodes and your barcodes contain simple text or numbers, your content field can grab that text.

RegEx. A regular expression pulls text from the document based on a pattern. For instance, suppose you want to capture a social security number from the document. You’ll set up a pattern that looks for three digits, a dash, two digits, a dash, then four digits. You can also extract text based on neighboring text. For example, a will often begins with the text “Last Will and Testament of _____.” You can capture the text that follows this phrase.

Zone. You can extract text from a specific region in the document's body. For example, if you scan standardized forms and the invoice number always appears in the same position on the form, FileCenter can extract the text in that region and insert it in the filename.
Creating Content Fields

You’ll create content fields as part of setting up a naming option. When you add a content field, you’ll be taken to the *Content Field Editor*, a dedicated workspace for helping you fine-tune and test the field settings.

**Tip:** You can access the *Content Field Editor* any time from FileCenter’s *Tools* button.

**Preview Window.** A key component of the editor is its *Preview Window*. The preview window allows you to have a sample document open as you set up your field. Besides serving as a nice visual reference, this also helps you set up your zones.

To open a document in the preview window, click the Open button on the main toolbar, browse out to your sample PDF, and open it.

**Note:** The document in the preview window is not part of the content field. It’s simply there for your convenience as you figure out the optimal settings for your content field.

**Text Window.** In addition to the document preview, you can view the document’s raw text. This is especially helpful for writing regular expressions. To toggle the text window on/off, click *Text Window*.

**Common Field Options**

Every flavor of content field shares a few common options:

**Name.** Each content field requires a unique name. Use a name that helps you identify the field easily. This name will be displayed everywhere that you use the content field.

**Description.** The description is for your purposes. Use it to supplement the name, giving further information about what this field does.

**Page.** Since a content field pulls information out of the document, it needs to know which page to look on. You will specify this with the *Page* option.

**Formatting.** You can apply some character formatting to the text that gets pulled from the document. For example, you can convert it to all uppercase letters. The formatting options are fully explained on p. 51, *Character Formatting within Fields*. 
### 15.2 Barcode Fields

A Barcode content field pulls the information out of a barcode. The only thing you need to specify is which barcode to use. For example, if you have three barcodes on the page, you can specifically target barcode #2.

**Important:** FileCenter won’t look for barcodes automatically. You must enable barcode detection. When you scan or run OCR, go to the *Barcodes* tab > *Content Rules or Naming Options Contain Barcodes.*

**Note:** If you have more than one barcode on the page, don't assume what order they fall in. They aren't always identified in the order you'd expect. Test it out carefully to be sure you've targeted the correct barcode.

**Tip:** If your barcode isn't being recognized, you probably need to adjust your barcode settings. Not all barcode types are enabled by default. Go to the FileCenter *Settings* button > *Barcodes.*

### 15.3 Regular Expression Fields

*Regular Expression* or *RegEx* fields are probably the most difficult to understand but also the most powerful. In short, regular expressions allow you to extract text from the document based on a pattern. For example, you can write a pattern that looks for things like:

- Dates
- Invoice numbers
- Social security numbers
- Names, based on surrounding text
- Specific names or keywords

To create a regular expression field, we strongly suggest opening a sample document in the preview window first. This will let you test your expression interactively to ensure that it works the way you expect.

**Regular Expression.** You'll enter the regular expression in the Regular Expression field. We'll go over the syntax of regular expressions in on p. 122, *Regular Expression Syntax.*

**Important:** Many regular expression examples that you'll find on the Internet put quotes and/or forward-slashes around the expression like this: "/expression/". **Do not** put the expression in quotes or slashes. The only thing you need to enter is the expression itself.
**Text Option.** You can control how FileCenter looks at the text in the document. Specifically, you can control how FileCenter deals with lines and paragraphs:

*Continuous Text.* All text is treated as one continuous chunk with no line breaks.

*Paragraphs.* An attempt is made to break the text into paragraphs. Any line terminating with end-of-sentence punctuation is considered the end of a paragraph.

*Lines.* Each horizontal line in the document is treated as its own line of text.

*Words.* Each word is its own line of text.

In most cases, the text flow is irrelevant and you can leave it set at *Continuous Text* or *Paragraphs*. If, however, you need to target text based on its **position in a line**, you’ll want to set the **Text Option** to **Lines**.

For example, suppose that the customer’s name is always the last text on the line and always follows “Bill To”. You can set your regular expression to grab all of the text between “Bill To” and the end of the line:

```
Bill To (.*)$
```

**Return Expression (optional).** By default, a regular expression field will give you back whatever text the pattern matched (if there are multiple matches, you'll get the first one back). You can, however, use parentheses in your regular expression to isolate specific pieces of text. Further, you can rearrange those pieces of text and even add more information and punctuation.

### Using Parentheses to Isolate Segments of Text

Suppose you’ve written the following regular expression to isolate the first name and last name of a client in a letter:

```
Dear ([A-Z][a-z]+) ([A-Z][a-z]+),
```

**Interpretation:** This pattern looks for the word "Dear" followed by a space, then two words that begin with a capital letter plus any number of lower-case letters, and finally a comma.

Notice that the first name and last name are placed in parentheses. The parentheses give you specific access to those bits of text. To access the text in parentheses, put a backslash "\" in the **Return Expression** followed by a number indicating which set of parentheses to access. Going back to our example, to get *First Last*, put this in the return expression:

```
\1 \2
```
To get Last, First put this in the return expression:

`\2, \1`

You can put whatever additional text or punctuation you want in the return expression. For example:

The first name is \1 and the last name is \2.

**Getting Back the Whole Match**

Normally if you want the whole match, you should leave the *Return Expression* blank. But if for some reason you need to include the whole match in the *Return Expression*, use "\0" (a backslash and the digit 0).

Suppose you have the following regular expression to extract a date from the document:

```
(\[0-9\]+)/(\[0-9\]+)/(\[0-9\]+)
```

Interpretation: This pattern looks for three sequences of digits separated by slashes, so it will find a date in this format: 7/20/1969. There are parentheses around each date element to isolate that value.

Here are all of the placeholders you could use in the return expression along with the value they would give you for the date 7/20/1969:

- `\0` - 7/20/1969
- `\1` - 7
- `\2` - 20
- `\3` - 1969

**Working with Dates**

One of the most powerful uses for regular expression fields is locating the document date. For example, many offices like to use a date in the filename. Using a regular expression field, you can pull the document’s actual date and use it in the filename.

But there’s a problem with this approach. The date in the document is rarely formatted the same way you’d want to use it in a filename. For example, suppose that the date in a document shows up in the typical format: *July 20, 1969*. That’s not terribly useful for a filename. We
always recommend that filenames use the format 1969-07-20. Which raises the question, how do you reformat document dates for use in filenames?

You can do this through the field’s Formatting option. Just enter -DT as the formatting flag, followed by the date format you want to use:

```
-DT yyyy-mm-dd
```

The “-DT” signals that you want to use a different date format, and the “yyyy-mm-dd” indicates what format you want to use.

The formatting codes are explained on p. 48, Dynamic Fields.

### 15.4 Zone Fields

Zone fields pull text from a document based on specific coordinates. In a nutshell, you define a rectangle on the page. Any text that falls within that rectangle will be returned. Zone fields are the perfect choice if the text you’re targeting never moves on the page. For example, you could use a zone field to pull an invoice number from a standardized invoice.

Before you create a zone field, you will need a sample document that you can open in the preview window. You will draw your zone on the sample.

To create a zone, simply draw a rectangle on your sample document. The coordinates will be picked up automatically.

*Tip:* Grab as much space around the text as you can in order to give yourself some buffer since page alignment can vary from scan to scan. If the zone picks up fragments of outside text, they’ll be ignored if at all possible.

**Updating a Zone.** If you need to make a small adjustment to your zone, do the following:

1. If the rectangle isn't showing, click Draw Zone
2. If the rectangle is solid red with no handles, carefully click somewhere on the red line
3. You should now see handles on the zone
4. Drag any handle to resize the rectangle
5. Click the circle in the center of the rectangle to reposition it

Alternatively, draw a new rectangle anywhere on the page. The existing rectangle will be removed.
15.5 Testing Your Content Field

It's a good idea to test your content field to make sure that it's working the way you expect it to. In order to test the field, you'll need to open a sample document in the preview window.

To test the field, click the Test button. The extracted content will show up in the adjacent field.

15.6 The Content Field Library

If your field will be useful in other places, you can copy it to the Content Field Library. The library is a place to collect commonly-used fields so you don't have to re-create them again and again.

Adding a Field to the Library

To add a field to the library, do the following:

1. Set up your content field so it works the way you want it to
2. Click the Library button to show the library below (if it isn't already visible)
3. Click Add to Library

Using Fields from the Library

If you want to use a field from the library, select it in the library then click Copy Up. All of its settings will be copied into the field you're working with. If you update the settings, clicking Save Changes will update the library copy.

15.7 Data Mining with Content Maps

As long as you’re extracting content for your filenames, you might consider passing it along to some of your other software. Through content fields, FileCenter gives you the ability to export content to external data sources like customer databases.

How to Set it Up. To export data, you create a Content Map. A content map is an ordered list of content fields that you want exported. Here’s how to set one up:

1. Go to the FileCenter Tools button > Content Field Editor
2. Create all of the content fields you’ll need and add them to the Library
3. Go to the Content Maps tab
4. Give the new map a unique name
5. In the Content Fields grid, add each of the fields you want to use
6. Select the folder where you want the data file saved
7. Add your new map to the Library

**How to Use It.** You can do the data export any time that you scan or OCR a document. For example:

1. Start a new scan
2. Select the Map tab
3. Click the Library button to select a content map from your library
4. Proceed with the scan

FileCenter will extract the content from each of the content fields and save it to a data file.

**Tip:** You can assign content maps to your separators. This allows a separator to trigger a data export from the associated document. See p. 163, All Separator Options Explained.

**Where does the Data Go?** Your content map has a folder assigned to it. FileCenter will save the data to that folder as a CSV file, a universally-supported data format. The file will have the name of your content map along with a timestamp. The data file contains one line for each page in your document along with the content fields found on that page.

### 15.8 Regular Expression Syntax

Think of regular expressions as patterns. Your goal is to pattern the text that you want to extract. You create this pattern through a very specific syntax:

- .  
  A period matches any single character (a wildcard)
- *
  Matches zero or more of the preceding character
- +
  Matches one or more of the preceding character
- ?
  The preceding character is optional
- !
  Must not include the preceding character in that position
- \{n\}
  Matches a specific number of the preceding character
- [a-zA-Z]
  Matches any letter of the alphabet
- [0-9]
  Matches any number
- [^characters]
  Must not match any of the characters listed in the brackets
- \d
  Any digit; identical to [0-9]
\D  Any non-digit; identical to [^0-9]
\w  Any "word" character: a-z, 0-9, or underscore "_"; identical to [a-zA-Z0-9_]
\W  Any non-word character
\s  Any "whitespace" character: space, tab, return, etc.
\S  Any non-whitespace character
^expression Requires the match to be at the beginning of the line of text
expression$ Requires the match to be at the end of the line of text
\b Requires a match to be at a "word boundary"

**Either-Or**

You can list alternatives by separating them with a pipe "|". For example, this will look for any common household pet:

```
cat|dog|goldfish|parakeet
```

To isolate the options from the rest of the pattern, surround them in parentheses:

```
I want a (cat|dog|goldfish|parakeet) for a pet
```

**Using the Special Characters Literally**

If you want to use one of the special characters literally – as an actual character in your pattern – put a backslash "\" in front of it. For example, if you want to use a period, plus symbol, or exclamation mark as part of the pattern, do this:

```
\.  
\+  
\!
```

The special characters that would require a backslash are: \^ $ . | ? * ( ) [ ] { }

### 15.9 Regular Expression Examples

The best way to learn regular expressions is through examples. So here are some simple and real-world examples.

bat Matches the bat in bat, battle, combat, unbathed, etc.
b.t Matches *bat, bit, bot, b9t, b&t, b t* but not boat (will also match any of those in the middle of a word)

b.*t Matches *bt, bat, boat, b39-26xt, etc.* (will also match any of those in the middle of a word)

\bword\b Ensures that word is a complete word; it won't match sword, swordplay, or wordy, only word

b.+t Matches bat, boat, b39-26xt, etc. but not bt

[a-zA-Z]+ Matches any complete word: axe, house, hippopotamus but not double-take

\w+ Matches any complete sequence of letters or numbers: bat, B2384, 229A, etc.

^[a-zA-Z]+ Matches any complete word at the beginning of a line of text

[a-zA-Z]+\$ Matches any complete word at the end of a line of text

[0-9]+ Matches a sequence of numbers: 12345 but not 12,345

[0-9,]+ Matches a sequence of numbers, including commas: 12,345

[0-9,\.]+ Matches a sequence of numbers, including commas and decimals: 12,345.67

\d+ Identical to [0-9]+

[aeiou] Will match any single vowel

[aeiou]+ Will match any sequence of vowels

[^[aeiou]+ Will match any sequence of consonants

*Pull Information from Body Text*

Each of the examples below requires you to create a CONTENT field. Use each example as the Regular Expression value.

\b\d\d\d-\d\d-\d\d\d\d\b

Extracts a social security number. It looks for exactly three digits + a dash + exactly two digits + a dash + exactly four digits. The \b are word boundary markers. In other words, there can't be any other alphanumeric characters before or after the social security number. This prevents false positives, like 00000-00-0000.
Identical to the last example.

Identical to the last example.

Dear ((a-zA-Z\-\.| \)+),

Pull the recipient's name from a letter that's in this format:

Dear John Hanks,

It looks for the literal text "Dear " followed by a sequence of letters and spaces leading up to a comma. It tolerates hyphens and dots in the name, so "Ann-Louise P. Barnacle" would be captured.

**Important:** To use this example, you need to set the content field’s Return Expression to: \

(January|February|March|April|May|June|July|August|September|October|November|December) (\d+), (\d+)

Matches a date in the format "January 1, 1990". You can either accept the whole date back, or take out individual portions by putting any combination of the following in the content field’s Return Expression:

- \1 = the month
- \2 = the date
- \3 = the year

assign ((a-zA-Z\-\.| \)+) as my agent

Gets the text between "assign ________ as my agent". For example, suppose your document consistently states the agent name with this language: “I hereby assign Bob Johnson as my agent." This pattern will pull out the name. Again, to use this example, you need to set the content field’s Return Expression to: \

Pull Information from Another Naming Option Field

On page 51, Character Formatting within Fields, we discussed the –X formatting option which can employ a regular expression to pull out only a portion of a naming option field.
For example, let’s suppose that our drawer names have the client’s last name, first name - id number like this:

    Johnson, Robert - 55236
    Kirby, LeAnn - 238967
    Larson, Steve - 1296

You could use the following expressions to pull out each piece of information:

«FOLDER Drawer [-X1 ^(.*)]»

This takes everything from the beginning of the drawer name up to the comma. In other words, it captures the last name. The important character is the "^" at the beginning, which requires the match to occur at the beginning of the drawer name. We've also used parentheses to capture only a portion of the pattern, so we also used -X1 to give us back the value of the first set of parentheses.

«FOLDER Drawer [-X \d+$]»

Captures the client ID by taking the sequence of numbers from the end of the drawer name. The important character is the "$" at the end, which requires the match to happen at the end of the drawer name.

«FOLDER Drawer [-X \w+$]»

Also extracts the client id from the end of the drawer name. This version tolerates letters and numbers in the id.

«FOLDER Drawer [-X [0-9\-]+$]»

Also extracts the client id from the end of the drawer name. This version tolerates hyphenated numbers like "555-21397".

«FOLDER Drawer [-X [^ ]+$]»

Also extracts the client id from the end of the drawer name. This version tolerates any kind of character except a space.

«FOLDER Drawer [-X1 , (.*) -]»

Captures everything between the comma and hyphen. In other words, it captures the first name. We only want the portion in parentheses (the first substring), so we use -X1 where the “1” indicates we want the text from the first set of parentheses.
Chapter 16: Advanced Scanning

We introduced you to scanning in Chapter 6: Scanning Basics. In this chapter, we’ll cover other ways to scan, how to make adjustments to the scanned image, and we’ll explain all of the options on the Scan dialog.

Some FileCenter users do intensive scanning. To help ease and automate this process as much as possible, we’ve given FileCenter some powerful scanning features aimed specifically at bulk scanning. These features deserve a separate discussion of their own. We’ll cover them in Chapter 17: Speed Up Repetitive Scanning.

16.1 More Ways to Scan

Besides the basic scanning methods we’ve already covered, FileCenter features some specialized scanning options designed to take the pain out of common problems.

Scan to E-mail

It’s surprising how many fax machines remain in daily use, especially considering that everyone has access to email. But the fax machine continues to fill an important role: sending copies of paper documents. The classic case is when you need to sign a form and return it – a nondisclosure agreement, a rental agreement for a vacation property, a school permission slip, etc.

People tend to favor faxing over scanning because scanning’s slower and because they don’t know where to put a file that’s only intended for emailing. FileCenter fixes these problems by letting you scan directly to email. It’s fast and it doesn’t leave a stray file on your computer. Here’s how it works:

1. In either Manage or Edit view, click Scan on the main toolbar
2. For the scan Action, select Scan to Email
3. Give the scan a Filename; this will be the name in the email attachment
4. Set any other scan options
5. Proceed with the scan

FileCenter will scan the document and attach it directly to a new email message using the name you specified.
Important: For this to work, you must have a working email client on your computer – like Outlook or Thunderbird. This will not work with web-based email programs, like Gmail and Yahoo. To use Scan to Email with these services, see p. 183, Web Mail (Gmail, Yahoo, etc.).

Tip: If you see a mail setup screen when you try scanning to email, it means you don’t have an email program set up. You’ll have to get an email program set up and working on your computer.

Insert New Pages into an Existing Document

We already discussed how to add a PDF to an existing file on p. 90, Combine PDF Files through Drag-and-Drop. But what if you need to scan new pages into an existing file? For example, you want to add a shipping receipt to a purchase order, or you need to add a signed addendum to a contract.

FileCenter provides scanning options to make this easy:

1. Either select the file in Manage view or open it in Edit view
2. Click Scan on the main toolbar
3. For the scanning Action, select either Append Scan (place it at the end of the document), Prepend Scan (place it at the beginning of the document), or Insert after Page and provide the page position where you want it inserted
4. Set any other scanning options
5. Proceed with the scan

FileCenter will scan in the pages and insert them into your existing file.

Note: The scanning options you select will only apply to the new pages. They will not affect the existing pages in the file.

Double-Sided Scanning

Many scanners have the ability to scan both sides of a page at once. Even if yours doesn’t, FileCenter can still help you scan two-sided documents.

FileCenter and most scanner makers refer to double-sided scanning as Duplex Scanning. Look at your scanner’s specifications and see if it mentions duplex or double-sided scanning. FileCenter has two duplex options, depending on whether your scanner has a duplex mode:
Scanner Duplex. If your scanner will scan both sides of a page at once, click *Scan* on the main toolbar, then select the *Scanner Duplex* option. This will tell your scanner to scan both sides of the page. We also recommend that you select *Remove Blank Pages* on the *Advanced* tab so that blank sides won’t get included in the scan. To switch back to single-sided scanning, de-select *Scanner Duplex*.

**Manual Duplex.** Use *Manual Duplex* when your scanner can only scan one side at a time. The scan happens in two passes – first the front side, then the back side. Here’s how to use it:

1. Load the document in your scanner so the front side will scan
2. Click *Scan* on the main toolbar
3. Select the *Manual Duplex* option
4. Scan the front side of the document
5. Next you’ll be prompted to pick up the stack, flip it around, and put it back in the feeder so the back side will scan; **DO NOT REORDER THE PAGES!**
6. Scan the back side of the document

After the second scan finishes, FileCenter will rearrange the pages in the right order: page 1 front, page 1 back, page 2 front, page 2 back, etc.

**Note:** The *Remove Blank Pages* option isn’t available with *Manual Duplex*. Once the scan’s done, you’ll need to go through and delete blank pages yourself.

**Scanning with Flatbeds: Books, Multi-Page Documents, etc.**

The frustration of a flatbed scanner is that you have to scan every page by hand, then figure out how to combine all of those scans into one document. And when you’re scanning large documents or books, this gets especially tedious.

FileCenter has a *Prompt for More* feature designed especially for flatbeds (or any situation where you have to scan in stages). With this feature, you initiate the scan once, then FileCenter will pause after each page, giving you a chance to load the next sheet or reposition the book. You end up with a single file with all of your pages in it. Here are the steps:

1. Load your first page on the flatbed
2. Click the *Scan* button on the main toolbar
3. If you’re using a flatbed scanner, select the *Use Flatbed* option
4. Select *Prompt for More*
5. Set any other scanning options you want
6. Click *Start Scan*
7. FileCenter will scan the first page, then ask if you have more pages to scan; don’t answer yet.
8. Change the page on the scanner
9. Now click Yes to scan the next page
10. Continue like this until you’ve scanned all of the pages

When you’re done, FileCenter will combine all of the pages into a single document.

16.2 Adjust the Scanned Image

Modern scanners do a wonderful job, but occasionally you’ll run across a document that needs extra tweaking. FileCenter has a number of adjustments you can make both before and after you scan. Your scanner may offer even more adjustments.

Adjust the Image Quality While You Scan

Go to the Scan dialog and click the Adjust tab. There you’ll find settings that control the brightness, contrast, and black/white balance of your scans. Note that these settings affect how your scan comes in. You can’t use them after-the-fact.

Contrast. (For color/grayscale scans only). Contrast adjusts the distinctness of each color/shade. For example, with low contrast, individual colors will be more muted and will blend more. With high contrast, each color will be crisp and distinct. An example is twilight versus mid-day. At twilight, colors fade and blend together (low contrast). At mid-day, colors are sharp and distinct.

Brightness. (For color/grayscale scans only). Brightness adjusts the overall vibrancy of the image. With low brightness, the image will be dim. With high brightness, the image will be strong. Note that contrast and brightness work differently. For example, you could have high contrast (each color is distinct and sharp) but low brightness, resulting in a muted but sharp image.

Black/White Threshold. (For black & white scans only). You can think of the black/white threshold as brightness for black-and-white scans. Lowering the threshold brightens the image and raising it darkens the image. The truth is, this setting adjusts how sensitive your scanner is to the image. A very low threshold will only pick up very obvious marks on the page, which is good for reducing background speckling. A high threshold will let even tiny marks through, which is good for scanning faded/dim pages.
Note: Not all scanners support these adjustments. It’s also possible that you scanner has more options than FileCenter exposes. To see all of the adjustments your scanner supports, select the Use Scanner Dialog option when you scan.

**Edit the Image after You Scan**

After your scan comes in, you can make edits to the page: crop and straighten it, remove stray marks and background noise, and erase or even redact (black out) parts of the text. To use these features:

1. Open the scan in the *Edit* view
2. Select the page you want to edit
3. Click the *Edit PDF Image* button on the main toolbar
4. Make your edits
5. Click *Commit Changes*

Here are the editing tools you’ll find:

**Auto Straighten.** This tool will automatically straighten a skewed/crooked page. It tries to figure out the vertical/horizontal lines and de-skews the page accordingly.

**Straighten.** Use this tool to straighten a page manually. Click and drag to draw a line that represents where the horizontal or vertical plane should be. For example, draw a line that traces along the bottom of a line of text or along the left margin of the text. When you release the mouse, the image will rotate to make your line level. Your line won’t stay on the image.

**Crop.** Use the *Crop* tool to trim down the size of the page. For example, if you scanned a small receipt, you might want to trim the page down to the size of the receipt. Just select the *Crop* tool then click and drag to draw a rectangle to the size you want your page to be. When you release the mouse, the page will get trimmed.

**Redact.** The *Redact* tool is for blacking out sensitive information on the page. Click and drag to draw rectangles over sections of the page you want to black out. Use the *Redact* tool when you want it known that information was removed.

**Erase Area.** The *Erase Area* tool works just like the *Redact* tool, except instead of blacking out sections of the page, it erases them.

**Erase Outside.** While the *Erase Area* tool erases everything *inside* of the rectangle, the *Erase Outside* tool erases everything *outside* of the rectangle. For example, to remove black edges
and margin noise from your scan, drag and draw a rectangle around the body of the page. Everything outside of the rectangle will get wiped clean.

**Eraser.** To erase small dots, use the *Eraser* tool. Click once on stray marks, or click and drag across areas. Note that you can change the size of the eraser. Click the drop-arrow next to the *Eraser* button and choose the size you want.

**Despeckle.** The *Despeckle* tool will automatically clean up dirty images. It analyzes your page, identifies background “noise” and specks, and removes them from the page.

### Automatic Image Cleanup

FileCenter Pro Plus includes automatic image cleanup tools that can scrub an entire document at once. To use it, simply select the document in your cabinet, click *Cleanup* on the main toolbar, and choose the options you want to use. The following options are available:

- **Deskew.** This option will straighten each page if any of them are slightly angled, a common problem when paper gets pulled through the scanner.

- **Despeckle.** This option removes random “noise” from the scan – small stray dots and specks.

- **Remove Border.** Scanned images often end up with black lines along the edges of the page. This option will remove them.

- **Remove Punch Holes.** If the original document had punch holes for a binder, the holes often come across in the scan as black circles. This option erases the black circles.

**Tip:** Each of these tools is also available as an option when you scan.

**Pro Plus Only:** This feature is only available in FileCenter Pro Plus.

### 16.3 Scanning Options Described

We’ve touched on many of the options on the *Scan* dialog. Here’s a full description of all options.

**Actions**

The scan *Action* controls what kind of scan you want to perform:
New Scan. This is the basic scanning option that you’ll use most of the time. It starts a new file.

Scan to Word. This option will scan a document, recognize the document text with OCR (Optical Character Recognition), and send the OCR text to your word processor for editing. Use this option if you only care about getting usable text from the scan.

Scan to E-mail. This option will scan a document and attach it directly to a new e-mail message. It is a great way to send a paper document to another party without the hassle of sending a fax.

Append Scan. You can append pages to an existing file. To make this option available, select the file in Manage view or open it in Edit view, then click Scan > Append Scan. The scanned pages will be added to the end of the file.

Prepend Scan. This is the same as Append Scan, except that the pages are added to the beginning of the file.

Insert after Page. This is the same as Append Scan, except that you can choose where the pages will be inserted. For example, if you want to insert some pages after page three, enter “3” as the page position.

Save Options

If you scan in the Manage tab or choose Scan to Email, you’ll see options for naming and saving the scan:

Filename. You need to give the scan a filename. Note that there’s a drop-arrow and a “…” button next to the filename field, which you can use to access your Naming Options and Custom Lists for faster file naming. See p. 47, Pre-Defined Filenames for more information.

Tip: If you select a file in Manage view then click the Scan button, FileCenter will default to that filename, plus an increment (counter).

Keywords. Use the Keywords field to add searchable keywords, descriptions, etc., to the PDF when you scan. The keywords will be saved to the PDF file’s Keywords metadata field. This is an easy way to make your scans searchable without running OCR.

Bookmark. If you’re scanning to PDF, you can optionally add a bookmark to the first page of the scan. The ideal use for this option is when you’re adding additional pages to an existing file. A bookmark can indicate where the added pages begin.
Scanner Options

Click Select next to the Scanner field to access the scanner options. There are three options that control what scanner driver FileCenter will use and how it will interface with the driver. Tweak these settings if you’re having a hard time getting FileCenter to work with your scanner.

**Scanner.** Use the Scanner option to select the scanner you want to use. If your scanner is listed more than once, first try any option that does NOT have “WIA-” in the name. If your scanner isn’t on the list, Windows doesn’t recognize it, either because it isn’t connected/turned on, or because you don’t have a TWAIN driver installed for the scanner.

**Mode.** If FileCenter is having a hard time communicating with your scanner, try changing the Mode. There are a number of modes available, and one of them will usually work.

**Transfer.** If there are problems or crashes transferring the scanned pages into FileCenter, try changing the Transfer type. Most scanners support Native, but sometimes Memory and File are more reliable.

**Important:** If you’re still having trouble getting your scanner to work, see Task 11: Troubleshoot Scanner Problems. If your scans are going through but there are problems with the images, see Task 13: Troubleshoot Scanned Image Problems.

Scan Tab

The following options are available on the Scan tab of the Scan dialog:

**Type.** This controls the file format for saving your scan. You can choose PDF, TIFF, or JPEG. Here are the benefits and drawbacks of each:

**PDF –** This file format is quickly becoming the standard for archiving files. With PDF you get a true reproduction of the original document that you can also annotate and comment on. PDF also lets you embed the actual text of the document behind the scanned image, making it searchable and able to be indexed. Other advantages of PDF are that nearly everyone can open a PDF file on their computer, and PDF files can be secured with encryption and passwords.

**TIFF –** TIFF has long been the standard for saving scanned files. A TIFF file gives a true reproduction of the original document and can have a very small file size. The downside of a TIFF is that it doesn’t allow for annotation or embedding the actual text of the document. But if you’re not concerned about making your scans searchable, TIFF is still a good choice.
**JPEG** – The JPEG format is designed specifically for digital photos. Use JPEG for all of your photo scanning.

**Note:** If you choose *TIFF* or *JPEG*, this will limit your OCR options since they don’t support embedded text.

**Color.** This setting determines the color of your scan. The more colors you use, the larger the file size will be. As a rule of thumb, you should generally scan documents in *Black & White*. This gives a good reproduction of the original but keeps the file size small. *Grayscale* will produce smoother edges at the cost of file size. *Color* scans will produce very large files.

**Note:** Not all scanners support all of the color options, especially *4-bit Grayscale* and *8-bit Color*. Also, your scanner may support color options that aren’t listed here. To see a list of the color options your scanner supports, select the *Use Scanner Dialog* option.

**DPI.** Scanning “DPI” refers to *Dots Per Inch*. A scan is made up of millions of tiny dots. The more dots per inch, the smoother the scanned image will look. As a rule of thumb, you should scan documents at 200-300 DPI. A 300 DPI scan will look just like the original when you print it. A 200 DPI scan will be slightly more rough around the edges, but still very acceptable. Resolutions higher than 300 DPI won’t improve the printed quality but will bloat the file size.

**Note:** Not all scanners support all of the resolution settings. Also, your scanner may support resolution settings that aren’t listed here. To see a list of the resolutions your scanner supports, select the *Use Scanner Dialog* option.

**Paper.** The *Paper* option tells the scanner the page size of the originals. The resulting scan will match the dimensions of the paper size you select here.

**Tip:** Many scanners have automatic paper size detection. To use it, select *Use Scanner Dialog* and *Start Scan*. This will pop up your scanner’s interface. Here you should look for an option like *Automatic* in the paper size, or a setting called *End of Page Detection, Auto-Crop*, or something similar.

**Order.** Most scanners give you the scanned pages in their original order. Some scanners, however, reverse the order. You can correct this with the *Order* option. Select *Reverse Simplex* for single-sided scans, or *Reverse Duplex* for double-sided scans.

**Use Scanner Dialog.** Your scanner will have some options beyond what FileCenter shows. You can see your scanner’s own scanning dialog with all of its options by selecting *Use Scanner Dialog*. This will pop up your scanner’s dialog when you begin a scan.
Use Flat Bed. If you have a flatbed scanner (where you have to put each sheet down on the glass yourself), select Use Flat Bed. Some flatbed scanners also have a sheet feeder. Select Use Flat Bed when you want to scan from the glass, and de-select it when you want to use the sheet feeder.

Scanner Duplex. Some scanners support double-sided scanning, meaning that both the front and the back of the page can be scanned at the same time. You can turn double-sided scanning (“duplex” scanning) on and off with the Scanner Duplex option. If you need to do a double-sided scan but your scanner can only scan one side at a time, use Manual Duplex instead.

Manual Duplex. Use Manual Duplex to scan double-sided documents when your scanner can only scan one side at a time. FileCenter will guide you through two passes. First you scan the front side, then the back. FileCenter will then rearrange the pages in the right order: page 1 front, page 1 back, page 2 front, page 2 back, etc.

Deskew Pages. It’s common for sheet-fed scanners to pull pages through crooked, resulting in a slightly rotated scan. The Deskew Pages option will try to straighten images automatically as you scan so that you’ll always get upright pages. To straighten pages after-the-fact, see Edit the Image after You Scan above.

Tip: Many scanners can automatically straighten the scans. This will work better than FileCenter’s option, since the scanner knows if the page is going through crooked. To see if your scanner can do this, select Use Scanner Dialog and Start Scan. This will pop up your scanner’s interface. Here you should look for an option called Deskew or Straighten Pages.

Invert Pages. Some scanners produce “inverted” or negative images – white text on a black background. If your scanner creates negative images, correct it with the Invert Pages option.

Prompt for More. If you have a document that is too big to fit in the feeder or you have a flatbed scanner, use Prompt for More. At the end of each scan, FileCenter will ask if there are more pages to scan. It won’t finalize the document until you’re done scanning.

Auto-Crop Pages. This option will attempt to trim excess whitespace or black edges off of the page. It’s ideally suited for scanning receipts and other odd-sized pieces of paper. To crop pages after-the-fact, see Edit the Image after You Scan above.

Tip: Many scanners have their own auto-crop functions. If your scanner supports auto-crop, use it instead. Your scanner already knows the edges of the page and can do a more accurate cropping. To see if your scanner supports auto-crop, select Use Scanner Dialog to pop up your scanner’s interface when you scan. Then look for Auto-Crop, Auto-Trim, Automatic Paper Size Detection, or something similar.
**Pro Plus Cleanup Options.** The following options are only available in FileCenter Pro Plus:

*Deskew.* Straightens any page that comes in slightly angled.

*Despeckle.* Removes random “noise” from the scan – small stray dots and specks.

*Remove Border.* Removes the black lines that often occur along the edges of pages.

*Remove Punch Holes.* Removes the black circles that result from hole punches.

**Pro Plus Only:** These cleanup options are only available in FileCenter Pro Plus.

**Adjust Tab**

See p. 131, Adjust the Image Quality While You Scan.

**OCR Tab**

The OCR-related options are available on the **OCR** tab. All of them will cause OCR to run after your scan, but only the first option, *Make Searchable PDF*, will save the OCR text with your scan. The other options make use of the OCR text for one reason or another, but then discard it. For more information on these options, see p. 112, OCR Tab.

**Separate Tab**

*Separate Document Every ___ Pages.* If you want to automatically break the document up every few pages, select *Separate Document Every ___ Pages* and provide a page interval. For example, suppose you've scanned a stack of three-page forms. Enter “3” as the page interval. You’ll get a series of numbered files, each three pages long. If your *Filename* is “Scanned Form.pdf” you’ll end up with files named *Scanned Form [1].pdf, Scanned Form [2].pdf*, etc.

*Process Content Rules.* FileCenter can intelligently separate and route documents based on information in the document itself. To enable this option for the scan, select *Process Content Rules*. For more information, see p. 153, Page Content Separato.

**Pro Plus Only:** This feature is only available in FileCenter Pro Plus.

*Process Page Separators.* Think of *Page Separators* as special cover pages that show where a new document begins. If you’re scanning a stack of documents and you put page separators
between them, FileCenter can automatically split up the stack into individual documents. We’ll go over this on p. 149, Page Separators.

If you want FileCenter to look for page separators in the document, select *Process Page Separators*, otherwise it will ignore them.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

**Delete Original File after Successful Separation.** When you’re scanning directly to file in the *Manage* tab, you can still use separators. But that creates an issue: what happens with the original file after the separators get processed? By default, FileCenter will leave the original file intact. Once you’ve verified that all of the documents separated and got routed properly, you can then delete the original. If you’d rather have FileCenter delete the original automatically, select *Delete Original File after Successful Separation*.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

**Advanced Tab**

**Remove Blank Pages.** FileCenter can try to identify blank pages in the scan and drop them. This happens as the scan comes in. To identify a blank page, FileCenter looks at how much of the page is white. If it’s almost completely white, FileCenter will consider it blank and drop it from the scan. To adjust the sensitivity, use the *Blank Page Sensitivity* setting, where a low number tolerates no stray marks on the page and a high number will tolerate some speckles and black marks.

**Default Filename.** See p. 143, Include a Filename in the Profile.

**Other Options:** See p. 83, Conversion Options.

**Metadata Tab**

We strongly recommend including metadata keywords when you scan. They don’t display in the document, but they are more useful for document searches than OCR text (see p. 172, Metadata Fields).

There are two ways you can include metadata when you scan: using the *Keywords* field as described on p. 134, Save Options, or for even more control and the option of using the metadata fields as part of the scanning profile, which you’ll learn about next, you can use the fields on the *Metadata* tab.
This tab allows you to use four different metadata fields: Title, Author, Subject, and Keywords. There is no hard and fast rule about which field(s) to use. You can use any one of them in isolation or all of them together, however it fits your workflow best.

**Note:** If you use this Keywords field and the Keywords field under the Save As options, FileCenter will combine the keywords.

To make it as easy as possible to include metadata in your scans, FileCenter includes some dynamic tags that you can insert instead of manually typing in common, repetitive values:

- **%FileName%.** The tag “%FileName%” (including the percent symbols) will be converted to the name of the file once the document gets saved (excluding the drive and folders).

- **%FilePath%.** The tag “%FilePath%” resolves to the complete file path, including the filename.

- **%DateCreated%.** The “%DateCreated%” tag gives the date the document was created (formatted using the default date format on your system). This will normally be the current date unless you’re appending the scan to an existing document, in which case it will use the existing document’s creation date.

- **%DateToday%.** The “%DateToday%” tag gives you the current date formatted using the default date format on your system.

- **%UserName%.** The “%UserName%” tag will insert the Windows login name for the current user. Note that this isn’t the display name, but the login name they type when logging onto the computer.

- **%ComputerName%.** The “%ComputerName%” tag will insert the network name for this computer.

**Pro Only:** This tab is only available in FileCenter Professional and Pro Plus.

**Barcodes Tab**

**Process Barcodes as Separators.** You can have FileCenter treat your own barcodes as separators. It can separate a document every time it encounters a barcode, route the separated file to a path contained in the barcode, or even treat the barcode like a full-fledged FileCenter separator. We discuss using barcodes as separators on p. 158, Barcode Separation.

**Content Rules or Naming Options Contain Barcodes.** FileCenter does not look for barcodes automatically. If any of your naming options or content rules contain barcodes, this option will
tell FileCenter to look for them. We discuss these topics on p. 117, Barcode Fields and on p. 154, Content Rules.

*Pro Plus Only:* This feature is only available in FileCenter Pro Plus.

**Map Tab**

FileCenter can optionally export specific information from the document’s content to an external data file. This is accomplished through *Content Maps*. See p. 121, Data Mining with Content Maps for more information.

*Pro Plus Only:* This feature is only available in FileCenter Pro Plus.

**Variables Tab**

One of the most flexible naming option fields – the *Variable* field – allows you to provide the field value at the time you scan or run OCR. See p. 48, Dynamic Fields.

The place to provide those values is on the *Variables* tab. Values you provide here will feed into the naming options when the file gets saved. Enter the values in this format:

```
variable_field_name=value
```

For example, suppose you set up a variable field called *DocumentType*. To set it to “Letter” you would enter the following:

```
DocumentType=Letter
```

You can set more than one variable. Simply enter one per line:

```
Department=Estate Planning
DocumentType=Letter
User=Bob Johnson
```

*Note:* Variable names cannot contain spaces (but the values can). Variable names are *not* case sensitive.

*Pro Plus Only:* This feature is only available in FileCenter Pro Plus.
16.4 Scanning Profiles

You may have two or three different ways you scan 90% of the time. Changing the same settings over and over can be a real nuisance, not to mention inefficient and error-prone. FileCenter solves this problem by letting you store your most common scanner settings as “profiles”, or presets. When you want to do a different kind of scan, just select the profile you want to use and FileCenter will apply the right settings for you.

Important: Some users scan with the Use Scanner Dialog option so they can see their scanner’s native interface and all of the settings it exposes. You cannot include the settings on your scanner’s dialog in a profile, only the settings on FileCenter’s Scan dialog.

Add a Profile

FileCenter comes with one profile already: the Standard Profile. Let’s start by modifying that profile:

1. Click the Scan button on the main toolbar
2. Right below the Scanner option, notice the Profile option
3. Change a couple of the settings on the grid
4. Click the Save button next to the Profile field

Now Cancel out of the Scan dialog, then go back in again. You’ll notice that the new settings stuck. They were saved to the Standard Profile.

Now let’s create a new profile:

1. Set any options you’d like on the Scan dialog
2. Click the New button next to the Profile field
3. Give the new profile a name, and click OK to save it

Now back on the Scan dialog you’ll notice that your new profile is selected. In the Profile field, change back to the Standard Profile then back to your new profile and watch how the options change.

When you want to scan, just select the profile you want to use, and FileCenter will apply the settings.

Note: Profiles can include any of the options below the Profile field, but not the ones above it. For example, the scan Action and scanner selection can’t be part of a profile.
Scanning with a Profile

When you want to scan, just select the profile you want to use, and FileCenter will apply the settings.

Tip: You can select a profile then change the options a bit. That’s not a problem. Just select the profile you want to use, then tweak the settings. The changes won’t stick with the profile unless you click Save.

Include a Filename in the Profile

While profiles are limited to the options at the bottom of the Scan dialog, there is an exception: the Filename field. You can include a default filename with your profile. You’ll find a Default Filename option in the Advanced tab of the Scan dialog.

When you scan with a profile that has a filename, FileCenter will fill in the Filename field automatically. If there’s already a file in the directory with that name, FileCenter will include an increment (counter). For example, if your default filename is Invoice and there’s already a file called Invoice.pdf in the directory, FileCenter will put the filename as Invoice_2.pdf.

Modify or Delete a Profile

To modify an existing profile, first select it on the Profiles list, then select or de-select scanning options, as desired, and click Save.

To delete a profile, just select it on the Profiles list, then click Delete.

Quick Scanning with Profiles

Back in the main FileCenter interface, notice that there’s a drop-arrow under the Scan button. At the bottom of this menu, you’ll see your scan profiles listed (you may have to close and re-open FileCenter if profiles you just added aren’t showing up).

You can select a profile from the list to immediately launch a scan, without using the Scan dialog at all. Smart use of profiles and filenames with this quick-access list can speed up your scanning.
Chapter 17: Speed Up Repetitive Scanning

While we’ve now covered the mechanics of scanning, let’s shift our focus to the practical side of it. In other words, let’s learn how to scan as quickly and easily as possible.

Many offices and users deal with repetitive scanning – scanning the same kinds of documents and forms over and over, day in and day out. This is the kind of scanning where shaving off one step, or even one mouse click, actually pays dividends in the long run.

FileCenter supports a number of scanning techniques that were designed specifically to reduce the pain inherent in repetitive scanning. We’ll cover them in the next two chapters.

17.1 Use an Inbox with a Network Scanner or ScanSnap

If you use a network scanner, you probably enjoy some of the fastest scanning speeds available. And while you can’t use your scanner with the full range of features available in FileCenter, FileCenter does offer some tools designed specifically with a network scanner in mind. Namely, the Inbox, the Split View, and Drop Renaming.

How to Set it Up

First you need to find the network folder where your scanner saves new scans. Once you know that:

1. Go to the Inbox tab in FileCenter
2. Click the Inbox button
3. Browse to the folder where your scanner saves new scans
4. Click OK
5. Click the File Preview button to turn on the preview window
6. Click the Split View button to open the split view

You should now see the scans from your network scanner on top and your cabinets on the bottom.
How to Use It

This configuration was designed to help you rapidly move files from your network scanner into FileCenter. Here’s how you’ll typically use it:

1. Select a file in the Inbox
2. See what it is in the Preview Window
3. Provide a filename in the Drop Naming field or use the drop-arrow to select a Naming Option
4. Make sure Move is selected as the Drop Action
5. In the bottom view, select the cabinet location where you want to file the item
6. Drag-and-drop the item into place

You can move multiple files at once this way. They’ll all receive the same filename followed by an increment (counter).

Once you get used to this workflow, you’ll be filing away items very, very quickly.

Making this Work with a ScanSnap

All of these instructions apply equally to the ScanSnap. The only difference is that you’ll set the Inbox to the folder where the ScanSnap saves its new scans.

17.2 Scan to File with Naming Options

One of the fastest ways to move paper documents into FileCenter is scanning straight to file using Naming Options. We discussed naming options on p. 47, Pre-Defined Filenames, and learned there that naming options help you name a file in just a couple of mouse clicks. Couple that with in-place scanning, and you can move a lot of paper very quickly.

The steps are simple:

1. Go to Manage view
2. Go to the drawer/folder where you want to put the scan
3. Click Scan on the main toolbar
4. Click the drop-arrow or the “…” button next to Filename
5. Select your naming option
6. Click Start Scan
Making this Work with a ScanSnap

If you’ve turned on the ScanSnap integration using the instructions in Task 9: Integrate with a ScanSnap Scanner, things will work roughly the same way. You’ll browse to the drawer/folder where you want to save the scan and perform the scan on your ScanSnap. When the scan finishes, FileCenter will prompt you to rename it. You can access Naming Options at that point. Just click the drop-arrow or the “…” button next to the Filename field on the rename dialog.

17.3 Use Profiles with Filenames

If there are only a few kinds of files that you scan over and over, you can trim off even more mouse clicks using scanning Profiles with filenames. As we saw on p. 142, Scanning Profiles, profiles are just a way to store different scanning configurations. One of those scanning options is a filename. We also saw in that section that you can bypass the scanning dialog altogether by scanning straight to a profile. By combining each of these pieces, we can come up with a very fast scanning method.

How to Set it Up

First, set up each of your profiles following the instructions we gave on p. 142, Scanning Profiles. The most important setting is Default Filename, which you’ll find under the Advanced tab on the Scan dialog.

Most of your profiles will probably be identical except for the Filename. That’s ok.

For your filename, you can simply type one in or, to add some dynamic elements, you can use a naming option. See Chapter 8: Automate File & Folder Naming.

When you’re done setting up the profile, click OK.

How to Use It

Here’s how to scan with this technique:

1. Make sure the document is in the scanner, ready to go
2. Go to the Manage view
3. Go to the drawer/folder where you want to save the scan
4. Click the drop-arrow under the Scan button
5. You’ll see your profiles listed at the bottom of the menu; pick the one that applies to this document.

The scan will start immediately, then drop your file in the cabinet, already named and ready to go. If there’s already a file with the same name in the drawer/folder, the new file will get an increment (counter) after it.

Using this technique, you can literally bring new scans into FileCenter in two clicks, scanned, filed, and named.

17.4 Automatically Break Up Scans at Regular Intervals

If your office deals with standardized forms, you can scan whole stacks of them at once and have FileCenter split them up for you. On the Scan and OCR dialogs, you’ll notice an option called **Separate Document Every __ Pages** (on the **Separate** tab). If you select this option, FileCenter will take a single scan and break it out into multiple files. All you have to do is indicate how many pages you want in each file.

For example, suppose you’re scanning a stack of three-page forms. Select **Separate Document Every __ Pages** and enter “3” as the page interval. You’ll get a series of numbered files, each three pages long. If you set the **Filename** to “Patient Info”, you’ll end up with files named **Patient Info [1].pdf, Patient Info [2].pdf, etc.**
Chapter 18: Automate Scanning with Separators

Most of the scanning methods we’ve discussed so far require two things: first, that you scan one document at a time, and second, that you manually save the scan (or at least manually select the folder where you want to save it). What if you could eliminate both of these steps?

This chapter covers the concepts of *separating* and *routing*. While those terms may seem intimidating at the outset, they’re not hard to learn. In a nutshell, when we talk about separating and routing we’re referring to a group of features that make it possible to 1) automatically split up a scan into multiple documents, and 2) automatically save those documents to distinct locations.

This requires a bit of work to set up, but it’s not as complicated as it sounds. Once you have it all functioning, separating and routing will almost completely automate your scanning workflow.

**Note:** Separation and routing will work with a ScanSnap as long as you’ve turned on OCR for ScanSnap scans. See Task 9: Integrate with a ScanSnap Scanner.

**Tip:** If you have a network scanner, consider pairing it with FileCenter’s sister product, FileConvert. FileConvert supports the same separator and routing technology but has the advantage of total, invisible automation. It will monitor the output folder of your scanner and automatically grab and process new files. This means you can scan then walk away knowing the documents will get split apart and filed where they need to go.

**Pro Only:** Separation and routing is only available in FileCenter Professional and Pro Plus.

**Pro Plus Only:** Content- and barcode-based separation and routing are only available in FileCenter Pro Plus.

18.1 The Separators Dialog

You’ll set up separation and routing through the *Separators* dialog. To access it, click the *Separators* button on the main toolbar.

Here you can view, manage, and print your separators (where applicable).

You’ll find that there are three kinds of separators:
**Page Separators.** Page separators act like cover sheets. You place one of these special cover sheets on top of each document. FileCenter will split up the documents at the separator sheets and follow any routing instructions on the sheet.

**Page Content.** FileCenter can decide where to split up documents based on information in the documents themselves. You’ll set up rules to help FileCenter know what to look for.

**Barcodes.** If you use barcodes, FileCenter can split up documents based on the occurrence of specific barcodes.

*Pro Plus Only: Page Content and Barcode separators are only available in FileCenter Pro Plus.*

### 18.2 Page Separators

Think of *page separators* as special cover sheets you put on top of documents. If you scan a stack of documents that each have a separator cover sheet, the separators will show FileCenter where each document starts so that it can automatically break each document off into its own file.

But page separators don’t stop there. They can also contain *destinations, or routing instructions*. In other words, they can instruct FileCenter *where* to save the file, *how* to name it, and *what* options to use (like file type, whether to run OCR, etc.).

**Page Separator Basics**

As we mentioned, page separators are special cover sheets. You’ll set them up and print them in FileCenter. You can print as many copies as you need, and use them over and over. Once you’ve set up and printed your page separators, here’s how you’ll use them:

1. Place a printed separator on top of each document
2. Put your documents in a stack
3. Click *Scan* on the main toolbar
4. Select the *Separate* tab and make sure *Process Page Separators* is selected
5. Proceed with the scan

FileCenter will scan the whole stack of documents. Then, during OCR, it will look for separator pages. Each time it runs across a separator, it will pull that document off of the stack into its own file and, if the separator has other instructions, save the file wherever and however the separator instructs.
**The Generic Separator**

FileCenter already has one page separator set up for you: the *Generic Separator*. This page separator only has one purpose – to split apart documents. It doesn’t have any other options.

Let’s get our feet wet on the generic separator:

1. Click the *Separators* button on the main toolbar
2. The only separator on the list will be *Generic*
3. Select it and click *Print*
4. Close the dialog

Now look at the printed separator. It has a series of codes along the top. These codes are what identifies the separator, and every separator will have a different set of codes. Now let’s take the separator for a spin:

1. Sandwich the separator between two sheets of paper (sheet, separator, sheet)
2. Put the stack in your scanner
3. In FileCenter, go to the *Edit* view
4. Click *Scan*
5. On the scan dialog, go to the *Separate* tab and select *Process Page Separators*
6. Proceed with the scan

After the scan comes in, you’ll see OCR run, then the magic happens – FileCenter will pull the pages apart, each in its own document tab. The separator itself will disappear. A single scan has now given you two documents.

Let’s repeat the same experiment in the *Manage* tab:

1. Put the pages back in the scanner
2. Go to the *Manage* view
3. Click *Scan*, and once again, make sure *Process Page Separators* is selected
4. Give the scan a name
5. Proceed with the scan

This time you’ll end up with two separate files. They both use the same filename, but with counters after them.

**Tip:** By default you’ll also get a file with the original, unsplit scan in it. If you don’t want that file, select *Delete Original File after Successful Separation* when you scan. You’ll find it on the *Separate* tab with the other separation options.
18.3 Add Routing Instructions

Separators spring to life when you add routing instructions, or destinations. A destination provides three pieces of information: where to save the file, how to name the file, and what file format to use (PDF, TIFF, etc.).

In this section we’ll use page separators as our example to demonstrate how destinations work, but understand that destinations are exactly the same for every kind of separator: page separators, content separators, and barcode separators.

Route into Subfolders

Let’s imagine a doctor’s office. The office uses FileCenter to store patient records, one drawer per patient. Inside each drawer they have a standard folder layout: one folder for patient information, one folder for billing and insurance records, and one folder for doctor’s notes.

When new patients come into the office, they fill out a patient history form and a separate form for insurance/billing info. The receptionist then scans these forms into the system. This is a perfect case for separators because it’s a repetitive filing task.

The office sets up two separators: one for the patient intake form, and one for the insurance form. Each separator’s destination specifies 1) a filename for the document, 2) a subfolder where it should go, and 3) that it should be saved as a PDF. The receptionist puts a page separators on top of each form, selects the patient’s drawer, then scans the stack. The forms automatically get split apart, sent to the correct folders, and named.

How to Set it Up. Let’s set up a page separator that will save a file to a subfolder. Click the Separators button on the main toolbar, then do the following:

1. Click Add
2. Give the separator a unique name; this is just to help you identify it
3. Set the Type to Page Separator
4. You’ll notice a tab for Destinations; a destination is a routing instruction
5. Click Add under the grid of destinations
6. Select the option called Relative to Selected Location or Destination
7. For the folder name, type in “Test Scans”
8. Click OK, then OK again
9. You’ll see a prompt to print the separator; click Yes
10. Print two copies
11. Close the *Separators* dialog

**How to Use It.** Now make sure you’re in *Manage view*. Select a drawer, then do the following:

1. Get two printed sheets of paper and stack them with the separators in this order: separator, sheet, separator, sheet (in other words, a separator *on top of each sheet*)  
2. Put the pages in the scanner  
3. Select a drawer  
4. Click *Scan* and, once again, make sure *Process Page Separators* is selected  
5. Proceed with the scan

This time, FileCenter will separate the two sheets and automatically file them into a folder called “Test Scans”, as specified on the separator. Now let’s add just a little bit more power by including a *Naming Option*.

**Include Naming Options**

We covered naming options on p. 47, Pre-Defined Filenames. They’re a powerful way to automatically name files. Let’s edit your separator to use a naming option.

1. Click the *Separators* button on the main toolbar  
2. Select the separator you just made and click *Edit*  
3. Select the destination in the *Destinations* tab and click *Edit*  
4. Select the option called *Use Filename Builder*  
5. Click *Add/Edit Filename*  
6. We’re now in the *Expression Builder*; select *Folder Name > Folder Parent 2*, and *Insert Field Into Expression*  
7. Add the text “New Scan” to the expression  
8. Select *Increment > 01, 02* then *Insert Field Into Expression*  
9. Click *OK* and *OK* again

You don’t need to reprint the separators. Now go back to the drawer and re-scan the stack, making sure to use the *Process Page Separators* option.

This time, the two files should pick up the name of the drawer, followed by “New Scan” and an increment, like this:

```
Some_Drawer New Scan 01.pdf
Some_Drawer New Scan 02.pdf
```
Separate into Pre-Defined Locations

It’s also possible to have a separator send a file to a fixed, pre-determined location. While this is less flexible, it has its uses. Take office mail as an example. The receptionist can set up separators for each person in the office, routing their mail to their own, personal Inbox (see p. 60, The Inbox). When the mail comes in, the receptionist opens it and puts the appropriate separator on each piece of mail, then scans the whole stack at once. FileCenter routes each piece of mail to the correct inbox automatically.

**How to Set it Up.** The setup is identical to Route into Subfolders, above, with one difference: when you set up the Destination, choose Fixed Location and browse to the folder where you want the scans to go.

Let’s do a quick experiment:

1. Click the Separators button on the main toolbar
2. Select the separator we’ve been working with and click Edit
3. Select the destination in the Destinations tab and click Edit
4. Select the option called Fixed Location
5. Select a location where you’d like to save the file
6. Click OK and OK again

You don’t need to re-print the separator.

**How to Use It.** Now in either Manage or Edit view, scan the same stack of pages and separators you used for the last tests, again making sure you’ve selected Process Page Separators. This time, notice that when everything’s done processing, a window opens up at the bottom of FileCenter.

This shows where the documents were sent. Use this to verify that everything went to the right place. Select an item on the list and click Locate on the toolbar right above that window. FileCenter will jump to the file. Notice how it went to the exact folder you specified.

**Tip:** To toggle the Processed Files window on and off, go to the Tools button on the main toolbar > Show Processed Files.

---

18.4 Page Content Separators

When you think about it, most documents contain unique identifiers. For example, correspondence typically contains a salutation, like “Dear ______.” Forms usually have a form
number that will either appear in the title or the footer. And as a practice, legal documents clearly state the purpose of the document in the title:

Last Will and Testament of …
Operating Agreement for …
Quitclaim Deed

Now imagine teaching FileCenter to recognize documents based on their unique content. This would make it possible for FileCenter to automatically separate and route a document based on what kind of document it is – true logic-based automation.

All of this is possible through FileCenter’s Page Content Separators.

Pro Plus Only: This feature is only available in FileCenter Pro Plus.

Content Rules

The heart of page content separators is Content Rules. A content rule examines the body of the document to see if it meets a specific test. For example, if you’re setting up rules to identify a will, you might create a rule to look for the text “Last Will and Testament”.

How to Set it Up. The easiest way to understand page content separators is to try one out. First, go to your word processor and create a document with the text “Last Will and Testament” in it. Print the document (so you can scan it). Now do the following:

1. Click the Separators button on the main toolbar
2. Click Add to create a new one
3. Give the separator a unique name
4. Select Page Content as the type of separator
5. Under the Rules tab, click Add
6. For the condition, select Page Content
7. Set the Operation to Contains
8. Set the Value to “last will and testament” (without quotes)
9. Click Ok

Back on the Separators dialog, set up a destination:

1. Select the Destinations tab
2. Click Add
3. Select Relative to Selected Location or Destination
4. For the Location, enter “Estate Documents” (without quotes)
5. Click OK
6. Click OK again to save the separator

**How to Use it.** Now let’s do a test scan to see what happens:

1. Go to the Manage tab in FileCenter
2. Navigate to any drawer
3. Start a new scan with the document you just printed out
4. Give it a name
5. Select the OCR tab and make sure Make Searchable PDF is selected
6. Select the Separate tab
7. Select Process Content Rules
8. Proceed with your scan

FileCenter will now scan the document then check each content separator to see if it matches the document. When it finds the text “Last Will and Testament” in the document, it will realize that this is a will and save it out to a subfolder called “Estate Documents”.

If you had included additional pages before the “Will” page, FileCenter would have treated them as a separate document.

In other words, *Page Content* separators work *exactly the same* as page separators, except you don’t need to insert a physical separator. You separate based on logic instead.

**Important:** If your content rules contain barcodes, you must enable barcode detection. When you scan or run OCR, go to the Barcodes tab > Content Rules or Naming Options Contain Barcodes.

---

**Creating Content Rules**

A content rule is nothing more than a series of *Conditions* or tests. In our previous example, we only used one condition: that the document content contain the words “Last Will and Testament”. In practice, you’ll want to use a number of conditions to avoid false positives.

To add a condition, click *Add* above the list of conditions. You have the following options.

**Page Content.** You can examine the entire content of the page to see if it has (or doesn’t have) a certain value.
**Important:** Page content tests are case-insensitive and also match *partial* words. For example, a test for the word “Will” also matches “willing” and “unwilling”.

**Content Field.** For more power and control, you can examine only a specific content field. For example, you might set up a zone that pulls the text out of a precise region. You can then test the results from that zone to see if they match what you’re looking for.

Besides zones, content fields also let you do sophisticated pattern matching and even pull text from barcodes. We covered content fields in Chapter 15: Tap into Document Content.

**And/Or.** If you set up more than one condition, you need to specify the logical relationship between the conditions. An *And* condition means that it *and* the condition before it must both be true. An *Or* condition creates an either/or scenario. We’ll discuss this more shortly.

**Operation.** Specify whether the text you’re analyzing must *contain* or *equal* the value you specify (or *not* contain/equal). For example, you’d probably want to test if a page’s entire content *contains* a value rather than *equals* a value. On the other hand, you may want to see if a zone *equals* a certain value.

**Value.** The text you’re looking for in the document.

---

**Getting the Logic Right**

Because your content rules rely on the relationship between multiple conditions, it is imperative that you understand how the conditions are analyzed.

Things are fairly straightforward if all of your conditions are *And* conditions: the rule will be *true* if *A and B and C* are all *true*. But what happens when you throw a series of *Or* conditions into the mix? This is where sequence becomes critical.

Let’s illustrate this with a very simple example. We have a document with this text:

```
My favorite desserts are apple pie, chocolate cake, and pumpkin cookies.
```

We have a content rule that tries to identify documents that deal with desserts. It has the following conditions:

```
[PageContent] contains “cake”
OR  [PageContent] contains “eclair”
OR  [PageContent] contains “ice cream”
OR  [PageContent] contains “cookie”
```
FileCenter will *group* the *Or* conditions together if at all possible, then compare them against the *And* conditions. So based on our document, the overall logic behind the rule looks something like this:

```
(cake OR eclair OR ice cream OR cookie OR pie) AND dessert
```

Which, of course, resolves to TRUE.

**Best Practices for Content Rules**

**Use the Editor.** While you can create your content rules in the *Separators* dialog, we recommend creating them in the *Content Field Editor* which gives you more control. You have two ways to access the editor:

- If you’re in the middle of creating rules for your separator, click the *Editor* button above the list of rules
- If you’re outside of the *Separators* dialog, go to the *Tools* button > *Content Field Editor*

**Test as You Go.** The biggest advantage of the content field editor is that it lets you load a sample document to test against:

1. Go to the content field editor
2. Click the *Open* button above the preview window
3. Open a sample PDF that’s already been OCRed

Now whether you’re creating content fields or content rules, you can click the *Test* button to check the results.

**Use the Library.** You are best off creating all of your content fields and content rules in advance. As you create each one, add it to the *Library*. This makes them reusable and saves you time in the long run:

1. Display the *Content Field Editor*
2. Click the *Library* button to display the library below (if it isn’t already visible)
3. Create your content field or content rule
4. When the item is working the way you’d like, click *Add to Library*

Now whenever you need to insert a content field or content rule, click the *Library* button and select the item you want to use.
**Important:** When you update an item in the Library, it does *not* update the places where you’ve used that item. You’ll need to go to each one and re-insert from the library.

**Include Plenty of Conditions.** The biggest problem with content rules is false positives. And the best way to battle false positives is to include enough conditions to weed them out.

**Use Content Fields for Precise Matches.** When you create a condition, you can base it on *Page Content* or a *Content Field*. Remember that looking for a value in *Page Content* is very broad: the search is *not* case sensitive and partial word matches are allowed. A *Content Field*, on the other hand, is much more targeted. It can examine text from a single, specific region (*Zone*), or it can do a very specific pattern match (*Regular Expression*).

**How to Check if a Content Field was Found.** Sometimes you need to check the exact text that came back from a content field, but other times all you care to know is whether it resulted in a match. For example, suppose you want to know if the document contains one of the months. You have this regular expression:

(January|February|March|April|May|June|July|...)

You don’t care *which* month is in the document, only that *one of the months* is there. You can handle this two ways in your content rule:

- Set the *Return Expression* to ‘true’ in your content field; in the content rule, check whether the field *Equals* ‘true’ (without quotes)
- Set the content rule to check whether the content field *Does Not Equal* then leave the value empty; if any value comes back, it will be *true*

### 18.5 Barcode Separation

You have the option to use your own barcodes as separators. You can do simple separation, where FileCenter starts a new file every time it sees a barcode, you can add routing by saving the file to a path contained in the barcode, and you can take advantage of the full power of FileCenter’s separator destinations.

**Pro Plus Only:** This feature is only available in FileCenter Pro Plus.
**Simple Separation**

Suppose that every document you deal with has a barcode on the first page. The presence of a barcode clearly signals the beginning of a new document, so you’d like FileCenter to automatically split apart stacks of documents every time it encounters a barcode. This is easy to do:

1. Click *Scan*
2. Select the *Barcodes* tab
3. Select *Process Barcodes as Separators*

Now proceed with your scan. After the scan finishes, FileCenter will quickly look through the pages and split apart the document every time it encounters a barcode. The barcoded pages will be treated as the *first page* of the new document.

The separated files will all show up together in the same folder where you scanned (unless you scan in the *Edit* tab, in which case, they’ll each open in new tabs). They will all have the same name you used for your scan, with an increment: *Intake Form 01.pdf, Intake Form 02.pdf,* etc.

*Note:* In this case, FileCenter does not look at the value of the barcode. It’s merely looking for the *presence* of a barcode.

**What if every page of the document has a barcode?** Some documents include the barcode on every page. Fortunately, that won’t stop you from using this feature, as long as every document has a *unique barcode*.

For example, suppose that, in your system, every document gets stamped with a unique barcode. That barcode, however, shows up on every page of the document. FileCenter can limit separation to unique barcodes. Just select the option called *Separate on Unique Barcodes Only*.

When FileCenter’s looking for barcodes, it will only separate a document if it hasn’t seen its barcode before *in this scan*. Once it separates on a barcode, it will ignore that barcode for the rest of the scan.

*Note:* FileCenter only remembers barcodes during the current scan. Once you start a new scan, FileCenter takes a fresh look at the barcodes.

**Route to a Barcode Path**

In addition to separating documents based on the presence of a barcode, FileCenter can also route documents if their barcode contains a valid file path. To do this:
1. Ensure that the barcode contains a *complete* path
2. Click *Scan*
3. Select the *Barcodes* tab
4. Select *Process Barcodes as Separators*
5. Select *Route to Path Contained in Barcode*

Note that a “complete path” includes a *drive, folder(s)*, and a *filename* (including an extension). If the path isn’t valid or accessible, FileCenter will still separate the document, but will save it using the same name and folder as the original scan.

If the path points to an existing file, FileCenter will save the new file with an increment.

**Tip:** One advantage to this method is that you can share these barcodes among multiple users without having to share a separator database, since this kind of barcode is completely self-contained.

**Create a Barcode Separator**

The most flexible and powerful way to separate with barcodes is to create a barcode separator. All of the naming and routing power and flexibility available in a FileCenter separator become available whenever you use the barcode. To use this option:

1. Either edit an existing separator or create a new one
2. Set the separator *Type* to *Barcode*
3. Enter the barcode’s *value* in the field provided
4. Set any other values you want for the separator, then click OK
5. Start a new scan
6. Select the *Barcodes* tab
7. Select *Process Barcodes as Separators*
8. Select *Route Via Separators Database*

FileCenter will now look for barcodes in the scan and, if it finds one, attempt to look it up in the separator database. If it finds the barcode there, it will act on the separator’s settings.

**Make Reusable Barcode Separators**

It’s possible to create reusable barcode separator pages that you use like cover pages. These sheets can contain any other text or information you’d like; it won’t interfere with their function. To make this work:
1. Either edit an existing separator or create a new one
2. Set the separator Type to Barcode
3. Enter the barcode’s value in the field provided
4. Set any other values you want for the separator, then click OK
5. Start a new scan
6. Select the Barcodes tab
7. Select Process Barcodes as Separators
8. Select Route Via Separators Database
9. Select Remove Barcode Pages in Destination Documents

### 18.6 Other Separator Topics

**Using Separators with Existing Files**

It’s possible to insert page separators into an existing file. When would you want to do this? Imagine a medical practice. A patient gets referred by another doctor, and all of the patient’s records get sent over in a single PDF file. The front office staff can quickly browse through the file and insert page separators wherever a new document starts. Then they process the separators in the file. FileCenter automatically splits up the file into individual documents and stores each one where it belongs.

Here’s how to do it:

1. Open the PDF in Edit view
2. Find a page where a new document starts
3. Click the drop-arrow under the Separators button on the main toolbar
4. Select the separator you want and click Insert
5. Do the same for other documents in the file
6. When you’re done, click the OCR button on the main toolbar
7. Select Process Separators Only
8. Click Begin OCR

FileCenter will go through the file, locate the separators, then break up and route the individual documents accordingly.

**Note:** If you use separators with relative destinations, the original file’s directory will be treated as the active directory.
What about Naming Conflicts?

FileCenter will never overwrite an existing file, even if there is a name conflict. When a name conflict happens, FileCenter will use counters to keep names unique. For example, suppose that the file scan.pdf already exists. If FileCenter needs to place a new file, also called scan.pdf, in the same folder, it will save the new file as scan_2.pdf to prevent a conflict. If another scan.pdf comes along later, FileCenter will save it as scan_3.pdf", and so on. You can customize the format of the increment value by using the Filename Builder option on the Destination dialog (Separators > Add/Edit > add or edit a Destination > Use Filename Builder).

Share Separators between Users

Normally, separators are only valid when you scan on the machine where they were created because the separator database is part of FileCenter’s local settings. However, in an office environment you may want to be able to share separators between users. For this to work, the users need to share a common separator data file so that separators created by one user are available to the other users.

To share separators, go to the machine where the separators are set up and do the following:

1. Click the Settings button on the main toolbar
2. Select the Separators section on the left
3. Select Use Custom Location for Separator Database
4. Select a network folder that all users will be able to access
5. Click OK

Now repeat these steps for the other users.

Common Mistakes with Separators

If separators don’t seem to be working for you, see if one of these scenarios applies.

Using Separators Created by Another User. You can only use a separator on the machine where it was created (unless you’ve set up shared separators, like we describe in Share Separators between Users, above). If you try to use a separator on another machine, FileCenter will see that it’s a separator but won’t know what to do with it.
To explain, when you use a separator, FileCenter extracts the separator codes from the top of the page and looks the separator up in its database. If the separator isn’t there, FileCenter will treat the separator like a *Generic Separator* and just separate the documents.

**Continuing to Use a Deleted Separator.** Once you’ve deleted a separator from FileCenter, you can’t continue using the printed copy. If you do, FileCenter will see that the page is a separator, but when it looks up the separator codes, it won’t find anything and, consequently, won’t know what to do with the separator.

**Re-Creating a Separator.** If you delete a separator in FileCenter and then re-create it using the same name, you must re-print the separator and destroy the old copies. If you try to use an old copy, FileCenter won’t recognize it, even though the new separator uses the same name.

**Multiple Destinations.** When users want a separator that routes to multiple destinations, sometimes they make the mistake of selecting the option called *Choose among Destinations by Marking on Printed Separator*. That is a highly specialized option designed for only one use (see All Separator Options Explained, below). If you select that option, FileCenter won’t route to *any* destinations by default. If you simply want to send a document to multiple destinations, all you have to do is add the destinations to the separator.

**All Separator Options Explained**

Besides the features we’ve already touched on, separators offer a number of useful options. Here is the full line-up of separator capabilities. You’ll see these when you create a separator or add a destination to a separator.

**Separator Name.** This is for your reference. It will get printed on the paper separator. Try to use a name that describes what the separator does.

**Separator Type.** Page separators have three variants:

*Default.* A page separator that separates and routes. You’ll select this most of the time.

*Bookmark.* If you select this option, the separator will insert a PDF bookmark instead of splitting up the document. The bookmark will use the name of the separator. No other options are available for bookmark separators.

*User Select.* This creates a multiple-choice separator. FileCenter will print the separator as a check-list of destinations. You can choose the destination you want by marking it on the separator. After you scan with this kind of separator, FileCenter will only save to the destination(s) that you picked. To use it:
1. Set up each choice as a destination for the separator
2. Select the *User Select* option
3. Print the separator
4. Note that each destination begins with: ( - )
5. On the printed separator, mark the destination(s) you want to use by putting a short vertical line through the hyphen
6. Scan

**Important:** To mark a destination, your goal is just to destroy the hyphen ("-"). A short vertical line through the hyphen is all it takes. A small “x” through the hyphen will also work. But it’s critical that your mark not touch the parentheses and not extend above or below the parentheses.

**Begin a New Document Every __ Pages.** A single separator can optionally split a document at fixed page intervals. For example, suppose that you scan a whole stack of 3-page documents. A single separator will split it into individual files every three pages.

To enable this, go to the *Destinations* tab and select *Automatically Begin New Document Every __ Pages* and enter the number of pages you want in each document. If using this with a printed separator, put it at the *beginning of the stack.* Only insert it once. It will remain in effect until the end of the file, or until FileCenter runs into another separator.

**Destinations – Fixed Location.** A separator can always route the file to exactly the same place (fixed location), or it can go to your current location in FileCenter (relative location). The *Fixed Location* option for a destination does just what it says: sends the scans to that folder every time.

**Destinations – Relative Location.** Relative locations are designed for scanning in the *Manage* view. The separator will either save the scan to the selected drawer/folder or, if your separator specifies a sub folder, it will create the sub folder (if necessary) and put the scan there.

**Destinations – File Type.** Select the format that you want the scan saved in. It can be any of:

*PDF* – This option produces a PDF file. If you use the *Make Searchable PDF* option when you scan or run OCR, this will be a searchable PDF.

*TIFF* – This format is simply an image of the original file. There is no actual text. The file will look like the original, but you won’t be able to search its contents or copy any text from it.

*Text* – A text file is simply the OCR text without the scanned image itself. Text files are searchable, and you can edit them in any word processor. You might select this option if you only care about the text of the document and the formatting does not matter.
**Destinations – Use Subfolder Name Builder.** Use this option to dynamically create subfolders off of the main folder using naming option fields. The classic use is creating dated subfolders, which will put the files in dated subfolders within the destination folder.

**Destinations – Use Filename Builder.** Select this option if you want to use dynamic filenames. See p. 48, Dynamic Fields for help building a filename.

**Note:** If you don’t use the filename builder, FileCenter will use the original document name, if available, or a generic document name.

**Metadata.** Your separator can automatically populate some of the PDF metadata fields. See p. 139, Metadata Tab for more information.

**Map.** It’s possible to mine data from the document’s contents and export it to an external data file. This is accomplished through *Content Maps*. See p. 121, Data Mining with Content Maps for more information.

### 18.7 Use FileConvert for OCR, Separation, and Routing

The slowest part of the scanning process is OCR. You’ll find that it takes longer to OCR a page of text than to scan it, especially if you have a high-speed scanner. For short documents, this might not matter, but for long documents and repetitive scanning, waiting for OCR to finish can seriously affect your workflow and your efficiency.

Because OCR is required for all separation and routing in FileCenter, you stand to improve your efficiencies *even more* if you can shift that burden away from FileCenter.

This is where FileCenter’s sister product, FileConvert, comes into play. FileCenter and FileConvert share the same abilities to separate and route documents. The difference is that FileConvert is an invisible engine that runs behind the scenes. As a result, FileCenter can pass the heavy lifting over to FileConvert so that you can continue working uninterrupted. Here’s a quick overview of the workflow:

1. Perform your scan in FileCenter using any kind or separators you’d like
2. FileCenter notifies FileConvert that a new scan was performed
3. FileConvert jumps into action behind the scenes
4. FileConvert runs OCR then handles any separation and routing necessary
5. In the meantime, you’re free to continue scanning in FileCenter
To make the integration work, you need to set up a job in FileConvert to handle the FileCenter scans, then enable the integration in FileCenter.

Pro Only: This feature is only available in FileCenter Professional and Pro Plus.

What is FileConvert?

FileConvert, FileCenter’s sister product, is a robust file conversion tool. It specializes in converting files between different formats (like TIFF to PDF), and making files searchable through OCR. It can run invisibly, meaning that it operates in the background converting and OCRing files as needed. Learn more at:

http://www.lucion.com/fileconvert

Step 1: Create a Folder

FileCenter needs to send instructions to FileConvert – basically, lists of new scans that need to be OCRed. It posts these instructions in a regular Windows folder (“Batch Files”).

Your first step in setting up the integration is to create a folder somewhere that both FileConvert and FileCenter can see it. We suggest calling the folder something like “FileCenter Scan Jobs”, but the name really doesn’t matter.

Important: Do not put scans in this folder! FileCenter will use it behind the scenes to pass instructions to FileConvert. Just set up the folder then forget it’s there.

Step 2: Set Up a FileConvert Job

Next go to FileConvert and set up a conversion job to handle new scans in FileCenter:

1. Create a new job
2. Give the job a name
3. Select Use Batch Files (at the top of the dialog, near the Manual/Scheduled job options)
4. Set the Batch File Folder field to the folder you created in the last step
5. You’ll probably want to select Keep Converted Files in Original Folders
6. Set any other conversion, OCR, and scheduling options you want
7. Click OK
Step 3: Enable the Integration in FileCenter

Finally, enable the integration in FileCenter:

1. Go to Settings
2. Select Scan & OCR on the left
3. Select Enable FileConvert Integration
4. Set the Batch File Folder option to the folder you created in the first step
5. Click OK

Using the Integration

When you scan in FileCenter, turn off OCR. In other words, don’t select any of these options on the OCR tab:

- Make Searchable PDF
- Process Content Rules
- Process Page Separators
- Auto-Rotate Pages

Every time you scan, FileCenter will pass instructions to FileConvert letting it know there’s a new file to OCR. Then whenever your FileConvert job runs, it will take care of the OCR for all of your new scans.

Tip: if you move or rename a file after you scan it, FileConvert won’t find it.

When Will FileConvert Do the OCR? You can set a schedule for your FileConvert job. For example, if you want it to constantly OCR new files, set the job to run every minute. If you want it to OCR new files after business hours, set the schedule to run during the night. If you want to initiate OCR manually, set the job to Manual.

How Can I Tell When a File’s Been Done? Your FileConvert job has a History tab that shows the status of every file sent to FileConvert.

Can I Still Use OCR in FileCenter? Yes. If you choose any OCR options when you scan in FileCenter, FileCenter will take care of the OCR itself and won’t pass that file to FileConvert.
Chapter 19: Search for Files

If you put in place a good cabinet structure and use FileCenter’s built-in tools to help you be consistent in the way you name and organize files, you’ll find your files easily and get to them quickly. At the same time, everybody misplaces files from time to time, or discovers they aren’t where we expect them to be. This is where document search comes in.

FileCenter gives you the ability to search your files much like you’d search the Internet. Type in a few keywords, or maybe words from the filename, and run the search. FileCenter will comb through the filenames and body text of your files and give you a list of matching candidates. You can then use the Preview window to quickly pinpoint your missing file, and then use FileCenter’s moving tools to put it back where it belongs.

19.1 File Searching versus Content Searching

Before we begin, we need to make a distinction. FileCenter offers two types of searching: file searching and content searching. It’s important to understand the difference.

File searching only concerns itself with looking for files and/or folders that contain a certain word in their name, or perhaps fall within a certain date range. It only looks at the name and dates (created/modified) on the file. The actual contents of a given file are ignored. This kind of searching is always available in FileCenter. It doesn’t require any additional setup.

Content searching, on the other hand, will do everything that file searching does, but it goes deeper still. Content searches can probe into the actual contents of documents, looking for keywords and search phrases in the document body itself. Content searching does require an additional bit of setup: it needs you to set up search indexes. This is much easier than it may sound. We cover it later in the chapter.

19.2 Get Started with File Searching

A file search is a great way to pull up files that match certain basic criteria, like specific keywords in the file name or, more useful still, created/modified dates that fall within a specific range.

For example, suppose that you want to see all files that were modified yesterday. You could easily do this with a file search. Another practical example is file archival. With a quick file
search, you can pull up a list of every file that was modified more than a year ago. You can then move all of these files into a different cabinet – perhaps a cabinet called “Archived Documents” that you created.

All of this is possible with file searching.

**Performing a File Search**

If you navigate to FileCenter’s *Search* tab, the first thing that you’ll see is an option to select the *Engine*. Select *Windows File Search*. Now you can provide any of the following search parameters (all are optional):

**File Name.** Provide any portion of the file (or folder) name you’re searching for. You can use an asterisk (*) as a wildcard: it will match zero or more characters.

**Retrieve.** Choose whether you want to search your files, your folders, or both.

**File Types.** You can limit your search to specific types of files. For example, you may only want to see Microsoft Word files, or maybe only PDF files. The easiest way to specify what kind of files you want to search is to select them on the *Pick Type* list. As you select file types on this list, they get added to the *File Types* list. You can also add your file types to that list manually. Just make sure that you separate them with a comma, like this:

```
.doc*,.jp*,pdf,.tif*,.txt,.wpd
```

Note that you can use a wildcard character with file types. As with the filename, this matches zero or more characters. The wildcard makes it easy to list document types that sometimes have more than one extension. For example, Microsoft Word documents can be `.doc` or `.docx`. Digital photos can be `.jpg` or `.jpeg`. The wildcard takes these variants into account.

**Date:** You have a lot of flexibility in selecting a date range. A number of the most common options have been provided for you. You can also specify specific start and end dates for a custom range. Only files that fall within the range will show up in the results. Note that all files have two dates: a *Created* date when the file was first created, and a *Modified* date when the file was last updated. The *Created* date should never change. The *Modified* date will change every time you edit the file.
**Searching within a Cabinet**

While it’s possible to search entire cabinets, you’ll also find it useful to limit your search to a specific drawer or folder:

1. Select the drawer/folder you want to search
2. Click the *Search* button above the list of files
3. Choose *Windows File Search* as the *Engine*
4. Enter your search parameters
5. Click *Search*

The search results will show up in the *Files* view. To clear the search results, click *Clear*. To close the search window, click the X the right of the *Search* button.

**19.3 Get Started with Content Searching**

FileCenter has a dedicated *Search* tab you can use to run large-scale searches. By that, we mean searches of multiple cabinets or your entire filing system.

More often, though, you might want to search right in your cabinets. For example, if you have a drawer with dozens of folders and hundreds or thousands of files in it, you might be able to get to a file faster by searching the current drawer.

In the *Manage* view, you’ll notice a *Search* button right above the list of files. Use this to run quick searches within the current cabinet or limited to the current drawer/folder.

Regardless of which view you run your search in, you’ll see the same search options (mostly). Let’s go over those quickly.

**Search For**

The *Search For* field is where you’ll enter your search terms. By default, FileCenter will search for *all of the terms*. In other words, if you search for *apple pie*, FileCenter will show you all of the files that have *apple AND pie* in them, though not necessarily together or in that order.

*Note:* If you use FileCenter Professional’s *dtSearch* engine, the default search is an “OR” search. In other words, it will return documents that have *any* of your search terms.

Here are a few tips to help you find what you’re looking for:
**Use “+” to Require a Term.** Put a “+” symbol in front of every word that *must* be in the document. FileCenter will only return documents that have that term in them.

**Use “-” to Omit a Term.** If you put a “-” symbol in front of a word, FileCenter will only return documents that *do not* have that term in them. Think of it as a negative search term: “Give me documents that *don’t* include…”

**Use “” for Exact Phrases.** Put quotation marks around exact phrases. FileCenter will only return documents that contain that exact phrase.

**Punctuation and Capitalization Don’t Matter.** FileCenter completely ignores punctuation and capitalization in a document. Suppose your document says, “Pigs don’t fly. Birds do.” FileCenter simply sees “pigs dont fly birds do”.

Here are some examples:

<table>
<thead>
<tr>
<th>Search Request</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>apple pie</td>
<td>Must contain both <em>apple</em> and <em>pie</em> (not necessarily together)</td>
</tr>
<tr>
<td>-apple +pie</td>
<td>Must only contain <em>pie</em>, not <em>apple</em></td>
</tr>
<tr>
<td>+apple +pie</td>
<td>(same as the first example)</td>
</tr>
<tr>
<td>“apple pie”</td>
<td>Must contain the exact phrase <em>apple pie</em></td>
</tr>
</tbody>
</table>

**Filename or Path**

At this point, we need to mention that FileCenter supports two different content search engines: *Windows Content Search* and *dtSearch* (FileCenter Professional only). If you’re using *dtSearch*, you’ll see a *Filename* field you can use to search filename terms (but not folder names).

We recommend, however, that you use *Windows Content Search* (it’s the default). Windows Content Search has superior indexing and gives you more control in searching filenames and folder names.

With Windows Content Search, you enter filenames right in the *Search For* field, alongside your other search terms. You’ll use two special labels to let FileCenter know you want to search file or folder names:

**Use “name:” for Filenames.** If you preface a word with *name:* then FileCenter will only look in the filename for that term.

**Use “path:” for Folders:** If you preface a word with *folder:* then FileCenter will only look at the folder(s) for that term.
Here are some examples:

<table>
<thead>
<tr>
<th>Search Request</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>name: chocolate</td>
<td>Look for any file with <em>chocolate</em> in the name</td>
</tr>
<tr>
<td>path: desserts</td>
<td>Look for any file in a folder with <em>desserts</em> in the name</td>
</tr>
</tbody>
</table>

**Tip:** You can put a space after the label or omit it. So *name: chocolate* and *name:chocolate* mean the same thing.

Let’s go through some practical examples. If you search for *path:desserts*, it will give you every document found in a folder with *desserts* in the name:

```plaintext
C:\My Cabinets\Recipes\Desserts\Pies\Apple.PDF
C:\My Cabinets\Recipes\Desserts\Pies\Chocolate.PDF
C:\My Cabinets\Recipes\Desserts\Pies\Rhubarb.PDF
C:\My Cabinets\Recipes\Desserts\Puddings\Banana.PDF
C:\My Cabinets\Recipes\Desserts\Puddings\Chocolate.PDF
C:\My Cabinets\Recipes\Desserts\Puddings\Rice.PDF
```

We can limit these results to *pies* by searching with *path:pies*, which gives us these results:

```plaintext
C:\My Cabinets\Recipes\Desserts\Pies\Apple.PDF
C:\My Cabinets\Recipes\Desserts\Pies\Chocolate.PDF
C:\My Cabinets\Recipes\Desserts\Pies\Rhubarb.PDF
```

If we search for documents with “chocolate” in the filename (*name:chocolate*), we’ll get two results:

```plaintext
C:\My Cabinets\Recipes\Desserts\Pies\Chocolate.PDF
C:\My Cabinets\Recipes\Desserts\Puddings\Chocolate.PDF
```

By searching both the path and the filename (*path:pies name:chocolate*), we can pinpoint the document we want:

```plaintext
C:\My Cabinets\Recipes\Desserts\Pies\Chocolate.PDF
```

**Metadata Fields**

Think of metadata as document tags. They don’t show up on the document, but you can search on them. If you’re careful about the metadata you include in your documents, the metadata becomes far more important than OCR text if you need to do a search for the document. Why? Two reasons: OCR text is prone to errors, and searches can be restricted to specific metadata fields, effectively filtering out false positives.
If you’re using the *Windows Content Search* engine, you can limit your search to specific metadata fields using this syntax:

```
field: search terms
```

Replace “field” with the actual name of the metadata field you want to search. Here are some examples:

<table>
<thead>
<tr>
<th>Search Request</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>keyword: apple</td>
<td>Look for any file with <em>apple</em> in the “keywords” field</td>
</tr>
<tr>
<td>author: jones</td>
<td>Look for any file with the name <em>jones</em> in the “author” field</td>
</tr>
</tbody>
</table>

**Tip:** To add metadata when you scan, see p. 139, Metadata Tab.

**File Type**

You can narrow your results by file type. For example, select PDF (.pdf) to search only PDF files. This helps to narrow the search results if you get a lot of hits. You can filter on more than one file type. Use the *Select Type* list to pick file types you want to use, or type them in by hand with commas between them:

```
.docx,.pdf,.rtf
```

**Modified/Created**

Use the *Date* option to target files by the date they were modified or created. Either pick a pre-defined window, like within the last day or the last year, or pick a specific date range (*on date*, *before date*, *after date*, and *between*).

**Search In**

The *Search In* option sets the “scope” of your search. The options are different in *Manage view* and *Search view*.

**Manage View.** When you search in *Manage view*, you can search the entire cabinet, or limit your search to the currently selected path, be that a drawer or a folder. Many users search a specific drawer as a way to quickly jump to the file they’re looking for. Others use it like a filter to show only one kind of file. For example, if you search a drawer with *name:pleading*, it will
show you all of the pleadings in the drawer. This is another argument for saving files with consistent, descriptive filenames so you can search and filter on filenames in the future.

**Search View.** In *Search view*, your options depend on your search engine. With *Windows Content Search* (the default), you can limit your search to a specific cabinet, or you can search your entire local hard drive (or more precisely, all of the indexed parts of your local hard drive; we’ll cover that under Configuring Windows Content Search, below), which is useful for scouring your system for a lost file. With *dtSearch*, you can search multiple cabinets at once. Just put a check mark next to each cabinet you want to search. Note that you’ll only see the cabinets that have been indexed. We’ll cover this in Configuring dtSearch, below.

*Other Search Options*

If you’re using *dtSearch*, you’ll see a few other search options:

**Plain English or Boolean?** There are two search types available: *Plain English* and *Boolean*. Plain English is the default and works as described above. *Boolean*, on the other hand, uses the classic Boolean operators: *AND*, *OR*, *NOT*:

- apple OR pie
- apple AND pie
- apple NOT pie

**Fuzzy.** *Fuzzy* matching will find a word even if it is misspelled. For example, a fuzzy search for *apple* will find *appple*. Fuzzy matching can be useful when you’re searching text that has a lot of typographical errors, or text that came from OCR.

**Stemming.** *Stemming* extends a search to cover grammatical variations on a word. For example, a search for *fish* would also find *fishing*, and a search for *applied* would also find *applying*, *applies*, and *apply*.

**19.4 Windows Content Search vs. dtSearch**

Every user can search with *Windows Content Search*, better known as *Windows Search* – the search engine that’s built into newer versions of Windows (if you use Windows XP, you’ll have to download and install *Windows Desktop Search*, which is available for free from Microsoft). Windows Search is a robust search engine that’s also simple to use. One of the key advantages of using Windows Search, and the reason we recommend it, is that new files and file changes
get indexed immediately. As soon as you create a new file, it’s available for searching. It also has a rich, powerful search syntax that’s well documented on the web.

*dtSearch* is only available in FileCenter Professional and Pro Plus. Its one advantage is that it provides network search capability in the few cases where Windows Search isn’t available. Specifically, it lets you search files stored on non-Windows machines. The classic case is a NAS drive (Network Attached Storage). These drives are popular with small businesses and small offices because they’re simple to set up and don’t require IT staff to maintain them. The trouble is, they typically run a Linux operating system, meaning that Windows Search won’t work.

In these cases, you’ll have to use dtSearch. The downside is that new files and file changes only get indexed a few times a day, and indexing is a bit more complicated to set up. We’ll cover the indexing issues in Configuring dtSearch, below.

**Pro Only:** Only FileCenter Professional and Pro Plus provide the dtSearch engine.

**Which Should I Use?**

Unless you need to use dtSearch because Windows Search won’t work in your situation, we strongly recommend you use Windows Search. The search language is richer, you have more control over the results, and you don’t have to worry about keeping the indexes current.

**Changing the Default Search Engine**

To set your default search engine, click the Settings button on the main toolbar, then select the Search option on the left and set Default Search Engine to your preferred engine. If *dtSearch* isn’t listed, select Enable dtSearch.

**Changing Engines on the Fly**

Regardless of which engine you use as your default, you can switch search engines on the fly. In both Manage view and Search view, you’ll see an Engine option where you can pick the engine you want to use for the current search. This is a sticky choice, meaning that FileCenter will keep your selection until you change it again or restart FileCenter, at which point it will revert to the default engine.
19.5 Configuring Windows Content Search

If you’re not getting any search results with Windows Content Search, you’ll need to make sure your cabinets are getting indexed.

First, click the Cabinets button on the main toolbar, then note the Location for each one of your cabinets. Then do the following:

1. Go to the Windows Control Panel
2. Click Indexing Options
3. Click the Modify button
4. Browse to the drive/folder for each cabinet and put a check mark next to it
5. Click OK

Windows should start indexing the folder. Once indexing finishes, Windows will keep the index up-to-date automatically.

**Tip:** You’ll find a button called Manage Indexes in the Search view. This will take you straight to the indexing options for whichever search engine you’re using.

19.6 Configuring dtSearch

If you try to search in Manage view and see an error that the cabinet is not indexed, or your cabinet isn’t showing up as an option in Search view, it means you need to “index” your cabinet.

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.

**Turn on Indexing for a Cabinet**

File searching is handled on a cabinet-by-cabinet basis. In other words, you can activate full-text searching for one cabinet but leave it deactivated on another. To activate file searching for a cabinet:

1. In the Manage view, click the Cabinets button > Indexing Options tab, OR ...
2. In the Search view, make sure the engine is set to dtSearch and click the Manage Indexes button
3. Put a check mark next to every cabinet you want to index
4. For the Type of Index, select Full
5. Click the Start Indexer button

The indexer will begin running immediately. When it’s done, you’ll be able to search the cabinet(s).

**Keep Your Indexes Current**

If you want new files added to the index on an ongoing basis, you must allow FileCenter to periodically update the index. This is known as an *Incremental Index or Auto-Indexing*. To activate auto-indexing for a cabinet, do one of the following:

1. Go to Settings > dtSearch
2. Make sure that Enable Auto Indexer is selected
3. Place a check mark next to each cabinet you want to keep updated
4. Set the auto-indexer’s schedule for a time when the machine will be running but in low use
5. Click OK

Or …

1. Click the Cabinets button in Manage view
2. Select the cabinet you want to index
3. Click Edit to edit the cabinet’s settings
4. In the Edit Cabinet dialog box, go to the Index tab
5. Select Auto Index Cabinet
6. Click OK

The indexes will now be updated every time the auto-indexer runs. Updating simply means that documents created or modified since the last refresh time will be added to the index, and deleted documents will be removed.

**19.7 Making Use of Your Search Results**

If you’re simply looking for a specific file, you can open it directly from the search results. Or preview it. Or rename it. Or delete it. Or email it. Or do anything else that you can do with a file.

You may simply want to know where the file is located. In this case, select the file then click the Locate button. FileCenter will jump to the drawer/folder where the file is located.
Using the Split View with Searches

Sometimes you may be searching for files that match certain criteria so you can move them or archive them. In this scenario, the Split View becomes a powerful tool. We first mentioned the split view back on p. 62, The Split View.

Whether you’ve done your searching in the Manage tab or the Search tab, you can open the split view. All of the features and functions of the split view work in exactly the same way with search results. You can select multiple results and move/copy them into any cabinet or Explorer location. The drop renaming feature works as well.
Chapter 20: Use FileCenter with Email

FileCenter recognizes that email is an essential part of any office workflow. Unfortunately, email also tends to be fairly detached from your actual filing system. To email a file, you have to “attach” it to an email. And when you receive new emails, they and their attachments remain holed away in their own storage environment, completely separate from the rest of your files.

FileCenter works to bridge the gap between your email system and your filing system through a number of useful tools, which we’ll describe in this chapter. We’ll also discuss how to integrate FileCenter with various email clients.

20.1 Emailing documents from FileCenter

FileCenter has a number of convenience features that make it quick and painless to email documents. We’ve covered them throughout the course of this manual. To refresh your memory, here are the key features:

The “Email” Button

You’ll find an Email button on the main toolbar. Regardless of what context you’re in, you can use this button to email the current document. That obviously means that if you have a file selected in a cabinet, you can click Email and send it. Less obviously, it also means that you can select a file in your search results and email it, or email the document you have open in Edit view. Additionally, there are a number of options in the drop-list under the Email button, which we covered on p. 69, Email a File.

Email Files as PDFs

It’s often true that if we’re sending someone a document, we don’t want them making changes to it. For example, if you send someone a buy/sell agreement as a Word document, they can change the terms however they want. As a result, PDF makes a much better choice for sharing documents.

FileCenter makes it effortless to send any kind of document as a PDF. Just select the document, go to the drop-arrow under the Email button, and select Email as PDF or Email as Secure PDF.
FileCenter will send a PDF copy of the document and leave the original untouched. We covered this on p. 87, Email Files as PDFs.

**Scan to Email**

If you need to send someone a copy of a paper document, FileCenter will let you scan it straight to email. Just click the drop-arrow under the *Scan* button and select *Scan to Email*. FileCenter will attach the scan directly to an email message. A fast, simple, and superior alternative to faxing. For more information, see p. 128, Scan to E-mail.

### 20.2 Archive Outlook Email

FileCenter can help you organize and archive your Outlook e-mail by saving it out as individual files.

While many users try to organize their e-mail within Outlook, what they end up with is two separate filing systems: one for their Outlook e-mail and another for the rest of their files. The better approach is to take e-mail messages out of Outlook and treat them like any other file. They still open in Outlook when you double-click them and you can still reply to them. In short, they behave exactly the same as if they were still in Outlook, but you can now store them with the rest of your files. E-mail correspondence with a client, customer, or patient will reside with the rest of their letters, faxes, documents, invoices, etc.

**Use Regular Save**

The most straightforward way to archive an email message to file is to simply save it. Select the message in Outlook, then go to *File > Save As*, browse to a location, and save it.

Note that you can choose between a few different file formats. We recommend you use the *MSG* format, since this retains all of the original information about the email – sender/recipient, date, and attachments. MSG files will open in Outlook and will look just like any other email. You can even forward them and reply to them.
Use Drag and Drop

To archive a lot of files very quickly using FileCenter Standard, just drag-and-drop them from Outlook into FileCenter. You won’t have any control over the filenames, but if your primary concern is to just get an archive copy, this will let get you there faster than any other method.

Use Advanced Drag and Drop

FileCenter Professional offers improved drag-and-drop with most of the capabilities of the Outlook Add-In, described below, but it does not require the Add-In. This is an advantage for offices that don’t allow add-ins for security reasons or that experience conflicts with other add-ins.

To turn this feature on, go to FileCenter’s Settings > General and select Enable Advanced Outlook Drag and Drop.

To use this feature, simply drop email messages from Outlook into FileCenter. The same dialog you would see with the Outlook Add-in will pop up, giving you advanced options like renaming the messages, having the file dates match the message dates, attachment handling options, etc.

For a description of the options, see Use the Outlook Add-In, below.

Use the Outlook Add-In

FileCenter Professional can show a special Save Copy button in Outlook. Use this button to archive messages as they come in or go out. In addition, FileCenter can remember where you’ve saved messages in the past on a per-contact basis. When you save a message, FileCenter can suggest the locations you’ve used before. In a short time, you can reach a point where archiving a message is virtually automatic.

Pro Only: This feature is only available in FileCenter Professional and Pro Plus.

Enable the Button. To show the button in Outlook, do this:

1. Click the Settings button on the main toolbar
2. Select Outlook on the left
3. Select Enable Outlook Integration
4. Click OK
Using the Button. Inside of Outlook, select one or multiple messages to save. Then click FileCenter’s Save Copy button in Outlook. This button is also available when you open an individual message.

When sending messages, you’ll also see a Save & Send button. Use this instead of Outlook’s Send button to save a copy of the message and send it at the same time.

E-mail Names. When you save messages, the first option you’ll see is a list of the messages you selected to save. The names as they appear in the list will be the filenames for the messages. You can change a name by selecting it and clicking Rename.

Below the list you’ll see two options:

Save E-mails – If you de-select this option, the e-mail messages won’t be saved out to file. You’ll find this useful if you only want to save out attachments.

Use E-mail Date for Date Stamp – By default, the saved e-mail messages will get a Windows Date Created/Modified timestamp that matches the time they’re saved out. If you’d rather the Date Created/Modified time match the date/time in the e-mail message, select Use E-mail Date for Date Stamp.

Handling Attachments. If any messages contain attachments, you can extract the attachments and save them to file. Just select Save Attachments Separately. The attachment names as they appear in the list will be the filenames. You can change the name of an attachment by selecting it and clicking Rename. If there’s an attachment you don’t want saved, just select it and click Remove.

You can also strip attachments out of the e-mail messages. Simply select Remove Attachments from E-mail. Note that this strips the attachments from the saved e-mail, not the original copy in Outlook. This also works independent of saving attachments. For example, you can remove attachments from the messages and also choose to not save the attachments separately. This will discard the attachments completely.

Save Locations. Use the Save To area to pick the locations where you want to save the e-mail messages. Use the Browse button to add a location, or use the Most Recent button to pick from the most recent locations you’ve used. You can add as many locations as you need.

Contacts. On the Contacts tab, you can select locations that you’ve associated with your contacts.

A list of contacts that were found in the e-mail message(s) will appear on the left (e-mail addresses that aren’t in your contact list are ignored). When you click on a contact, you’ll see a
list of locations that you’ve associated with that contact. To use one of the locations, just
double-click it or click the Use As Location button. It will be added to the list of locations where
the message(s) will be saved.

Use the New button to add a new location for the contact. This location will be remembered in
the future. The Remove button will permanently remove a location from the contact.

**Note:** If you use Outlook Business Contact Manager, in order to save paths to the contacts, you
will need to set up a user-defined text field with the name FileCenterMailPaths. Do this from
your Business Contact Manager Administrator.

### 20.3 Web Mail (Gmail, Yahoo, etc.)

There’s no denying the convenience of web-based email. The fact that there’s nothing for you
to configure, together with having anywhere, anytime access to your email explain why web-
based email services like Gmail, Yahoo, MSN, and others have exploded in popularity and
dominate the email landscape.

Unfortunately, they also present a major problem. PC-based programs like FileCenter have no
way to integrate with them. We mentioned at the beginning of this chapter that email tends to
be detached from your local filing system. Nowhere is this more true than with web-based
email, which isn’t just detached from your filing system, its detached from your whole PC.

For example, the email features we described in Emailing documents from FileCenter, above,
can’t work with web-based email services. They can only work with email programs installed on
your PC.

Likewise, web-based email services lack any kind of mechanism for saving email messages to
file. As a result, you can’t store copies of your email messages in your cabinets.

Fortunately, there are a couple of ways to work around these limitations.

**Option A: Use a Helper Tool**

The first solution is to get a helper program. These are little utilities that run on your computer.
They handle all interactions with programs like FileCenter and then pass them along to your
web mail service. So, for example, when you click the Email button in FileCenter, it can pop
open to Gmail.
Actually, these utilities go even further than that. They can notify you when you have new mail, pop up alarms from your Google Calendar, and just about anything else you’d expect a desktop email/calendar program to do.

There are various helper applications available for the more popular web mail services. Two available for Gmail are Affixa and Gmail Notifier Pro (they’re both commercial apps).

The limitation of helper programs is that you still won’t be able to save copies of your email messages to file.

**Option B: Use a Full Email Client**

Some, but not all, web-mail services will let you access them through a regular email client, like Outlook or Thunderbird. You can find plenty of instructions online for setting it up. For example, to use Outlook with Gmail, just search for “configure outlook gmail”.

Using a full email client with your web mail gives you the best of both worlds. You still enjoy the convenience and anywhere access of web mail, but you also get all of the power and integration options offered through a desktop email program.

**20.4 Other Email Clients**

While Outlook seems to get more attention than any other email program for the PC, it is not the only player on the field. There is a whole lineup of desktop email programs, and FileCenter will work just fine with any of them that integrate with the Windows MAPI protocol. Most do.

The most robust and most popular alternative to Outlook is Thunderbird, a free, open-source email program. All of FileCenter’s document emailing features work seamlessly with Thunderbird. As to archiving email to file, Thunderbird offers two options: drag-and-drop, and message saving.

We’ll discuss these two methods for Thunderbird, but realize that most other email programs probably offer similar functionality. If you use a different program, experiment with it.

**Use Drag and Drop**

Drag-and-drop work just like it does in Outlook: select the messages you want to archive, then drag and drop them onto a FileCenter location. Thunderbird will save copies of the messages as
individual files. The files will have an \textit{EML} extension. They retain all of the information from the original message, including attachments. Double-clicking one opens it in Thunderbird. You can even forward or reply to it.

\textit{Use Regular Save}

Another way to archive individual messages or whole groups of messages is from Thunderbird’s \textit{File} menu \textgreater{} \textit{Save}. You can then browse out to any cabinet location and save the messages. Again, the saved messages still function exactly as if they were messages in Thunderbird.
Chapter 21: Use FileCenter on a Network

If you already have a network, you can get FileCenter sharing cabinets on the network with very little effort. There’s nothing to install on the server, and no extra configuration required. For a small office, this is all you need to do:

1. Put your shared data on a network drive
2. Install FileCenter on each workstation
3. On each workstation, create a cabinet that points to the shared data

For example, if your shared patient files are at S:\Patients, just go to each workstation, add a “Patients” cabinet, and set its location to S:\Patients. All workstations will now see the same files when they click the “Patients” tab in FileCenter.

In the remainder of this chapter, we’ll cover these concepts in a little bit more detail, then we’ll spend the rest of our time learning about advanced sharing options for larger networks and the administrator’s tool for deploying and administering FileCenter on the network.

21.1 Simple Cabinet Sharing for Small Networks

Small networks fall into two categories: peer to peer and file server.

A peer to peer network does not have a server. Instead, one of the user machines (often the secretary’s) shares its files with the other machines.

File server networks have a dedicated machine that holds all of the network files. This can be a large, powerful file server, or it can be a simple Network Attached Storage unit (“NAS drive”), which is effectively just a small appliance with a hard drive that’s attached to the network and accessed as if it were a server.

What if I don’t have a network yet? If you need to set up a network, we **strongly** suggest hiring someone to set up a file server or NAS drive and connect your network for you. If you knew the pain you’ll avoid fighting with a peer to peer network, you’d consider it money very well spent. Peer to peer networks should never be used for businesses. Just a few of their problems:

- If the “host” computer is running a lot of software, network access slows down or drops off completely
- If the user of the “host” computer shuts down, everyone loses access to the files
Despite improvements over the years, getting past login and security issues remains challenging and frustrating, especially when the machines run different flavors of Windows.

Not all users see shared files in the same location, which can make setting up cabinets confusing.

**Set Up FileCenter on a Peer to Peer Network**

As noted, while a peer to peer network has the simplest layout, in practice it presents the most challenges for sharing files. But if you already have a peer to peer network up and running, you can get FileCenter working without too much extra trouble.

Your biggest challenge is that not all users see the files in the same location, which can make setting up cabinets confusing. For example, the “host” machine (where the files actually reside) might see the files at `C:\Users\Public\Documents\Clients`, while other users on the network might see them at `S:\Clients`.

**Setting Up Shared Cabinets.** To set up a shared cabinet on a peer to peer network, you need to ascertain where the shared files are from the perspective of each computer, since they may all be different. Then on each computer:

1. Install FileCenter
2. Add a cabinet
3. Set the cabinet’s location to the drive/folder where you see the shared files on this computer
4. Repeat for the other computers

Even if each computer sees the shared files in a different place, you’re still seeing the same files. Once you’ve got cabinets showing the shared files on each machine, everyone will be working with a common set of data.

**Set Up FileCenter on a File Server Network**

With a file server network, everyone typically sees the network files on the same network drive. This makes setting up shared cabinets a snap.

**Existing Data.** If you have existing files on the network which you want to share, simply note the location of their parent folder. Then go to each workstation, add a cabinet, and make that folder the cabinet’s location.
For example, suppose that you have a network drive called S:\ and that it has a Clients folder you want to turn into a cabinet. Go to each workstation and create a Clients cabinet, setting its location to S:\Clients.

**New Cabinets.** If you’re starting from scratch, create a folder on the network drive to hold your shared cabinets. We suggest creating a folder named Shared Cabinets. Then create folders for each shared cabinet in that folder. For example, suppose you want two cabinets: Active Patients and Archive. And suppose your network drive is called S:\. You’ll create these folders:

- S:\Shared Cabinets
- S:\Shared Cabinets\Active Patients
- S:\Shared Cabinets\Archive

Now on each workstation, create the Active Patient and Archive cabinets and set their locations to the right folder on the network.

**UNC Paths.** You can use UNC paths instead of mapped drive letters. For example, if the shared network folder is at \\Our Server\Network Files, you would make the following folders:

- \\Our Server\Network Files\Shared Cabinets
- \\Our Server\Network Files\Shared Cabinets\Active Patients
- \\Our Server\Network Files\Shared Cabinets\Archive

Then you would use those paths for the cabinet locations.

**Move a Cabinet to the Network.** Suppose you’ve created a cabinet on your workstation, and now you want to move it to the network. First, choose where the files should go on the network. As we said, we suggest you put a folder like Shared Cabinets on the network, then put each of your shared cabinets in that folder.

Next move the cabinet to the network. We describe how to do this in Task 5: Move a Cabinet.

For example, suppose you have a cabinet called Research on your machine. You’ve prepared a folder on the network called S:\Shared Cabinets. Click the Cabinets button, select Move, and select S:\Shared Cabinets as the new location. FileCenter will move the cabinet folder into the network folder.

Now you’ll need to go to each workstation and manually add the Research cabinet.
21.2 Shared Settings

In all of our discussions so far, we require you to manually set up cabinets on each machine. This works fine for small networks, but by the time you reach half a dozen machines, manually creating cabinets gets tedious quickly.

For these larger networks, we’ve made it painless for you to share cabinets and other items on your network. We call this Shared Settings and it’s very simple to use.

**What Can Be Shared?**

Currently you can share cabinets (and their options), folder templates, naming options, scan profiles, and favorites. You can also share a product key, separators, and certain other settings. Additionally, you can disable certain FileCenter features through a shared policy, break up your users into groups, and choose what each group will see.

*Pro Only:* This feature is only available in FileCenter Professional and Pro Plus.

21.3 Set Up Shared Settings

The philosophy behind shared settings is simple: you set up a common configuration and save it to the network. Your workstations then draw from these shared settings.

In this section, we’ll walk you through the basic steps. Anyone can do this – even non-technical users.

**The Shared Settings Folder**

The heart of FileCenter’s shared settings feature lies in the Shared Settings Folder. Don’t make more of this than you should – the shared settings folder is nothing but a folder on your network. FileCenter stores shared settings in this folder, and all of your workstations will draw their settings from it.

We recommend that you create two folders on your network, Shared Settings and Shared Cabinets. For example, if your network drive is S:\, you’ll create these folders:

```
S:\Shared Cabinets
S:\Shared Settings
```
Your shared FileCenter settings and configurations will go in the *Shared Settings* folder, and the cabinets themselves and all of your data will go in the *Shared Cabinets* folder. For example, if you have two shared cabinets, *Active Patients* and *Archive*, they would go here:

\[
\text{S:\Shared Cabinets\Active Clients} \\
\text{S:\Shared Cabinets\Archive}
\]

You don’t have to use a *Shared Cabinets* folder – any network folder can be a cabinet. But if you’re starting from scratch, we recommend using one. It will keep your cabinets well organized and it will visually pair them with your shared settings.

**The Admin Tool**

FileCenter includes a tool for sharing items. Go to the *Tools* button on the main toolbar > *Administer Shared Settings*.

Let’s start creating your shared settings. Click the *Open* button on the Admin Tool, then browse to the *Shared Settings* folder you created in the last step.

Now you’ll see a number of sections show up on the left: *Cabinets, Folder Templates, etc*. You’ll use these to create all of the items you want to share on the network.

**Share a Cabinet**

Let’s share a cabinet so you can see how shared settings work. Do this:

1. Click the *Cabinets* section on the left
2. Click *Add*
3. Give the cabinet a name
4. Set the cabinet’s location (either a folder in the *Shared Cabinets* folder, like \S:\Shared Cabinets\Clients, or for existing data, its network folder)
5. Set any other cabinet options
6. Click *OK*

Now click the *Save* button in the Admin Tool to commit your settings.

**Move a Cabinet to the Network.** If you’ve created a cabinet on your workstation, and now you want to move it to the network, go ahead and add the cabinet with its current location. Then use the *Move* button and choose the new network location (probably the *Shared Cabinets* folder you just created). FileCenter will move the data and update the cabinet settings.
Join Other Computers

Now it’s time to join some computers to the shared settings. On your own workstation, do this:

1. Go to FileCenter’s Tools button > Connect to Shared Settings
2. Browse to your shared settings folder
3. Click OK

The cabinet you created in the last step should now show up (if it doesn’t show up after a couple of seconds, close and re-open FileCenter).

Now use the same steps to join another computer to the shared settings. The cabinet should show up there also.

From this point forward, any item you create in the Admin Tool will automatically show up on any computer connected to the shared settings. To try it:

1. On your workstation, go to the Tools button > Administer Shared Settings
2. It should automatically open to your shared settings; if it doesn’t, click the Open button and browse to them
3. Click the Folder Templates option on the left
4. Add a folder template
5. Give it a name like Test
6. Click Add to add a folder to it
7. Click OK to create the template
8. Click Save in the Admin Tool to save your changes

Now back in FileCenter, click the Templates button on the main toolbar. Your new folder template should show up in the list. Also note that the Shared column indicates that this is a shared template. Because it’s shared, you won’t be able to edit or delete it here.

Now go to the other workstation and verify that the template showed up there too.

21.4 Users & Groups

In most cases, you don’t need to worry about users or groups. Just point all of the computers on the network to the shared settings folder. They’ll all see the same settings, which is fine for many offices.

If, however, you need to give some users different settings than the others, then the Users & Groups feature will help you.
Quick Overview

Suppose your office has twenty users: fifteen staff members and five managers. Everyone shares the same cabinets, but the managers share one additional cabinet, which the other users shouldn’t see.

This is a situation for the Users & Groups feature. In a nutshell, you would put the managers in a special “group” and give them exclusive access to the management cabinet.

Everyone in the office will get the basic set of shared cabinets, but only the managers will get the additional management cabinet.

Adding Users & Groups

First click the Users & Groups button in the Admin Tool, then follow these steps:

1. Select the All Users group on the left
2. In the Users column, click Add
3. Enter the Windows username for one of your users and click OK
4. Repeat for all of your users

Note that FileCenter tracks users by their regular Windows username. This is the name they click on when they log into Windows. If you don’t know the usernames, here’s how you can find them:

1. Go to the user’s machine
2. Make sure they’re logged in
3. Go to the FileCenter Tools button > Connect to Shared Settings
4. Their username will display at the bottom of the dialog box

Once you’ve entered all of the usernames, you can start creating groups. Click Add in the Groups column. Next select a user on the right and click Include in Group or Exclude from Group to change their group membership. When you’re done, click OK.

Limit Shared Items to Specific Groups

On the Home tab of the Admin Tool, you can see all of the shared items: cabinets, folder templates, naming options, etc.
You’ll also notice a drop-list, right below the toolbar, where you can select a group. You’ll use this list to control the settings for each group.

**The All Users Group.** First, establish the settings for the *All Users* group. This is the default group which includes all users. This is where you’ll restrict your low-level users from seeing things they shouldn’t. In other words, anything that’s private or exclusive should be forbidden in the *All Users* group.

Going back to our earlier example, you would give the *All Users* group access to the basic set of cabinets, but you would deny access to the management cabinet.

Here is how you set access:

1. Select *All Users* in the drop-list
2. Select a cabinet you want to hide from the group
3. Click *Exclude from Group*
4. Repeat for any other cabinets you want to hide
5. Repeat for any other items you want to hide: folder templates, naming options, etc.

**Your Other Groups.** Now it’s time to grant access to the private, exclusive items. Select the group that should receive access. Next go through all of the cabinets, folder templates, etc., that they should see and click *Include in Group.*

The group will now be allowed to see those items.

**Reconciling Permissions.** You’ll notice that many users will belong to more than one group. For example, the managers from our earlier scenario belong to two groups: *All Users* and *Managers.* In this scenario, the management cabinet has conflicting permissions. It’s blocked in the *All Users* group but allowed in the *Managers* group.

Where there’s a conflict, the *most permissive* setting wins. So if your user belongs to two groups and the item is blocked in one but allowed in the other, the user will see the item.

**Important:** If you don’t block private/exclusive items in the *All Users* group, everyone will see them! Why? Because everyone belongs to this group, so they get everything that’s allowed in this group.

**Other Settings and Features.** As we will see next, there are other settings and options that you can administer with the Admin Tool. You can control these on a group-by-group basis, just like other shared items. Again, the most permissive policy will win.
21.5 Advanced Features of the Admin Tool

Besides letting you share items like cabinets and folder templates, the Admin Tool also lets you share certain FileCenter settings and configuration options. Additionally, you can disable certain features. We’ll cover all of these advanced features in this section.

Product Key and Default Settings

On the left side of the Admin Tool, select the Settings section. Here you can enter a product key and establish defaults for most of FileCenter’s settings.

**Product Key.** Enter your product key here (or click Use Local to retrieve the key your local copy of FileCenter is using). Every user connected to these shared settings will receive the key. This is an easy way to keep the product key updated on the network.

*Important:* Never put a trial key in this field! If you do, all of your workstations will time out at the end of the trial period! The only way to get them running again will be to enter a valid product key in the Admin Tool.

**Default Settings.** You can establish default settings for new users here. Click View All Settings. You’ll see a copy of FileCenter’s Settings dialog. Configure FileCenter the way you want it for new users when they install for the first time.

*Note:* The default settings only apply to first-time installs. If the user already has settings, their settings will override the defaults.

**Force Settings.** You can “force” a few of FileCenter’s settings, meaning that the user won’t be able to override your defaults. These are listed as checkboxes. First establish your defaults as just described, then check the corresponding option to force the setting. This will effectively override the user’s setting and prevent the user from changing it.

Disable Features

Select the Permissions section in the Admin Tool. Here you’ll see a list of FileCenter features that you can disable. Most of them should be self-explanatory. Simply put a check mark next to each feature you want to disable.

If you have user groups, note that any custom group’s permissions will override the All Users group permissions. For example, suppose you have two groups, All Users and Managers. In the
All Users group, you disable most of the features. But in the Managers group, you leave all of the features enabled. Because Managers is a custom group, its permissions will override anything set in the All Users group.

**Shared Stamps**

If you have custom PDF stamps you want to make available to your users, you can distribute them through the Admin Tool.

Click the Advanced tab at the top of the Admin Tool. Now click the Miscellaneous option on the left. Here you’ll see a button called Open Shared Stamps Folder. This will open an Explorer window.

Copy the PDF stamp collections into this folder. FileCenter will automatically distribute any PDF stamp collections in this folder to every workstation connected to the shared settings.

**Administrators**

The user who sets up the shared settings folder will automatically become the administrator, or in other words, the user who is allowed to edit the settings with the Admin Tool.

The administrator can allow other users into the Admin Tool. To add more administrators:

1. First find out their Windows username (the name they log in with). To find it, open FileCenter on the user’s machine > Tools button > Connect to Shared Settings; their username will display at the bottom of the dialog box
2. Now open the Admin Tool on the administrator’s machine
3. Click the Admin button
4. Enter the usernames of the new administrators, one per line
5. Press Ctrl+S to save the changes, then close the list

**Tip:** You can also find your username in the Admin Tool. Open the Admin Tool and look on the title bar at the top of the dialog. It will say Administrator - [username] where “[username]” is the current Windows user.
21.6 Separators

Sharing separators works a little bit differently than the other shared settings. These instructions will help you get them shared among all of your users.

Quick Overview

Normally, separators only work on the machine where they were created. However, in an office environment you may want to share separators between users. For this to work, the users need to share a common separator data file so that separators created by one user will be recognized on other machines too.

Select a Network Location for the Database

First choose a folder on the network for the shared separator database. We suggest putting it alongside the other shared folders you created:

   S:\Shared Cabinets
   S:\Shared Settings
   S:\Shared Separators

Post the Database

On the machine that already has the separators you want to share, do the following:

1. Go to the Tools button > Settings
2. Go to the Separators section on the left
3. Select Use Custom Location for Separator Database
4. Browse to the shared separator folder you just made
5. Click OK

This will post the separator database to the shared folder, if there isn’t already a separator database there. Now repeat these steps on the rest of the machines to connect them to the database.

Orphaned Separators

For a separator to work, FileCenter must find it in the separator database.
When you first set up separator sharing, you may end up with some separators that aren’t in the database. For example, suppose that you decided to share Albert’s separators on the network. Albert’s separator database is now the shared database everyone is using. Unfortunately, Barbara had also created some separators on her own machine, but these don’t show up in the new shared separators database. These separators need to be re-created. For page separators, the printed copies should be discarded.

21.7 Easy Deployment

You can simplify the way you deploy FileCenter on office computers using the Install File option in the Admin Tool. In concept, you’ll be generating an INI file that the FileCenter installer will use to choose its installation options. Place the INI file and FileCenter setup file together in the same folder, somewhere on the network, then run the setup on each client machine.

The FileCenter setup file will find the INI file and use those options during the install. It will also connect FileCenter to the shared settings automatically. As a result, you can quickly set up all of your workstations without having to configure them one-by-one.

Generate the Install File

Open the Admin Tool and select the Advanced tab at the top. You’ll see an Install File option on the left. Use this to generate your install file.

Product Key. To automatically register the workstation during installation, enter the proper product key in the Product Key field. Normally all machines on a network share a single product key. To copy the product key from your local installation of FileCenter, click the Use Local Key option.

Install For ... During FileCenter’s installation, you can install it for All Users or for the Current User Only. The primary difference between the two is where the FileCenter settings are stored.

When you install for All Users, the settings go into C:\ProgramData\FileCenter. As a result, all users on the computer will share the same settings. For example, if User A sets up a cabinet, User B will see the same cabinet.

When you install for Current User Only, the settings go into C:\Users\[username]\FileCenter. As a result, each user on the computer will have their own, private settings. If you’re installing on a Terminal Server, you should select this option.
**Installation Path on Users’ Machines.** Use this option to specify the directory where FileCenter should be installed on each of the client machines, if you want to use a custom path.

**Post Installation Settings.** You can now generate and post the fcinstall.ini file to any folder on the network. Pick a folder, then click the Post Installation Settings File button to generate and post the settings file.

---

**Run the Setup**

To now run the setup on your office machines, you should download or copy the FileCenter setup file to the same folder where you just posted the installation settings. When the FileCenter setup runs, it will look for an fcinstall.ini file in the same folder, and if it finds one, it will use the options in that file for installing FileCenter and configuring it. At the same time, it will automatically connect the workstation to the shared settings.

**Silent Install.** If you run the installer with a “/SILENT” command-line switch, it will skip the option screens and only show the confirmation screens. If you run it with a “/VERYSILENT” switch, it will run completely in the background.
Chapter 22: Reinstall or Move FileCenter

Sooner or later, you’re going to need to either reinstall FileCenter or move FileCenter to a new computer. Luckily, you can do that without losing any of your data or settings. This chapter will walk you through the process.

22.1 Reinstall FileCenter

Most of the time, you can install FileCenter right over the top of an older version. The new version will automatically pick up all of the data, settings, and customizations from the old version.

If you fear that a program file has gotten corrupted, you might want to uninstall the old version first, then reinstall:

1. Go to the Windows Control Panel
2. Go to Programs and Features (or Add/Remove Programs in Windows XP)
3. Select FileCenter on the list
4. Click Uninstall

When the uninstall finishes, reboot your computer to ensure all files get removed. Then reinstall. All of your data, settings, and customizations will remain in place.

Do a Fresh Install

If you want to completely remove FileCenter, including all settings and customizations, you’ll also need to remove FileCenter’s settings folder. FileCenter’s settings will be in one of these locations:

- C:\ProgramData\FileCenter
- C:\Users\[your username]\AppData\Roaming\FileCenter
- C:\Documents and Settings\All Users\FileCenter
- C:\Documents and Settings\[your username]\FileCenter

Here’s an easy way to completely remove FileCenter:

1. In FileCenter go to the drop-arrow under the Help button > Support Options
2. Select Browse Settings
3. An explorer window will open to the settings folder; minimize it for now
4. Close FileCenter
5. Uninstall FileCenter as described above
6. Go back to the explorer window you minimized
7. Delete everything in it
8. Reboot your computer

That should completely remove FileCenter. You can check the program folder to make sure it was removed. It will be in one of these places:

C:\Program Files\FileCenter
C:\Program Files (x86)\FileCenter

**Note:** Your FileCenter cabinet data will remain intact. FileCenter never erases cabinet contents.

### 22.2 Move FileCenter to a New Computer

When it’s time to move FileCenter to a new computer, there are two routes you can take: the basic move, or full cloning.

Most users will only need to make sure their cabinet data makes it to the new machine. For them, a basic move will suffice. But if you’ve done heavy customization to FileCenter, or made heavy use of advanced features like separators, naming options, and folder templates, you may want to clone FileCenter on the new machine. We’ll describe both methods.

**Basic Move**

The basic move simply ensures that your cabinets make it to the new machine. To do it, you’ll need a way to carry your cabinet data over to your new computer: a thumb drive, a USB drive, a CD or DVD burner, or a network drive.

**On Your Old Computer:**

1. Click the drop-arrow under the Help button > About FileCenter
2. Note down your Product Key
3. Click the Cabinets button on the main toolbar
4. On the list of cabinets, notice that each cabinet has a Location
5. In Windows Explorer, go to each of those locations and copy the folders to your thumb drive (USB drive, network drive, or whatever you’re using to carry files to the new computer)
For example, if I have a cabinet at C:\My Documents\Client Files, I want to copy the Client Files folder to my thumb drive.

**Note:** If any of your cabinets are on a network drive, just note their location. You don’t need to copy the folders for those cabinets, only cabinets that are stored on your old computer.

**Tip:** Be sure to copy over the containing folder, not just its contents.

**On Your New Computer:**

1. Copy the cabinet data from your thumb drive to the **same locations** on the new computer where they were on your old computer
2. Install FileCenter; use your original *Product Key*
3. Run FileCenter
4. Click the **Cabinets** button on the main toolbar
5. Click **Add** and add back each one of your cabinets, using the same names; for the **Location**, browse out to the folders where you put the cabinet data

**Clone Your Old Setup**

Cloning your old setup involves copying not just your data, but also your old settings folder to the new computer. For this to work, it’s essential that everything go back into its original location.

You’ll need a way to carry your data over to your new computer: a thumb drive, a USB drive, a CD or DVD burner, or a network drive.

**On Your Old Computer:**

1. Locate and copy all of your cabinet data to your thumb drive (USB drive, network drive, or whatever you’re using to carry files to the new computer) as described in *Basic Move* above
2. Go to the **Tools** button > **Export Settings**
3. Save your settings to the same drive you used in step 1

**On Your New Computer:**

1. Copy the cabinet data from your thumb drive to the **same locations** on the new computer where they were on your old computer
2. Install FileCenter; just install it as a 30-day trial for now
3. Open FileCenter
4. Go to the Tools button > Import Settings
5. Browse to the settings file you created earlier and open it
6. Once it has been imported, restart FileCenter

When you restart FileCenter, all of your cabinet data, settings, and customizations should be restored.
Section 3: Tasks
Chapter 23: Common Tasks

In this chapter, we’ll cover common tasks and the steps needed to pull them off.

Task 1: Make a My Documents Cabinet

To make a cabinet out of your My Documents folder:

1. Click the Cabinets button in FileCenter
2. Select Add
3. Call the cabinet My Documents (or anything else, if you prefer)
4. For the Cabinet Location, click Browse
5. Expand the Libraries folder and select Documents (on Windows XP, just select My Documents under Desktop)
6. Click Ok, set any options you’d like, and OK again

Task 2: Use an Explorer Interface Instead of Drawers

If you prefer an Explorer interface to FileCenter’s “drawer” approach, you have two options. We recommend you still use cabinets, but with the Do Not Use Drawers display style:

1. Click the Cabinets button
2. Select the cabinet on the list
3. Click Edit
4. Select the Layout tab
5. Select Do Not Use Drawers
6. Click OK

If you’d rather use a full Explorer interface, do this:

1. Click Settings
2. Make sure General is selected on the left
3. Under Startup Manage Mode select Explorer
4. Click OK
5. Close and re-open FileCenter
Task 3: Make a Cabinet from Existing Files

You can show any directory as a cabinet:

1. Click the Cabinets button
2. Click Add
3. Give the cabinet a unique name
4. For the Cabinet Location, browse out to the directory
5. Set any other options
6. Click OK

The first level of folders in your directory will show up as “drawers” in the new cabinet, with corresponding “folders” and “files”.

Task 4: Make a Cabinet on a Cloud Drive

To make a cabinet available on a cloud drive, you just have to make sure the cabinet’s Location is somewhere in the local folder for your cloud service. Here are the folder locations for some of the more popular services:

- Dropbox – C:\Users\[username]\Dropbox
- Google Drive – C:\Users\[username]\Google Drive
- Microsoft SkyDrive – C:\Users\[username]\SkyDrive

Note: The paths will be different on Windows XP.

Task 5: Move a Cabinet

To move a cabinet’s data to a new directory:

1. Click the large Cabinets button on the main toolbar
2. Select the cabinet on the list
3. Click the Move button
4. Browse to the directory where you want to put the cabinet
5. Confirm
Note that this will move the folder that holds the cabinet data. So if your cabinet was originally located at C:\My Cabinets\Some Cabinet, the whole Some Cabinet folder will get moved to the new location.

When you move a cabinet by following the steps above, FileCenter will automatically update itself to the new cabinet location. Note, however, that if this is a shared cabinet, you’ll have to manually update the other workstations to the new location:

1. Click the Cabinets button on the main toolbar
2. Select the cabinet on the list
3. Click Edit
4. Change the Cabinet Location to the new location
5. Click OK
6. Repeat on each workstation

Task 6: Show the Files in a Cabinet’s Base Folder

Normally you want all of your files to be in folders within the directory you’re using for your cabinet. If, however, the cabinet’s main directory has files in it, there is a way to show them:

1. Click the Cabinets button on the main toolbar
2. Select the cabinet
3. Click Edit
4. Locate the option called Show Cabinet’s Main Folder as a Drawer
5. Change it to Always or Only if Contains Files
6. Click OK and Close

A new drawer called Cabinet Root will show up at the top of the drawer list. This drawer will show the files in the base (“root”) of the cabinet.

Task 7: Expand All Folders

Some users have very deep folder trees and want to be able to expand the whole tree at once. You have two ways to accomplish this.
Double-Click the Top Folder

You can double-click on the folder you want to expand (the folder name, not the “+” symbol), and it will expand/collapse the whole tree. If you double-click on a drawer, it will expand every folder in the drawer.

But first you need to turn on a setting for it:

1. Go to Settings
2. Select Manage on the left
3. Select the option called Double-clicking Drawer/Folder expands all sub-folders
4. Click OK

Keyboard Shortcuts

You can also expand folder trees from the keyboard. Select a folder, then press Ctrl + down arrow to expand or Ctrl + up arrow to collapse it.

Task 8: Enable Inline Renaming

If you prefer to do your file, folder, and drawer renaming inline, like you do in Windows Explorer, follow these steps:

1. Click the Settings button
2. Select Manage Files on the left
3. Select the option that says Enable inline editing of Drawer, Folder, and Filenames
4. Click OK

Now to rename a file inline, do a slow second click. In other words, with the item selected, click it one more time (if you click it twice too fast, the item will just open). Using F2 or the Rename menu options will still pop up a dialog so you can use your naming rules.

Task 9: Integrate with a ScanSnap Scanner

FileCenter can receive scans from a ScanSnap scanner. To see how the integration works, see p. 35, ScanSnap Scanners. Here, we’ll walk you through the setup.

Note: This may not work with all versions of the ScanSnap software.
1. Locate the icon for the *ScanSnap Manager* in the system tray at the bottom-right corner of the screen by the clock (it’s often a blue icon with a white “S”)
2. Right-click on the icon and select *Scan Button Settings*
3. De-select the option called *Use Quick Menu*
4. Select the Application tab (if you don’t see it, click the *Detail* button)
5. Select *Add or Remove* then *Add*
6. Call your new application *Scan to FileCenter*
7. For the Application Path, browse out to FileCenter (it’s typically located at: C:\Program Files (x86)\FileCenter\Main\FileCenter.exe)
8. Click *OK* then *Close* to get back to the ScanSnap Manager
9. Switch over to the Save tab
10. Make sure that *Rename File after Scanning* is NOT selected
11. Switch over to the File Option tab
12. Make sure that *Convert to Searchable PDF* is NOT selected

At this point, you have a choice to make. If you want to always scan to FileCenter (and nowhere else), make sure that *Scan to FileCenter* is selected as the Application, then click *OK*. If, on the other hand, you want to be able to choose on a scan-by-scan basis what to do with each scan, re-select *Use Quick Menu* then *OK*.

Now open FileCenter and go to a drawer or folder. Put a document in the ScanSnap scanner and press the scan button on the scanner. It should scan and save the PDF to the current location in FileCenter.

If you want to run OCR automatically for new ScanSnap scans to make them searchable, you need to turn on a setting:

1. Go to *Settings*
2. Click the *Scan & OCR* option on the left
3. Locate the *ScanSnap* options
4. Select *Run this OCR Profile on ScanSnap Scans*
5. Click *OK*

Each time a scan comes in from your ScanSnap, FileCenter will run OCR using the settings in that OCR profile. For a description, see p. 112, OCR Options Described.

**Task 10: Use a Different Word Processor with Scanning/OCR**
FileCenter lets you send the text from a scan to your word processor.

FileCenter actually saves the text as an “RTF” file then opens this file in whatever program is set to handle RTF. Normally this will be Microsoft Word, but you can change that. Just follow these steps:

1. Open your word processor of choice
2. Create a simple document
3. Click Save As
4. On the Save dialog, there should be a field where you can select the file type; locate and select Rich Text Format (RTF)
5. Save the document somewhere that you can find it easily
6. Close the word processor

Now find the file you just saved and do this:

1. Right-click on it
2. Select Open With; if this expands a sub-menu, select Choose Program
3. Select your word processor on the list, and select the option to always use this program to handle this type of file

If the operation worked, you should now be able to double-click that file and have it open in your word processor every time.

**Task 11: Troubleshoot Scanner Problems**

First, an important point to understand: FileCenter has no direct control over your scanner. Scanners are controlled completely by their TWAIN driver and Windows. FileCenter only puts in “requests” to the driver through Windows and receives pages in return.

As a result, most scanning problems are actually driver problems, and the driver is the responsibility of your scanner manufacturer.

FileCenter does have a few different ways it can try talking with the driver, and sometimes one method works better than the others. The instructions below will walk you through those settings. But if those settings don’t work, you’ll need to try the instructions in Task 12: Troubleshoot TWAIN Problems.
**Quick Overview**

Here are the basic steps for getting your driver to communicate with FileCenter:

1. If your scanner shows up more than once in the scanner list, select the option that does not have “WIA-” in the name
2. Try changing the Mode and/or Transfer type (next to the scanner option on the scanning dialog)
3. Try scanning with the Use Scanner Dialog option turned on
4. Uninstall and update your drivers

We’ll now go through each of those steps in more detail.

**Tip:** If you’re using a Neat Receipts scanner, the following settings seem to work best: Click Scan as if starting a new scan. Next to the Scanner option click Select then set the Mode to "C" and click OK. Next select the Use Scanner Dialog option. Finally, set the Order to Reverse Simplex for single-sided scans, or Reverse Duplex for double-sided scans. Click the small Save link next to the Profile option to make these the new defaults.

### 1. Select the Right Scanner

Click the Scan button in FileCenter. About mid-way down, you’ll notice a Scanner field. Click the Select button next to it. This will bring you to the scanner options.

If you click Select Driver, you will see a list of every TWAIN scanner Windows recognizes on your computer. If your scanner is there more than once, first try the one that doesn’t have WIA in the name, then try the WIA option.

**My Scanner isn't on the List!**

The list shows every scanner Windows can see. If Windows can’t see it, the scanner either doesn’t have a TWAIN driver, or it isn’t turned on or plugged in properly. If you’re sure it’s plugged in and turned on, first try a different USB cable (common problem) then skip to Get the Right Driver below.

**Tip:** If your scanner is a Fujitsu ScanSnap, see p. 35, ScanSnap Scanners. If you have a network scanner, see p. 35, Network Scanners.
2. Change the Scanning Mode and Transfer Type

While still in the Select Scanner dialog, notice the two options called Mode and Transfer. Do the following:

1. Set the Mode to “A”
2. Set the Transfer type to “Native”
3. Try a scan
4. If the scan fails, change the Mode to “B”
5. Try a scan
6. If the scan fails, continue trying each one of the Mode options

If the scan fails at this point, change the Transfer type to “Memory” and start over, trying each of the modes. Then change the transfer type to “File” and try each of the modes again, continuing in this manner until you find a combination that works.

Further explanation: The Modes are different ways of communicating with your scanner’s driver, and the Transfer types are different ways of getting an image back from the driver. This might help you narrow in on which setting to change. For example, if you can’t even get a scan to start, you probably need to change the Mode. If you get problems after a page has gone through the scanner, you might need to change the Transfer type. But often you’ll need to change both settings.

Tip: If you get an error that the scanner is busy or in use, you’ll need to reboot your computer and switch your scanner off then back on.

3. Show the Scanner Dialog

Some scanners have problems if you don’t scan through their interface. This can include everything from crashes to blank or skipped pages to problems with resolution and paper size.

On FileCenter’s Scan dialog, select the option called Use Scanner Dialog then click Start Scan. Your scanner’s interface will pop up. Proceed with the scan. If it works, you will want to make this setting permanent:

1. Go to Settings > Scan
2. Select Use Scanner Dialog
3. Click Save near the top of the dialog
4. Click OK
4. Get the Right Driver

As we mentioned, your scanner’s drivers are the communication link between the scanner and FileCenter. If the driver isn’t working, your first step is to remove the old driver:

1. Unplug or power off your scanner
2. If you’re not using Windows XP, go to the Windows Control Panel > Devices and Printers
3. If your scanner shows up here, right-click on it and select Remove Device
4. Go to the Windows Control Panel > Programs and Features (or Add/Remove Programs)
5. If your scanner shows up here, select it and click Uninstall

Now install an updated driver:

1. Note the scanner manufacturer
2. Note the scanner model number (find it on the bottom or back of the scanner)
3. Go to the scanner maker’s website
4. Look for a link that says Downloads, Drivers, or Support
5. There should be an option to look up a driver for your scanner
6. Download the TWAIN driver setup file for your version of Windows
7. Run the setup file
8. Follow the instructions in the setup
9. Turn on your scanner; Windows should find and recognize it
10. Now you should see the scanner in FileCenter; if it shows up more than once, select the option that does not have “WIA” in the name

Common Problems and Solutions

Here are some common problems and how to correct them:

Some Scanning Options are Disabled

Turn off the option called Use Scanner Dialog.

Error: Scanner is Busy

Your scanner failed to reset itself after the last scan. Sometimes you can just switch the scanner off, wait a couple of seconds, then turn it back on. If this doesn’t work, reboot your computer.
**Error: Device or Scanner Cannot be Found**

Switch your scanner off, wait a couple of seconds, then turn it back on again.

If that doesn’t work, carefully check your scanner connections. You should also try plugging the scanner into a different USB port on your computer, and even try a different cable. We’re always surprised how often USB cables and ports go bad.

Failing this, try rebooting.

If your computer still can’t find the scanner, see Task 12: Troubleshoot TWAIN Problems.

**Error: Cannot Connect to Scanner**

If you connect to your scanner through the network, your firewall could be interfering. Go to the Control Panel > Windows Firewall and allow FileCenter.exe to access the network. The steps vary between versions of Windows. Do a quick Google search for “windows firewall allow program windows ____”, filling in the blank with your version of Windows (e.g. “windows firewall allow program windows 8”).

**Error in the TWAIN Manager**

This usually means that your drivers are damaged or corrupted, to the point that it’s crashing Windows’ TWAIN manager. You’ll probably have to purge your TWAIN drivers and reinstall them fresh. See Task 12: Troubleshoot TWAIN Problems.

**There’s a Crash when I Scan**

If you get crashes when you scan, see Task 12: Troubleshoot TWAIN Problems.

**Task 12: Troubleshoot TWAIN Problems**

Your scanner’s TWAIN driver is the communication link between FileCenter and the scanner. TWAIN drivers are managed by Windows. The communication chain works like this:

```
FileCenter > Windows > TWAIN driver > scanner
```
If you’ve installed the right driver but Windows still doesn’t recognize your scanner, can’t connect to it, or crashes when you scan, your only recourse might be to purge all of your TWAIN drivers and reinstall them. If you’re getting TWAIN Manager errors, you’ll have to do this. Sometimes old, faulty drivers stick around, even if you think they’ve been deleted, and stop Windows from being able to communicate with the good ones.

Here’s how to remove your drivers:

1. Go to the Windows Control Panel > Programs and Features or Add/Remove Programs
2. Find any scanners on the list and uninstall them
3. Reboot your computer
4. Go to C:\Windows
5. Delete everything in the TWAIN and TWAIN32 folders (if they exist), but don’t delete the folders themselves
6. Reboot your computer

Now go to your scanner manufacturer’s website and download the TWAIN driver that matches your scanner AND your version of Windows. If you use a 64-bit edition of Windows, be sure the driver is specifically designed for 64-bit environments.

Install the driver. Drivers install just like programs.

**Task 13: Troubleshoot Scanned Image Problems**

Here are some common problems with scanned images and how to correct them.

**Image is a Negative**

If the image looks like a negative – white text on a black background – open the Scan dialog, then select the Invert Pages option. To make this setting permanent, click the Save button right above the list of options.

**Image is Too Light/Dark**

Open the Scan dialog and switch to the Advanced tab. If this is a black-and-white scan, adjust the Threshold. If it’s a grayscale or color scan, Adjust the Brightness and/or Contrast.
Wrong Page Size

If the scanned page size doesn’t match the original, open FileCenter’s Scan dialog and set Paper Size to the size of the original. If this option is grayed out, you’ll need to set the page size on your scanner’s interface, which will pop up automatically when you scan.

Tip: Many scanners have automatic paper size detection. On FileCenter’s Scan dialog, select Use Scanner Dialog and Start Scan. This will pop up your scanner’s interface. Here you should look for an option like Automatic in the paper size, or a setting called End of Page Detection, Auto-Crop, or something similar.

Pages are in Reverse Order

If your pages are showing up in reverse order, use the Order option to correct them. On the Scan dialog, change the Order to Reverse Simplex for single-sided scans, or Reverse Duplex for double-sided scans.

Image is Crooked

If the image is crooked on the page, first see if your scanner can automatically straighten the scans. On FileCenter’s Scan dialog, select Use Scanner Dialog and Start Scan. This will pop up your scanner’s interface. Here you should look for an option called Deskew or Straighten Pages.

If your scanner can’t straighten the scans automatically, FileCenter can try to straighten them for you. On FileCenter’s Scan dialog, select the option called Deskew Pages. To make the setting permanent, click the Save button right above the list of options.

All or Most Pages are Blank

Some scanners only work if you scan through their interface. Open FileCenter’s Scan dialog and select the option called Use Scanner Dialog and Start Scan. This will pop up your scanner’s interface. Go ahead with your scan.

If you still get blank pages, go through the all of the steps in Task 11: Troubleshoot Scanner Problems.
Task 14: Insert Names in Filenames

A lot of businesses like their filenames to include the name of the case, matter, client, patient, or account that the file pertains to. Here’s how you can do it automatically.

The first step is to make sure that you either use one drawer per client/matter/patient/etc. (highly recommended), or at the very least, a folder.

Next you need to set up a naming option that draws from the drawer (or folder) name. We discuss naming options on p. 47, Pre-Defined Filenames. Do this:

1. Click the Naming button on the main toolbar
2. Click Add
3. Select Folder Name on the left
4. Assuming the drawer name has the name you want to use, select FOLDER Drawer then Insert Field Into Expression (if you need to use a folder name, select the option that corresponds with the folder’s position in the drawer)
5. Add any other elements you want to the filename
6. Click OK and Close

You can use this any time that you rename or save a file through FileCenter’s custom Save dialog (see p. 80, Integrate with the Save/Open Functions of Other Programs):

1. Rename or save a file
2. Notice that the Filename field has a drop-arrow; click it
3. You’ll see a list of naming options; the ones that include the drawer (or folder) name will have the current client/matter/patient name in them
4. Click one to use it in the filename

Task 15: Create Links to Files

If you need a file in more than one place, you can create links instead of copies. The links point back to the original and will open the original if you double-click them. Here’s how to create links:

1. Click Split View on the main toolbar
2. Select the original file in the top window
3. In the bottom window, select the place where you want to put the link
4. Click the Copy button between the two windows
5. Select Link Instead of Copy
6. Click OK

FileCenter will place a link to the file.

**Task 16: Rename Files En Masse**

You can use the *Drop Renaming* feature to rename files *en masse*. Do this:

1. Click *Split View* on the main toolbar
2. In the top window, select the folder that has the files you want to rename
3. Select the same folder in the bottom view
4. In the bar between the two windows, select the *Move* as the drop naming action
5. In the drop naming field, either type in the new name or select a naming option
6. In the top window, select the files you want to rename
7. Drag-and-drop them into the bottom window

FileCenter will rename the files.

**Important:** The files will all have the same name, with an increment. To change the format of the increment, go to *Settings > Manage Files > Default Increment*.

**Tip:** If you want to include the original filename in the new name, create a naming option that uses the *Original Filename* field. See p. 48, Dynamic Fields.

**Task 17: Use a *Daily Appointments* or *Active Work* Cabinet**

If you use one drawer per client/patient, you have the option of pulling out the drawers for the ones you’re actively working on. You’ll do this through an *Advanced Cabinet*. Advanced cabinets don’t actually have any drawers of their own. Think of them more as a temporary workspace where you can show drawers from other cabinets. See p. 75, Advanced Cabinets for more information.

Here’s how to set up and use your *Daily Appointments* or *Active Work* cabinet:

1. Click the *Cabinets* button on the main toolbar
2. Click *Add*
3. Call the cabinet *Daily Appointments* or *Active Work* (or whatever makes sense to you)
4. For the *Type*, select *Advanced Cabinet*
5. Select *Use Default Location*
6. Click *OK* then *Close*

You’ll now see an empty cabinet. To show drawers from other cabinets:

1. Go to a different cabinet
2. Select the drawer you want to show
3. Click the *Drawers* button > *Pin To* and select the cabinet you just made

Now go back to that cabinet. You’ll see the drawer you just “pinned” to it. Repeat for other drawers. Note that the drawers themselves don’t move; you’re just seeing shortcuts to them.

When you want to clear the cabinet, go to the *Drawers* button > *Manage Drawers* > *Remove All*.

To learn more about this technique, see p. 77, “Pinning” Drawers.

**Task 18: Turn On the Save/Open Dialogs for an Application**

If you have a program where you want to use FileCenter’s *Save/Open* integration, here’s how to turn it on:

1. Click *Settings* on FileCenter’s main toolbar
2. Select *Save/Open Dialogs* on the left
3. Select *Enable for Supported Applications Below*
4. Click *Add App*
5. Browse to a shortcut for your program or the program’s actual EXE file, then click *Open*
6. Click *OK*

In Step 5, you need to know where there’s a shortcut for launching your program (often there’s one on the desktop), or you need to know where the actual program is located. You’ll find most programs in one of these folders:

```
C:\Program Files\nC:\Program Files (x86)\n```

You’re looking for your program’s directory, and somewhere inside of it, the “EXE” file that launches the program. For example, Microsoft Word is called *winword.exe*. 
Important: Test the integration thoroughly in the new application, especially verifying that files are being saved correctly. If you find that the integration doesn’t work well with the program, go back to FileCenter’s settings and deselect the program in the Available Applications list to disable the integration.

Task 19: Disable the Save/Open Dialogs for an Application

You can disable FileCenter’s Save/Open dialogs on a program-by-program basis, leaving them working in some applications and disabling them for others. To disable the integration for a program:

1. Click Settings on FileCenter’s main toolbar
2. Select Save/Open Dialogs on the left
3. Select Enable for Supported Applications Below
4. Locate the program on the list and de-select it
5. Click OK

Task 20: Use FileCenter’s Save/Open Dialogs with WordPerfect

If you want to use FileCenter’s Save/Open dialogs in WordPerfect, you’ll need to change a setting in WordPerfect first:

1. Go to the Tools menu > Settings (in some versions of WordPerfect, it’s under Edit > Preferences)
2. Select the Files option
3. Under the Document tab, de-select the option called Use Enhanced File Dialogs
4. Click OK then Close

Task 21: Use Your Signature as a PDF Stamp

You can use your own signature as a stamp when you work with PDFs in FileCenter. This is an easy and convenient way to put your signature on forms. To do it, you need to import your signature as a custom stamp:
1. Sign on a clean sheet of paper using the biggest signature you’d ever expect to need (it’s easy to shrink a signature, harder to enlarge one cleanly)
2. Scan it into a graphics program that supports transparency, like Photoshop
3. Crop the image to the size of the signature
4. Erase all of the white background so it’s transparent
5. Save it as a PNG file

Now back in FileCenter, follow the instructions on p. 103, Import Custom Stamps.

**Important:** This is just a convenience feature. It is not the same as a “digital signature”, which is a legally-binding way to sign a PDF and ensure that it does not change after you’ve signed it. To learn about digital signatures, see p. 107, Digital Signatures.

### Task 22: Use Your Signature in a Digital Signature

If you want to include your handwritten signature or other image as part of your legally-binding Digital Signature (see p. 107, Digital Signatures), do the following:

1. Open a PDF
2. If you want to use your signature, follow the instructions in Task 21: Use Your Signature as a PDF Stamp for turning your signature into a PNG image
3. Click the **Sign Document** button
4. Click somewhere to place a signature; the **Sign Document** dialog will pop up
5. Click the **Manage** button to the right of **Sign Template**
6. Pick a signature style that’s close to how you want your signature stamp to look and click **Clone**
7. Select the clone and click **Edit**
8. In the **Show Graphics** section, select **Custom Icon** and browse to the image of your signature
9. De-select **Display Logo** if you don’t want the “eye” watermark behind your signature
10. Change any other options you want
11. Click **OK** then **Close**
12. Back on the **Sign Document** dialog, click **OK** if you want to sign the document, otherwise click **Cancel**

When you sign documents in the future, you can select your custom signature as the **Sign Template**.
Task 23: Give a Scanned Document Keywords

There’s an easy way to give a scanned document searchable keywords that won’t be visible in the document, but that will help you find the document through full-text searching. This can be a speedy alternative to OCR.

Make sure you’re in Manage view and click the Scan button. Look for a Keywords field on the scan dialog, right below the Filename field. If you don’t see it, make sure the scan type is set to PDF.

Anything you enter in this field will be saved as a searchable keyword with the PDF.

For existing PDFs (or if you’ve scanned in Edit view), open the PDF in Edit view and look for a Properties button right above the thumbnails. In the document properties, you’ll see fields where you can enter things like “Subject” and “Keywords”. These are all searchable.

Alternatively, select the PDF in Manage view and go to the Actions button > PDF Document Properties, where you can enter keywords without opening the PDF (FileCenter Professional only).

Task 24: Back Up or Restore Your Settings

FileCenter makes it easy to export all or your settings and re-import them later, which is the perfect way to back up your settings against loss.

Back Up Your Settings:

1. Go to the Tools button > Export Settings
2. Browse to the folder where you’d like to store the backup
3. Give the backup a name
4. Click OK

FileCenter will create an archive of your settings. Note that they’re stored in a single file.

Restore Your Settings:

1. Go to the Tools button > Import Settings
2. Browse to the settings file you created earlier and open it
3. Once it has been imported, restart FileCenter
When you restart FileCenter, all of your settings will be restored. Note that this operation replaces your old configuration with the settings you import.

**Important:** Backing up your settings does NOT back up your cabinets’ contents, only your settings and preferences.

**Task 25: Change a File’s Timestamps**

Windows assigns every file a couple of timestamps: *Created* and *Modified*. The *Created* timestamp shows the exact date and time that the file was first saved. The *Modified* timestamp shows the exact date and time when the file was most recently changed. You can see these values if you right-click on a file > *Properties* or if you use the *Details* display style for your files, like we describe on p. 31, Change the Way Files are Displayed.

There are situations where you may want to change the timestamps. For example, some offices like to make the *Created* time match the document’s internal date rather than the date it was scanned. This is especially useful if you use the *Created* date in your naming options, like we describe on p. 48, Dynamic Fields.

Fortunately, it is quick and easy to change a file’s timestamps:

1. Select the file
2. Click the *Files* button above the list of files
3. Select *Change File Date/Time*
4. Enter new dates/times for the *Created* and/or *Modified* timestamps
5. Click OK

**Pro Only:** This feature is only available in FileCenter Professional and Pro Plus.